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1. Installation Overview

The document contains a brief set of instructions on how to install Zetadocs for NAV. Due to the highly
flexible nature of what can be achieved with Zetadocs and NAV the remainder of the guide covers specific
modifications you can implement to achieve your customer requirements.

Essentials Setup Pages 5--25

By carrying out the five steps below you will have created a working Capture and Delivery Essentials
system. After that it is a matter of simply adding any additional Zetadocs features required and tuning the
configuration settings to match your requirements.

Zetadocs NAV Client Installation

SharePoint Setup

NAV Objects and interfaces

Capture Essentials Setup

Zetadocs Configuration

Advanced Configuration Pages 26--57
This section of the guide contains the steps required to fully customize the delivery and capture of
documents from NAV and the installation of advanced features.

Capture Plus Setup Pages 58--84
This section covers the setup of the Capture Plus features.

Delivery Plus Setup Pages 85--101
The reference guide provides details on the use of the SDK and what is possible. It is usually only helpful for
those performing Delivery Plus installations.

Appendices Pages 102--143
The appendices contain advice on how to troubleshoot your system as well as details on how to perform
installations which do not follow the standard pattern, such as upgrades and Terminal Services installs.

Table of Contents Pages 144--147
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1.1 ldentifying the Required Installation Elements

Zetadocs can aid your document handling in a variety of ways depending on the modules you are installing.
Several of these modules share core components of Zetadocs with others and as such those installing
Capture Essentials will be installing several components from throughout this guide. To aid you in locating
those chapters relevant to your install simply look for the coloured indicators next to the chapter headings.

0 Capture Essentials Chapters @
Capture Plus Chapters 0 Delivery Plus Chapters ( D ;
\ .|.J

Delivery Essentials Chapters

1.2 Installation steps to be performed on the server or servers
1. Installing the Zetadocs for NAV Client

e Installation and configuration of the Zetadocs for NAV client, including licensing and
registration, enabling users and setting up shared folders.

2. Installing the Zetadocs SharePoint Extensions (Optional)

e Creation of the Zetadocs Archive Document library and installation of the required
Zetadocs components.

3. Importing the Objects and Interfaces

e Installation of the Zetadocs for NAV granules within Microsoft Dynamics NAV. Using the
NAV Object Designer to configure the required pages, forms, tables and codeunits.

4. Zetadocs for NAV Configuration
¢ Importing the standard configuration data.
e Adjusting standard data to fit in your requirements.
5. Installing Zetadocs Capture Essentials/Plus (Plus requires additional licence)

e Essentials: Installs the drag and drop document capture feature and the Zetadocs Server
which converts documents placed in the document queue folders into pdf format.

e  Plus: Configuration of Capture Plus features as required such as OCR and Custom
document queues.
1.3 Installation steps to be performed on each client machine
6. Installing the Zetadocs for NAV Client
e Installation and licensing of the Zetadocs for NAV client.

7. Testing the Zetadocs for NAV Solution
e Verify the functionality end to end and gain customer acceptance.
Note: Those intending to install using Group Policy should first perform the server setup as usual before

viewing the instructions in section 27 Installing Zetadocs for NAV using Group Policy to roll the system out
across the subsequent client machines.
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This section of the guide covers the setup of the Zetadocs Essentials features which make up the
core components of Zetadocs for NAV. These components are largely common across Delivery
and Capture Essentials with any required deviations for each type of install clearly labelled.

Chapters

Zetadocs NAV Client

Zetadocs SharePoint Extensions
NAV Objects and Interfaces
Zetadocs Configuration

Capture Essentials Setup
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Contents
Installing Zetadocs for NAV Client
Install Zetadocs for NAV Help Files
Configuring Zetadocs Licensing

2.1 Installing Zetadocs for NAV Client

Zetadocs for NAV needs to be installed onto the server as well as any intended client machines.

Platform Specific Steps: Please see the additional information available via the links below if you are
installing on these platforms.

Terminal Services

Group Policy

e  Extract your product download, the Zetadocs setup program will autorun, choose relevant install
option:
o Zetadocs Delivery
o Zetadocs Capture
o Zetadocs Delivery and Capture
e Select Zetadocs for NAV Client, either the 32 or 64 bit option as required to begin the install.
e Select the installation language and click Install. Follow the wizard to accept the software license
agreement and complete the installation.
o Note the wizard will prompt you to select the Install Type,
o Typical - For additional client users.
o Administrator - All components including the licensing and configuration application.
o Custom - Allows you to specify the install locations for Delivery and Capture components.
o Note: If you selected the Administrator install type you will be asked to create a shared folder for
sample Delivery Templates.
e Select a suitable folder location and select Next to continue. This will create and share the
templates folder on the network.
e Complete the wizard to finish the install of the Zetadocs for NAV Client.

2.2 Install Zetadocs for NAV Help Files

The Zetadocs for NAV help files need to be copied to the Microsoft Dynamics NAV help folder on each
machine and given names that will not clash with other help files. You should change the file names to the
first unused post-fix letter between a and j (e.g. change to addin_b.chm and addin_b.hh if addin_a.chm
exists). Note that the post-fix on both file names must match.

Role Tailored Client

The Zetadocs for NAV help files need to be copied to the Microsoft Dynamics NAV RTC help folders and
given names that will not clash with other help files as explained above. There are 2 files to copy a .chm file
and accompanying .hh file:

e addin_a.chm

This should be copied from your product download from the folder corresponding to your version of NAV:
\Zetadocs NAV Client\NAV Help\NAV 5 and 6
\Zetadocs NAV Client\NAV Help\NAV 2013
For NAV 6.0 systems copy to:
Program Files (x86)\Microsoft Dynamics NAV\6o\RoleTailored Client\ en-GB
Substitute en-GB for the language pertinent to the install e.g. en-US for US systems.
For NAV 2013 systems copy to:
Program Files (x86)\Microsoft Dynamics NAV\70\RoleTailored Client\en-GB
Substitute en-GB for the language pertinent to the install e.g. en-US for US systems.

e addin_a.hh
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This should be copied from your product download from the folder corresponding to your version of NAV:
\Zetadocs NAV Client\NAV Help\NAV 5 and 6
\Zetadocs NAV Client\NAV Help\NAV 2013
For NAV 6.0 systems copy to:
Program Files (x86)\Microsoft Dynamics NAV\6o\Service\ENG
Substitute ENG for the language pertinent to the install e.g. ENU for US systems.
To the following locations, for NAV 2013:
Program Files\Microsoft Dynamics NAV\70\Service\ENG
Substitute ENG for the language pertinent to the install e.g. ENU for US systems.

Development Environment/Classic Client

The files should be copied from your product download from the folder corresponding to your version of
NAV:

\Zetadocs NAV Client\NAV Help\NAV 5 and 6

\Zetadocs NAV Client\NAV Help\NAV 2013

For NAV 5.0 systems copy to:
Program Files\Microsoft Dynamics NAV\CSIDE Client\ENG
Substitute ENG for the language pertinent to the install e.g. ENU for US systems.
For NAV 6.0 systems copy to:
Program Files\Microsoft Dynamics NAV\6o\Classic\ENG
Substitute ENG for the language pertinent to the install e.g. ENU for US systems.
To the following locations, for NAV 2013:
Program Files\Microsoft Dynamics NAV\7o\Service\ENG
Alternatively it can be copied to the equivalent installation folder of Microsoft Dynamics NAV on the
machine.

You may need to restart the Microsoft Dynamics NAV server to get the help files to appear as expected.
e To do this got to Start and then click Run, in the Open box, type services.msc, and then press
ENTER.
e Under Services, right-click Microsoft Dynamics NAV Server, and then click Restart.

2.3 Configuring Zetadocs Licensing
Before you can start using Zetadocs you must license and register it, enable users and setup file sharing
folders for storage of company accessories (templates, stationery and attachments).

Zetadocs Client Licensing and Setup
e Launch the Zetadocs PDF Configuration.
e Choose the license location (General Tab).
o Active Directory (requires that user has access rights to write to AD)
o Shared Network Folder
Enter your Zetadocs license number and company name and register online.
Enter your registration key on receiving the registration success email.
Add the required users.
Set up a shared network folder for the NAV Templates in the location specified earlier in the install.
Leave Network Archiving off as you will configure archiving settings in NAV later in the install.

Zetadocs Client

e Start the client.

e |fusing Active Directory licensing, Zetadocs should locate the license automatically, otherwise, go
to Tools=> Options\Licensing and enter the path to the network folder containing the Zetadocs
license.

e Restart the client if necessary.

e You can confirm that you are successful if the splash screen shows the Automation tag beside the
number of users.

Please refer to the Zetadocs Client Help for further information on configuring the Zetadocs Client.

Click here for more details on Zetadocs for NAV licencing.
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5. Zetadocs SharePoint Extensions @ © @ (.

Contents
Prerequisites
Adding the Zetadocs SharePoint Extensions
Zetadocs Workflows

3.1 Prerequisites
The Zetadocs SharePoint Extensions will only install successfully on a machine that is running the following
versions of SharePoint.

e Microsoft SharePoint Foundation 2010
e Microsoft SharePoint 2010
e Microsoft SharePoint Online

Before beginning the installation of the Zetadocs SharePoint Extensions you require the following
prerequisites.
e Suitable SharePoint Site or Site Collection created for your archive
e The Workflows feature under the Site Collection Features in SharePoint needs to be activated if you
intend to support Approval Workflows.
e For more information on working with SharePoint please see these resources from Microsoft.

3.2 Adding the Zetadocs SharePoint Extensions
We need to add the Zetadocs content type to our Site and later configure our Document Library to use it.
Log into SharePoint as a Site Collection Administrator
On the Site Actions menu, click Site Settings.
Click Solutions, then on the ribbon select Solutions and then Upload Solution.
Browse to the Zetadocs SharePoint Extensions folder of your product download and select the
Zetadocs SharePoint Extensions.wsp file.
e Upload it and then, click on Activate.
e Return to the Site Settings and select Manage Site Features
e Scroll down the list and activate the Zetadocs elements in the following order:
o Zetadocs Content Type
o Zetadocs Document Library
o Zetadocs Workflow (Note: Do not activate this item if using Office 365 Small Business or
SharePoint Foundation)

3.3 Zetadocs Workflows
Note: Not available on Office 365 Small Business packages and SharePoint Foundation
If you have enabled Zetadocs Workflows you must now upload a document to your document library and
start a workflow to complete the Zetadocs workflow setup.
e Go to your Zetadocs document library and select the Add document option.
e Upload a document, select it and select Workflows and then start the Zetadocs Workflow.
e Onceit has been started you can either cancel or complete the approval process for the document.

To assign a specific icon for your pdf files in SharePoint see the section 30 of this guide.

3.4 Installing the Adobe PDF IFilter on a 64-bit system

For 64-bit systems please refer to the following advice:

http://www.adobe.com/support/downloads/detail.jsp?ftpID=4025
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4 NAV Objects and Interfaces ® ©@ -

This section details how to import the objects and interfaces used by Zetadocs.

Zetadocs for NAV Installation Guide

Contents
Creating a test NAV system
Backing up the existing NAV Objects
Importing the Zetadocs for NAV Objects
Zetadocs Interface Modification Tool
Importing the Language Module

4.1 Pre-requisites
e Zetadocs for NAV Client must be installed on the system where you intend to import the NAV
objects.
e You have a NAV licence which allows the importation of NAV objects
e Your NAV user login has sufficient permissions to insert data into all required tables (We
recommend that you are using the NAV Administrator / SUPER user.

We recommend that you perform the importation of the NAV objects and configuration data on a duplicate
of your live database. Once happy with this setup it can be exported as an xml file which will enable you to
transfer the setup onto the live system.

Terminology
Zetadocs for NAV Objects

e Thisis how we define the NAV objects that we add to the database and are all within our object
range 9009959 - 9001018.
Zetadocs for NAV Interfaces
e This is how we define the existing NAV objects which we modify to integrate Zetadocs for NAV with
an existing database. This is done using our interface modification tool which automates the
changes and makes the process significantly simpler.

4.2 Creating a test NAV system (optional)
If you are not intending to setup your system in a test environment then continue from section 4.4 below
and skip section 26 on exporting and reimporting the configuration.

Creating a copy of your NAV database
e Open the NAV client and open the database in question.
Select Tools>Backup.
Save a copy of your NAV database in a safe location.
Select File->Database>New and create a new duplicate system.
Next select Tools—> Restore and select the backup database you just created.

You are now ready to begin importing the Zetadocs for NAV objects and Standard Configuration.

4.3 Backing up the existing NAV Objects
In order to be able to uninstall Zetadocs for NAV software it is necessary to backup the NAV objects before
installing the Zetadocs for NAV objects. Please perform the following tasks:

Open the Object Designer (Tools=>Object Designer).

Click on All button in the designer menu.

Select All objects and export them File->Export.

Export objects to a Backup of Objects before Zetadocs for NAVs5.o.fob file.
Keep the Backup of Objects before Zetadocs for NAV5.o.fob in a safe place.

4.4 Importing the Zetadocs for NAV Objects

IMPORTANT: Before you import the Zetadocs for NAV objects, you must ensure that you have installed the
Zetadocs for NAV Client as a local administrator on the machine from which you intend to import the
Zetadocs for NAV objects into your NAV database.
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Open the NAV Development Environment (Classic Client) and open the relevant database.
Open the object designer and import the relevant fob file by selecting File>Import.

Browse to your download and navigate to Zetadocs NAV Server Components\ folder

Choose the object file relevant to your NAV version e.g. for a NAV 2013 system \Zetadocs NAV
Server Components\Zetadocs for NAV Objects — NAV7.00.fob

NAV Version Fob file to use
NAV 5.00 Zetadocs for NAV Objects — NAVs.00.fob
NAV 6.01 (2009 SP1) | Zetadocs for NAV Objects - NAVé6.01.fob
NAV 6.10 (2009 R2) | Zetadocs for NAV Objects - NAV6.10.fob
NAV 7.00 (NAV2013) | Zetadocs for NAV Objects — NAV7.00.fob

e Assuming there are no collisions with existing objects continue importing objects and ensure that
there have been no compilation errors. If you have object collisions or compilation errors refer to
the troubleshooting section at the end of this document.

Note: If upgrading from the Zetadocs for NAV — Express Edition then there will be some collisions, you will
be presented with the NAV Import Worksheet. Please accept the default actions and click OK to continue
with the import.

4.5 Zetadocs Interface Modification Tool
The Zetadocs Interface Modifier tool updates the NAV vs.x, v6.x and 7.0 objects to facilitate Zetadocs
functionality and is recommended for most scenarios. To facilitate the setup of demo systems and new
installs, a set of NAV 6.0 R2 and 7.00 objects have been provided. If your system has unmodified interface
objects (Forms, Pages), as supplied by NAV, you can simply import the supplied fob files.

o Role Tailored Client Sample Pages Import

e (lassic Client Sample Forms Import

Alternatively you can perform the modifications manually by following the steps available here:
¢ Modifying NAV Pages Manually
e Modifying NAV Forms Manually

Using the Zetadocs Interface Modifier Tool

We are continuing to develop the Zetadocs Interface Modification tool with lessons learned from ongoing
system installations, please see our installation notes page for access to the latest version of the tool and
any other updates relevant to your installation.

e Download the Zetadocs Interface Modifier Tool and extract it.
e  Open the NAV Development Environment/Classic Client and connect to/open the NAV database.
e Selecting the items for modification by selecting each page and form requiring modification from
the list.
Should you wish to modify the standard recommended set, of SOP and POP pages and forms, Please note
Forms are not compatible with NAV 7.0 as such you should exclude Form from the filter.
o Choose the All tab when viewing the Object Designer
o Click on the Table Filter and add these filters:
= Type - Form|Page
» D - 21126l41..44l49..521130113211341136l138l140l507150916630166 4016 650l6660
o Apply the filter and click OK.
e Click on File>Export. Save the pages or forms as an XML file (NAV 6.x) or as a TXT file (NAV 5.x and
NAV 7.0)
e Inthetool, click onthe Load Items option and choose your NAV version and language.
e Browse to the folder containing the interfaces export, any valid pages and forms will be loaded into
the table display.
Invalid items are reported in a message dialog after the load operation has completed.
Click Start, if there are Customer or Vendor Card pages, the tool will prompt you to decide whether
to include the Rules action to those pages. Select Yes or No accordingly.
e Astatus column in the items list shows the status of the conversion process. If an item cannot be
modified, the reason will be listed in this column.
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e The modified items are now available in the folder containing the original pages or forms file, in an
XML or TXT file depending on the NAV version, with the same name as the original followed by the
suffix '(modified)'.

Importing the Modified Pages and Forms
e Reimport the pages and forms into NAV and deal with any merge and conflict messages that may
appear.
e Compile the modified items by selecting them and pressing F11.

4.6 Zetadocs Report Modification Tool

Like the Zetadocs Interface Modifier Tool we are continuing to develop the Report tool with lessons learned
from ongoing system installations. Please see our installation notes page for access to the latest version of
the tool and any other updates relevant to your installation. Sample reports are provided for NAV 7 and NAV
6 W1 systems and can be imported by following the steps in section 22.6.

Alternatively you can perform the modifications manually by following the steps available here:
Manually Modifying your Existing Reports

In order to be able to uninstall the Zetadocs for NAV software it is necessary to backup any NAV reports you
are editing before installing the Zetadocs for NAV objects. Alternatively, reports can be duplicated and
saved with new report ID’s before adding the Zetadocs for NAV changes. Either way it is important to add
the Version List EQs.0 after saving the completed report.

The following should be taken into consideration when using this tool:

e The Report Modification Tool is currently only compatible with NAV 5.x, 6.x and 7.0 Classic Clients
or Development environments.

e The tool does not perform all the changes required for Role Tailored Client reports, to adjust Role
Tailored Client reports we recommend running the reports through the tool and then performing
the additional edits detailed below.

e Anappropriate NAV license is required for exporting and importing the reports.

e The Toolis not guaranteed to work for all NAV reports.

Using the Zetadocs NAV Report Modification Tool

Open the Object Designer and select the Report view.

Select each required report and export it as a text file to a new folder.

Run the ZdNAVReportTool.exe, the Zetadocs NAV Report Modification Tool will open.

Click on Load Reports and select the version of NAV.

Browse to your exported reports folder.

Valid reports will be loaded into the table display, with any invalid reports highlighted.

Click Start and the Conversion Options window will appear.

Modify the new report ID range if required. This specifies the starting ID that the Report

Modification Tool will use for the first modified report. Subsequent reports will use values

incremented from this base value.

o Modify the report name prefix, if required. This specifies a o to 3 character prefix that all reports
will have appended to their names. This ensures the reports have a unique name. Leaving the
prefix blank will allow the existing report name to be used, however, you may get name collisions if
you have chosen to use new report IDs as well.

e Adialog may pop up asking to delete the existing output directory if there already is one. You may
wish to back up this directory before proceeding.

e Ifareport cannot be modified, the reason will be listed. For successful conversions, the new report
ID and report name are given.

e The modified reports are now available in the folder containing the original reports, in an Output
subfolder.

e Reimport the reports into NAV and deal with any merge and conflict messages that may appear.

e Should you be modifying Role Tailored Client Reports you now need to perform the steps below, if
you are not using the RTC reports please continue from section 4.9.
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4.7 Role Tailored Client specific layout modifications for NAV 2013 (v7)

Following are the instructions for modifying the layout of the report for use with the role tailored client.

Header and Body Section

The Order confirmation report is an example where the page header section is used to display header
information on each page for the record. When this is the case, follow the instructions below to add the
Zetadocs reference.

e C(lick View ->Layout to open the report designer for the Role Tailored Client reports.

e Add a new text box to the body section of the report. Note: Ensure the textbox does not overlap any

existing controls and put the text box at the top left of the section. If this is difficult you may need

to mode existing text boxes and controls down a small bit. In general, existing text boxes have a

parent listbox called list1. If this is the case then ensure that this new textbox has the same.

Change the Name property to Zetadocs_Reference_tb.

Change the Value property to =Fields!Zetadocs_Reference.Value.

Change the Visibility > Hidden property to TRUE.

Change the Color property to Red.

Open the Document Qutline — Report window (Visual Studio = View = Other Windows 2>

Document Outline). Locate and cut (ctrl+x) the Zetadocs_Reference_tb texbox.

e Right click on the lista_Contents node from the document outline Report and select paste before
clicking the Bring to front button.

e Next, add a new text box to the top left of the page header section of the report. Note: Ensure the
textbox does not overlap any existing controls.

e Change the Font size and Color properties to values that you are happy with. Our recommended
size is 6 (4 being the minimum) and color is white, so that this information is not visible in the sent
document.

Change the Value property to =Reportltems!Zetadocs_Reference_tb.Value.
Close and save the report.

Version Code

Once you have saved the report add EQs.0 to the Version List column in the Object Designer. Adding this
value is essential to ensure easy identification of reports modified for Zetadocs for NAV, in particular, for
uninstalling Zetadocs for NAV at a later point.

4.8 Role Tailored Client specific layout modifications for NAV 6

Following are the instructions for modifying the layout of the report for use with the role tailored client. If
your version of NAV does not have the role tailored client, skip this step.

There are two different methods that can be followed to add the Zetadocs reference to the role tailored
client report depending on how it has been designed.

Body Section Only
The remittance advice journal report is an example of a report that does not have a page header section.
When this is the case, follow the instructions below to add the Zetadocs reference.

e Click View ->Layout to open the report designer for Role Tailored Client reports.

e Open the tool box and drag a new text box into the section of the report where the header data is
displayed. Note: Ensure the textbox does not overlap any existing controls and put the text box at
the top left of the section. If this is difficult you may need to mode existing text boxes and controls
down a small bit. In general, existing text boxes have a parent listbox called list1. If this is the case
then ensure that this new textbox has the same.

e Change the Value property to =Fields!Zetadocs_Reference.Value.

e Change the Font size and Color properties to values that you are happy with. Our recommended
size is 6 and color is white so that this text is not visible sent document.

e C(Close and save the report.

Header and Body Section

The Order confirmation report is an example where the page header section is used to display header
information on each page for the record. When this is the case, follow the instructions below to add the
Zetadocs reference.
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e C(lick View - Layout to open the report designer for the Role Tailored Client reports.
e Add a new text box to the body section of the report. Note: Ensure the textbox does not overlap any
existing controls and put the text box at the top left of the section. If this is difficult you may need
to mode existing text boxes and controls down a small bit. In general, existing text boxes have a
parent listbox called list1. If this is the case then ensure that this new textbox has the same.
Change the Name property to Zetadocs_Reference_tb.
Change the Value property to =Fields!Zetadocs_Reference.Value.
Change the Visibility > Hidden property to TRUE.
Change the Color property to Red.
Change the Size property to 6.
Next, add a new text box to the top left of the page header section of the report. Note: Ensure the
textbox does not overlap any existing controls.
e Change the Font size and Color properties to values that you are happy with. Our recommended
size is 6 and color is white so that this information is not visible sent document.
Change the Value property to =Reportltems!Zetadocs_Reference_tb.Value.
Close and save the report.
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Figure 1 - Example of a modified Header and Body ReportLayout with both Zetadocs textboxes highlighted in
position.

Version Code

Once you have saved the report add EQs.0 to the Version List column in the Object Designer. Adding this
value is essential to ensure easy identification of reports modified for Zetadocs for NAV, in particular, for
uninstalling Zetadocs for NAV at a later point.
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4.9 Zetadocs Sample Templates
Note: This step is only required on systems using Zetadocs Delivery.
Zetadocs comes with a number of sample templates which contain stationery and an email body with
embedded commands, which source information from NAV on send. It is usually simpler to modify these to
match your requirements than to create new ones.

e Browse to your product download then Zetadocs NAV Server Components\Sample Templates\.

e Select the language required and copy the templates to the Shared Network folder you created

during the client installation for the templates. The default location is:

\\<machine name>\Zetadocs Templates

4.10 Importing the Language Module

Note: This section should only be performed on systems using a language other than English.

¢ Inthe object designer select the All view. Then using a table filter Version = EQ* get the list to
show all the Zetadocs objects and select them.

e IMPORTANT: Ensure all the objects are selected (highlighted) before continuing. Otherwise the
language module may not apply correctly.

o Navigate to Tools>Language module—>Import.

e Browse to your product download then to Zetadocs NAV Server Components\Language Modules\.

e Import the relevant language module for your region and version of NAV e.g. for a Dutch NAV 2013
system this would be the Zetadocs for NAV Language Module - NAV7.00NL.flm.
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NAV 7 (2013)
Importing the Zetadocs Standard Configuration Data on NAV 2013
Updating the Zetadocs Report Settings to match your Reports
Setting NAV to run the correct reports
Setting up User Permissions

NAV 5 and 6
Importing the Zetadocs Standard Configuration Data
Updating the Zetadocs Report Settings to match your reports
Setting NAV to run the correct reports
Setting up User Permissions

The configuration steps are different in NAV 7.0 (NAV 2013) compared to the previous version as several of
the options and settings have been moved, please use the steps specific to your version of NAV.

5.1 Importing the Zetadocs Standard Configuration Data on NAV 2013

e Open the Role Tailored client and in the Navigation Pane select Departments 2>
Administration>Application Setup—>Zetadocs Setup > Zetadocs General Settings.

e You may be presented with a screen informing you that the RoleTailored client needs permission to
run the Zetadocs.ExternalUtilities.ZdAutomationFactory, select Always Allow and then OK.

e Next import the Zetadocs configuration by selecting Actions and then Import Configuration Data.

e Ontheimport dialog, provide a path to the templates should you be using a location other than the
default.

o Select the XML file path field and import the relevant xml file, e.g. for English it would be \Zetadocs
NAV Server Components\Standard Configuration Data\Zetadocs for NAV Configuration —
English.xml and select Open.

o Next select Import on the Home tab to perform the import. You will be asked to confirm that you
wish to import the data as it will overwrite any existing data in these tables.

e If you are using SharePoint archiving review the Archiving section and ensure the Archiving
Enabled Checkbox has been selected before inputting your SharePoint site or site collection
address as required. This is the bold section shown here:
https://equisys.SharePoint.com/sites/MicrosoftDynamics/default.aspx.

Note: Please do not include the specific library reference which appears at the end with its .aspx file

type. You can click the button located at the end of the SharePoint Site field to verify it.

o Next enter your Archive Library, the default value is Zetadocs. To select an alternative library name
please follow the steps detailed in section 22.9 to ensure your SharePoint site is suitably
configured.

e Set the Folder Name Structure, this subdivides archived documents into subfolders of the
SharePoint document library based on information from the sent record. You have three levels to
work with and each can contain the following options

o COMPANY — The recipient NAV Customer name

o DATE - The Date with a format specified by the Date Folder Naming property below

o DOCTYPE — The Archive Document Type as specified for the current Zetadocs Document
Set, or its override in the Zetadocs Report Settings.

e Ifyou are using Date in the folder structure you now need to specify the Date Folder Naming. This
allows you to specify the format of the date folder structure in the SharePoint archive. E.g. YYYY-
MM-DD, DD-MM-YYYY, MM-DD-YYYY etc.

Further advice on file plan settings is available here.

5.2 Updating the Zetadocs Report Settings to match your Reports

On importing the Zetadocs Standard Configuration data you will have populated the Zetadocs Report
Settings. This data points at some blank report objects, you now need to adjust this to match your report
id’s. As such if you are not using them or you have modified some or all of the existing NAV reports you now
need to adjust the Zetadocs Report Settings accordingly to point at the correct reports.
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e Open the Role Tailored client and in the Navigation Pane select Departments 2>
Administration->Application Setup->Zetadocs Setup -> Zetadocs Report Settings.

e Select the report you wish to modify the settings for. Use the Document Set Name as your guide to
the respective report setting.

e Select the Report ID field and choose your modified report from the Object list.

e Repeat the process for any remaining reports as required.

Properties:
e Areport can only be associated with one Zetadocs Document Set.
e Many reports can be associated with one Zetadocs Document Set.

5.3 Setting NAV to run the correct reports

Now that you have completed the report settings modifications to point at your report numbers, we need to
set NAV to run the correct reports. The steps below will take you through adjusting the Report Selections in
NAV.

Setting NAV to run the new report

If you are intending to use a sample or modified report with a different ID you will need to set NAV to run
that report instead of the existing report. In this example we will set NAV to run the sample Order
Confirmation report, this process should be repeated for each new report being used.

e Search for Report Selections Sales in the NAV 2013 Windows Client and open it.
e Select the Order report from the drop down.

e C(lick into the Report ID field and select the arrow to open the Objects list.

e Select the new object from the list, in this case 9009962 ZD-Order Confirmation.
e Repeat as required for the other reports.

5.4 Setting up User Permissions
To give the system users access to the features of Zetadocs they need to have their permissions setup with
NAV. Zetadocs comes with a RAPIDSTART file which contain the settings for two Zetadocs roles.

ZETADOCS - grants access to the standard Zetadocs forms and tables and allows you to use Zetadocs
for NAV.

ZETADOCS ADMIN - grants the user the ability to adjust the setup of the system in more fundamental
ways and should be reserved to administrators only.

e Search for Configuration Packages and open the Configuration Packages page.

e Select Import Package... from the Process group on the Home tab and select the Zetadocs for NAV
Permission Sets and Permissions — NAV 7.00.RAPIDSTART file from your product download.

e Inthe Process group, click on Apply Package to complete import of the settings.

Setting up Users
To assign a role to a user simply:
e Inthe NAV Windows Client type User Setup in the search bar and navigate to that page.
e Select the NAV user to enable for Zetadocs and choose Edit from the Home tab.
e Inthe User Permission Sets fast tab, select an empty row and add the required permission set.
e Click OK when finished and the user is now set up to use Zetadocs.
This user or group will now be added to the list shown in the Windows Logins window for this role.

5.5 Importing the Zetadocs Standard Configuration Data for NAV 5 and 6
e Right click on the Navigation Pane and select Refresh or close and then open NAV to update the
menusuite with the changes imported earlier.
e Select Administration—>Application Setup—>Zetadocs Setup.
e Runthe Zetadocs General Settings Form.
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e Select Functions=>Import Configuration Data, browse to Zetadocs NAV Server
Components\Standard Configuration Data

e  Pick the relevant xml file, e.g. for English it would be \Zetadocs NAV Server Components\Standard
Configuration Data\Zetadocs for NAV Configuration — English.xml and select Import.

ol

General IArchiving |

Zetadocs for NAV

version . . . . . . . ... ZDX5.0.206.0,EQS5.0.207

Licence Number. . . . . .

Licence Type . . .. ... Zetadocs PDF

loglevel . . . ...... |Error] I

Copyright (c) 2007-2012 Equisys plc and its licensors. All rights reserved. Zetadocs is a registered trademark
of Equisys plc.

I Functions v| Help

Import configuration data
Export configuration data

Figure 2 - Zetadocs General Settings Form

A pair of warning messages will appear, select Yes to continue.

If you are using SharePoint archiving review the Archiving tab and ensure the Archiving Enabled
Checkbox has been selected before inputting your SharePoint site or site collection address as
required. This is the bold section shown here:
https://equisys.SharePoint.com/sites/MicrosoftDynamics/default.aspx.

o Note: Please do not include the specific library reference which appears at the end with its .aspx
file type.

o Next enter your Archive Library, the default value is Zetadocs. To select an alternative library name
please follow the steps detailed in section 22.9 to ensure your SharePoint site is suitably
configured.

e Set the Folder Name Structure, this subdivides archived documents into subfolders of the
SharePoint document library based on information from the sent record. You have three levels to
work with and each can contain the following options

o COMPANY — The recipient NAV Customer name

o DATE - The Date with a format specified by the Date Folder Naming property below

o DOCTYPE - The Archive Document Type as specified for the current Zetadocs Document
Set, or its override in the Zetadocs Report Settings.

e |Ifyou are using Date in the folder structure you now need to specify the Date Folder Naming. This
allows you to specify the format of the date folder structure in the SharePoint archive. E.g. YYYY-
MM-DD, DD-MM-YYYY, MM-DD-YYYY etc.

Further advice on file plan settings is available here.

5.6 Updating the Zetadocs Report Settings to match your reports

On importing the Zetadocs Standard Configuration data you will have populated the Zetadocs Report
Settings. This data points at some blank report objects, you now need to adjust this to match your report
id’s. As such if you are not using them or you have modified some or all of the existing NAV reports you now
need to adjust the Zetadocs Report Settings accordingly to point at the correct reports.

e Select the Administration = Zetadocs Setup, then Advanced Settings.
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e Open the Zetadocs Report Settings Card

e Use the lookup and select the report you wish to modify the settings for. Use the Document Set
Name as your guide to the respective report setting.

e Select the Report ID field and choose your modified report from the Object list.

e Repeat the process for any remaining reports as required.

Properties:
e Areport can only be associated with one Zetadocs Document Set.
e Many reports can be associated with one Zetadocs Document Set.

5.7 Setting NAV to run the correct reports

Now that you have completed the report settings modifications to point at your report numbers, we need to
set NAV to run the correct reports. The steps below will take you through adjusting the Report Selections in
NAV.

Setting NAV to run the new report

If you are intending to use a sample or modified report with a different ID you will need to set NAV to run
that report instead of the existing report. In this example we will set NAV to run the sample Order
Confirmation report, this process should be repeated for each new report being used.

e Open the NAV client and connect to/open the NAV database.

e Select the Administration option from the Navigation pane.

e Expand the folder relevant to the report to be setup, in this case Sales & Marketing.
e Select Report Selections, the Report Selection — Sales card will open.

=

Seqguence |RE|:u:|rt 1D |RE|:u:urt Mame I
b 1 205 Order Confirmation -

Figure 3 - Report Selection - Sales Card

Select the Order report from the drop down.

Click into the Report ID field and select the arrow to open the Objects list.
Select the new object from the list, in this case 9009962 ZD-Order Confirmation.
Repeat as required for the other reports.

5.8 Setting up User Permissions
To give the system users access to the features of Zetadocs they need to have their permissions setup with
NAV. Zetadocs comes with two xml files which contain the settings for two Zetadocs roles.
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e ZETADOCS - grants access to the standard Zetadocs forms and tables and allows you to use
Zetadocs for NAV.

e ZETADOCS ADMIN - grants the user the ability to adjust the setup of the system in more
fundamental ways and should be reserved to administrators only.

e Select Administration > Application Setup - Company Setup - Data Migration.

e The Migration Overview form will appear, select Functions and then Import from XML.

e Go to your product download and browse to the Zetadocs NAV Server Components folder and
select the Zetadocs for NAV Roles.xml file.

e When the import is complete return to the Migration Overview form, select the Migration button
and then Apply Migration Data.

e Repeat this process to import and apply the Zetadocs for NAV Permissions.xml file.

e Next select Tools—> Security=> Synchronize All Logins.

Setting up Users
To assign a role to a user simply:
e C(lick Tools > Security > Roles.
e Select the Zetadocs role you want to assign and click the Role button and select the Windows
Logins option.
e Toadd a Windows user or group to the list, select an empty row.
e Inthe Login ID field, click Assist and the Windows Logins window appears.
e Select the user you want to assign this Zetadocs role to and click OK.
This user or group will now be added to the list shown in the Windows Logins window for this role.
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The Zetadocs Server is simple to install but completing the Zetadocs Capture Essentials setup does require
a number of the other steps of the Zetadocs for Microsoft Dynamics installation to have been completed.
We recommend that you complete all previous elements of the install you require before attempting to
install the Zetadocs Server.

Contents

Zetadocs Server
Installing the Zetadocs Server
Configuring the Zetadocs Server

Document Queues
The Sales and Purchase Document Queues
Create a shared network folder
Setting Document Queue Settings

References
Zetadocs Server
How the Zetadocs Server works
Adding Document Queues to your NAV Menusuite
Adding Document Queues to a Role Centre

6.1 Installing the Zetadocs Server

To install the Zetadocs Server simply:
e Go to the Zetadocs Setup program and select your Zetadocs product version from the main menu.
o Next select the Zetadocs Server option and select Install Zetadocs.
e Click Next and choose a destination folder for the installation and then Next to continue.

Installing OCR Support
Note: This requires a Capture Plus licence, Essentials users should proceed to step 6.2.
o Next you will be asked to Choose whether you want to include OCR support, to include the ZD OCR
Processor you are required to have a valid licence.
e Choose the relevant option for your install:
o |lhave an Abbyy licence and would like OCR support.
o ldo not have an Abbyy licence number.
e Click Next, if you have included Abbyy OCR you will be asked to review their licence agreement.
e Once you have reviewed and selected | Agree, click Next.
e The Installation Wizard is now ready to install the Zetadocs Server, select Install and the wizard
will complete the install.

Licensing Abbyy FineReader
Note: This requires an Abbyy and Capture Plus licence.
o Ifyou earlier specified that you wished to include Abbyy OCR support then you now need to license
the Abbyy FineReader Engine.
e The Abbyy License Manager will open automatically.
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+* ABBYY FineReader Engine 9.0 Local License Manager
Build: 9.0.1.472

Serial number  License type Status ‘olume limit Yolume remains  Units =~ Period = Protection
FEDC-9011-... Custom Developer Activated 10000 10000

Refresh I [ Close ]

Figure 4 - Abbyy FineReader License Manager

e C(lick the Add new... button and then add your Abbyy license number and click Add.
e The Abbyy FineReader Activation Wizard will appear for you to activate your product.

Activation methods:
e Viathe Internet - Activation is carried out automatically and takes only a few seconds. An Internet
connection is required for this type of activation.

o By e-mail - The user needs to send an e-mail message generated by the program and containing
information required for activation. To ensure a quick reply from the mail robot, do not alter the
information in the message body or Subject field.

Once activated Abbyy should be ready to work with the Zetadocs Server.

6.2 Configuring the Zetadocs Server

The Zetadocs server has a number of settings which allow you to specify a series of options on how it
handles documents, these are:

Document Queue Location

Adjusting the PDF Quality

Enabling and Disabling Abbyy (Capture Plus only)
Stellent Bypass PDF Option (Capture Plus only)
Log Level

Log Location

Batch Scanning Settings

Barcode Settings (Capture Plus only)

File Name Prefix

©EN OV R W N

To configure the Zetadocs Server it is necessary to modify the Config.xml file which controls it, this is
located in the Zetadocs Server installation location usually C:\Program Files\Zetadocs Server\Document
Converter. Open this file in a text editing program such as Notepad.exe and edit as per the instructions in
this chapter.

The Config.xml file consist of specific instruction for each queue setup, in the example below there is a
Sales and a Purchase Document Queue inside the <docsQueue></docsQueue> tags and the general Zetadocs

Server settings below that. Once you have changed the options as required save the updated Config.xml
file.

WARNING: The Zetadocs Server Config.xml file is case sensitive, therefore when setting the various options
please ensure that you copy the exact casing shown here. Failing to do so may prevent the server from
working as intended.
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<?xml version="1.0" encoding="utf-8"?>
<Config xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmIns:xsd="http://www.w3.0rg/2001/XMLSchema">

<docsQueue>
<DocsQ Description="Sales Document Queue" Location="\\User specified queue location\Sales Document Queue\">
<EnablePDFTextExtractionToFile>false</EnablePDF TextExtractionToFile>
<BatchScanSplitType>Barcode</BatchScanSplitType>
<BatchScanPagelnterval>1</BatchScanPagelnterval>
<BatchScanBarcodePrefix></BatchScanBarcodePrefix>
<BatchScanBarcodeDeleteSplitPage>false</BatchScanBarcodeDeleteSplitPage>
<FilenamePrefix></FilenamePrefix>

</DocsQ>

<DocsQ Description="Purchase Document Queue" Location="\\User specified queue location\Purchase Document
Queue\">

<EnablePDFTextExtractionToFile>false</EnablePDF TextExtractionToFile>
<BatchScanSplitType>Off</BatchScanSplitType>
<BatchScanPagelnterval>1</BatchScanPagelnterval>
<BatchScanBarcodePrefix></BatchScanBarcodePrefix>
<BatchScanBarcodeDeleteSplitPage>false</BatchScanBarcodeDeleteSplitPage>
<FilenamePrefix></FilenamePrefix>

</DocsQ>

</docsQueue>

<PDFQuality>Better</PDFQuality>
<EnableAbbyy>true</EnableAbbyy>
<StellentTimeOut>10</StellentTimeOut>
<StellentBypassPDF>true</StellentBypassPDF>
<LogLevel>Error</LogLevel>
<LogToFile>true</LogToFile>
<LogToEventLog>false</LogToEventLog>
<EnableBarcodeDetection>true</EnableBarcodeDetection>
</Config>

1. Document Queue Locations

The location of the folders used by the document queues, items added into these folders will be processed

and converted to PDF/A format. Document Queue folders should be folders on the local machine where the
Zetadocs Server is installed. The folder should then be shared on the network for Document Queue users to
use. Information on sharing the folders is available later in section 6.4.

2. Adjusting the PDF Quality
The quality of the pdf’s the Zetadocs Server produces during conversion can be adjusted to meet your
requirements of file size, quality and conversion speed.
The options are:
e Better
o Use this option when pdf quality is important, e.g. when using OCR.
e Smaller
o Use this option when storage space is at a premium and high resolution is not required.

To adjust the quality of the pdf files produced simply change the value shown here to one of the following
options:

<PDFQuality>Better</PDFQuality>

<PDFQuality>Smaller</PDFQuality>

3. Enabling and Disabling Abbyy

Note: Non Capture Plus users should leave this value set to false.

In some circumstances it may be necessary to deactivate Abbyy for example if you were approaching the
end of your licensed document limit and wished to save the remaining capacity for a specific group of work.
To deactivate Abbyy simply change the entry to false, similarly to reactivate it change the value to true.

This edition 5" December 2012 © Copyright Equisys plc 2012 All trademarks acknowledged All rights Page 21
reserved



equisys
ZETAOOCS®

Capture. Deliver. Share.

Zetadocs for NAV Installation Guide

<EnableAbbyy>true</EnableAbbyy>
<EnableAbbyy>false</EnableAbbyy>

4. StellentBypassPDF Option

This option causes the Zetadocs Server to bypass pdf files added to the conversion folder. They are instead
simply copied to the converted folder, which can result in the Server operating more quickly on a given
batch of documents. Note: The PDF files may not be in the specific PDF/A format generated by the Server.

<StellentBypassPDF>true</StellentBypassPDF>
<StellentBypassPDF>false</StellentBypassPDF>

5. Adjusting the Logging Level
The logging level options are as follows:

e Error

o Use this setting for general operation.
e Warning

o Use this for trouble shooting issues.
e Debug

o Should be used for a controlled period of time to trouble shoot issues.
As such simply change the value in the config.xml file to either of these.
<LogLevel>Error</LogLevel>
<LogLevel>Warning</LogLevel>
<LogLevel>Debug</LogLevel>

6. Specifying the Log Location
The Zetadocs Server log can be set to save to a file and/or the event log, change these values to true and
false as appropriate.

<LogToFile>true</LogToFile>
<LogToEventLog>false</LogToEventLog>

The Zetadocs Server log file is written to:

C:\Windows\Temp\Zetadocs\ZdDocumentConverter.log

7. Batch Scanning Settings
This setting is specific to each document queue. Each document queue can be configured to use only one
type of splitting method. The splitting methods are:
e Off - By default, the Zetadocs Server doesn’t process any batches present in the Batch Split folder
of your document queue.
e Barcode - The Zetadocs Server splits the batches on every page that contains a barcode.
e BarcodeValue - The Zetadocs Server splits the batches every time the barcode being read has a
different value to the previous barcode read.
e Pagelnterval — Zetadocs Server splits the batches using an interval defined by the
BatchScanPagelnterval parameter, e.g. every 3 pages see below for details.

<BatchScanSplitType>Off</BatchScanSplitType>
<BatchScanSplitType>Barcode</BatchScanSplitType>
<BatchScanSplitType>BarcodeValue</BatchScanSplitType>
<BatchScanSplitType>Pagelnterval</BatchScanSplitType>

Configuring the Page Interval
This value determines the page interval number to be used when processing a document using the
Pagelnterval splitting method described above.

<BatchScanPagelnterval>"Valug”<BatchScanPagelnterval>
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Where “Value” is a positive number, note this field cannot be left blank. For those not using page interval
splitting we recommend adding the value 1, this will be ignored unless the BatchScanSplitType has been set
to Pagelnterval.

8. Barcode Settings
Note: Non Capture Plus users should leave this value set to false.

We will cover adding barcodes to your NAV reports later in chapter 12, if you are intending to use barcode
splitting on captured documents to streamline your processes you need to configure the Zetadocs Server
accordingly using the options below.

Barcode Detection
Zetadocs can detect barcodes if the OCR module has been installed, this option determines whether the
Zetadocs Server searches for readable barcodes or not.

<EnableBarcodeDetection>true</EnableBarcodeDetection>
<EnableBarcodeDetection>false</EnableBarcodeDetection>

Barcode Prefixes

This setting is specific to each document queue. When using the Barcode and BarcodeValue splitting
methods, a barcode prefix can be set to ensure the Zetadocs Server only processes barcodes that contain
the prefix. The prefix is defined under the BatchScanBarcodePrefix parameter shown below.

<BatchScanBarcodePrefix>Prefix<BatchScanBarcodePrefix>
Note: The Prefix value is case sensitive.

Enabling Automatic deletion of the split page

This setting is specific to each document queue. When using the Barcode and BarcodeValue splitting
methods, if you use a splitting page containing a barcode, you may want to delete the split page. This can
be set under the BatchScanBarcodeDeleteSplitPage parameter. This feature is often used when splitter
pages have been added throughout a batch to define when each multipage document ends and prevents
these pages from ending up in the archive.

Note: By activating this feature any page containing a barcode used to split the batch will be deleted, if you
are using barcode splitting all pages with a readable barcode will be deleted after splitting. If using the
barcode prefix option, only those pages with the correct barcode prefix will be used to split on and will then,
if not a single page, be deleted.

<BatchScanBarcodeDeleteSplitPage>true</BatchScanBarcodeDeleteSplitPage>
<BatchScanBarcodeDeleteSplitPage>false</BatchScanBarcodeDeleteSplitPage>

Note: Non Capture Plus users should leave this value set to false.
Save the updated Config.xml file when finished.

9. File Name Prefix

It is often useful to be able to identify which Document Queue a document originated from post conversion
and queue processing. The file name prefix settings allows you to prefix all files processed by a queue with
some text descriptor. For example, a prefix setting of “SDQ_" in the Sales Document Queue would result in
a document “Sample.doc” becoming “SDQ_Sample.pdf” after conversion to PDF.

The default is no prefix. To set a prefix put the appropriate prefix in the setting for the desired queue. We
recommend that the prefix value be less than 10 characters and the following characters are not allowed:

#%&*:<>2/{|}~""

<FilenamePrefix>"Value"</FilenamePrefix>
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Restarting the Zetadocs Server

Once you have detailed the location of the Zetadocs Server you need to restart the conversion service.
e Go to Start>Run, then enter Services.msc
e Scroll to Zetadocs Document Converter and right click on it and select Restart.

6.3 The Sales and Purchase Document Queues

Zetadocs comes with two Document Queues setup a standard, a Sales and a Purchase Document Queue.
These come with a number of pre-programmed menu items which allow you to perform a variety of actions
from them. They are designed to cover a variety of standard Sales and Purchase scenarios. In this section
we will take you through how to setup the Sales and Purchase Document Queues.

These document queues have been created with the archiving and link items pre-programmed, this offers
you a quick and easy document queue solution. The queues come with the following menu items setup:

Sales Document Queue \ Purchase Document Queue

Create new blanket order Create new blanket order

Create new credit memo Create new credit memo

Create new invoice Create new invoice

Create new order Create new order

Create new quote Create new quote

Create new return order Create new return order

Link to existing blanket order Link to existing blanket order

Link to existing credit memo Link to existing credit memo

Link to existing invoice Link to existing invoice

Link to existing order Link to existing order

Link to existing posted credit memo Link to existing posted credit memo
Link to existing posted invoice Link to existing posted invoice

Link to existing posted return receipt Link to existing posted receipt

Link to existing posted shipment Link to existing posted return shipment
Link to existing quote Link to existing quote

Link to existing return order Link to existing return order

6.4 Create a shared network folder

The document queue requires a network folder into which captured documents are placed and to which all
users of the queue have full access permissions.

e Create the required folders e.g. Sales Document Queue
e View its Properties and ensure the Share this Folder radio button is checked
e Select the Permissions button and assign the necessary permissions.
o USERS: Share permissions with a minimum of Change and Read Permissions. Full
Permissions are recommended.
o SERVICE: The Zetadocs DIRMonitor Service must have access to the queue folders. To do
this add FULL Permissions to the SYSTEM user or whatever network user the service is
running as.

6.5 Setting Document Queue Settings in NAV 2013

The Zetadocs Document Queue card is where all Zetadocs Document Queue settings are defined. It already
contains the default settings imported earlier for the Sales and Purchase Document Queues, revise these as
required following the steps below. To add a new queue simply create another record on this card and fill it
out appropriately.

To open the card:

e Navigate to Administration>Application Setup—>Zetadocs Setup > Zetadocs Document Queue
List.

e Select the Queue you wish to adjust the settings for, you will be presented with the options below,
adjust these as required to setup the queue.

No.: The document Queue ID.
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Name: The name of the Document Queue.

Path: The location of the document queue folder you created e.g. \\ExampleServer\Sales Document Queue\
Archive Documents: Enables archiving of processed documents to SharePoint.

Delete After Archive: Documents are to be deleted from the document queue after successful archive.
Show Delete Confirmation: Determines whether a user is to be asked to confirm deletion.

Auto Link Documents: Enables Auto Link functionality. This determines whether the document queue will
call the GetAutoLink function in the Zetadocs-Send Customize codeunit.

The list at the bottom of the Document Queue card shows the menu items available to the user, when they
click the Archive button from the Zetadocs Document Queue form. Each menu item selects an action.
Through these actions the user can link the captured document with an existing or new NAV record.

Continuing with your setup

This completes the installation of Zetadocs Delivery and Capture Essentials. The next section covers
standard configuration data and how to adjust it to your specific needs. If you are not carrying out any more
configuration you may wish to validate your installation, we have a series of recommended tests in section
20 Testing Zetadocs Delivery and Capture Essentials.

6.6 Setting Document Queue Settings in NAV 5 and 6

The Zetadocs Document Queue card is where all Zetadocs Document Queue settings are defined. It already
contains the default settings imported earlier for the Sales and Purchase Document Queues, revise these as
required following the steps below. To add a new queue simply create another record on this card and fill it
out appropriately.

To open the card:
o Navigate to Administration>Application Setup—>Zetadocs Setup ->Zetadocs Document Queue

Setup.
8 ZDQO001 - Zetadocs Document Queue Card '\ & |D|§]
General |
A B e o O lZDQOOO 1
Name .. ovve v |Sales Document Queue
Path. . v v v oo v vene o | Y|
Archive Documents . . . . . . . v
Delete After Archive . . . . . . v
Show Delete Confirmation. . . . [V
Auto Link Documents . . . . . . { |
Caption IMenu Code ID I
|_»|Create new blanket order ZDCSBLANK (=
|___|Create new credit memo ZDCSCREDIT
|___|Create new invoice ZDCSINV
| |Create new order ZDCSORD
|___|Create new quote ZDCSQUOTE
|___|Create new return order ZDCSRETURN
| |Link to existing blanket order ZDSBLANK
|__|Link to existing credit memo ZDSCREDIT
|___|Link to existing invoice 2ZDSINV
| |Link to existing order ZDSORD
| |Link to existing posted credit memo ZDPSCMEMO
| |Link to existing posted invoice ZDPSINV
| |Link to existing posted return receipt ZDPRRCPT 5
| |Link to existing posted shipment ZDPSSHIP
| |Link to existing quote ZDSQUOTE
|___|Link to existing return order ZDSRETURN l]
Settings w Help |
Figure 5 - Zetadocs Document Queue Card
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No.: The document Queue ID.

Name: The name of the Document Queue.

Path: The location of the document queue folder you created e.g. \\ExampleServer\Sales Document Queue\
Archive Document: Enables archiving of processed documents to SharePoint.

Delete After Archive: Documents are to be deleted from the document queue after successful archive.
Show Delete Confirmation: Determines whether a user is to be asked to confirm deletion.

Auto Link Documents: Enables Auto Link functionality. This determines whether the document queue will
call the GetAutoLink function in the Zetadocs-Send Customize codeunit.

The list at the bottom of the Document Queue card shows the menu items available to the user, when they
click the Archive button from the Zetadocs Document Queue form. Each menu item selects an action.
Through these actions the user can link the captured document with an existing or new NAV record.

Continuing with your setup

This completes the installation of Zetadocs Delivery and Capture Essentials. The next section covers
standard configuration data and how to adjust it to your specific needs. If you are not carrying out any more
configuration you may wish to validate your installation, we have a series of recommended tests in section
20 Testing Zetadocs Delivery and Capture Essentials.
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The advanced configuration section of the guide covers the setup of some of
the extra features and the modification of the standard configuration to
match your requirements.

Chapters

Modifying the Zetadocs Standard Configuration in NAV 7 (NAV 2013)
Modifying the Zetadocs Standard Configuration in NAV 5 and 6

Using Document Templates
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7. Modifying the Zetadocs Standard Configuration
in NAV 7 (NAV 2013) ® ©@ o

Having imported the standard configuration data you should have a basic working system at this point. It
should be capable of sending reports from NAV to recipients using the standard templates included and,
should you have completed the SharePoint installation, documents should also be archived to SharePoint.
This chapter covers how you modify the standard configuration data to create fulfil your specific
requirements.

Zetadocs for NAV Installation Guide

The settings are contained in a number of different pages which each have a different area of focus, we will
go through each of these in turn and have provided a description of each of the fields.

7.1 The Zetadocs General Settings
The Zetadocs General Settings contains settings covering the logging level and archiving to SharePoint. To
access the Zetadocs General Settings:

e Open the Role Tailored client and in the Navigation Pane select Departments >
Administration->Application Setup->Zetadocs Setup -> Zetadocs General Settings.

General
Version: Contains the Zetadocs version numbers, which can prove useful in gaining technical assistance.
Licence Number: Displays the systems Zetadocs licence number.
Licence Type: Displays the systems Zetadocs licence type.
Log Level: Determines the level of information stored in the Zetadocs log file, it offers the following options.
o ERROR - Only writes error information to the log
o INFO - Writes processing information such as key processing values and the error information
e  WARNING - Writes out any potentially problematic states during processing and the info and error
information
o DEBUG- Writes all levels of detail for troubleshooting difficult problems, recommended only when
obtaining support or during installation and configuration

Archiving
Archiving Enabled: This option denotes whether Zetadocs will attempt to archive documents to SharePoint
during Capture or Delivery processing.
SharePoint Site: This setting should be the address of your SharePoint site collection, should you be
utilizing one. e.g. https://example.SharePoint.com/sites/yoursitecollection
Note: If you are integrating with SharePoint online then you must specify the valid https://protocol and not
http://
Document Library: Only specify the SharePoint document library name, not the full URL.
Archive URL: Displays the full target archive library by concatenating the SharePoint Site from the Zetadocs
System Settings and the Archive Library property.
Folder Name Structure: Subdivides archived documents into subfolders of the SharePoint document library
based on information from the sent record. You can specify up to three of these values to generate your file
plan.

e COMPANY —The recipient NAV Customer name

o DATE - The Date with a format specified by the Date Folder Naming property

e DOCTYPE - The Archive Document Type as specified for the current Zetadocs Document Set, or its

override in the Zetadocs Report Settings

Date Folder Naming: Allows you to specify the format of the date folder structure in the SharePoint archive.
E.g. YYYY-MM-DD, DD-MM-YYYY, MM-DD-YYYY etc.

Further advice on file plan settings is available here.

7.2 Zetadocs Document Queue

The Document Queue contains a record for each of the configured document queues and is used to control
their functionality and actions. The Document Queue settings were covered earlier in this guide, please
refer to the section 6.5 Setting Document Queue Settings.
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Specializing Document Queues

It may be advantageous to modify the standard document queue configuration to suit your requirements.
You may want to remove some of the document queue actions if they will be unused or you may want to
create a new queue which has only one possible action. For example, having a document queue specifically
for processing quote requests will mean that there is only one action and therefore the user will not have to
select the action each time. TIP: Reducing the scope of a queue may improve the end user efficiency.

7.3 Zetadocs Delivery Settings

To access the Zetadocs Delivery Settings:

e Open the Role Tailored client and in the Navigation Pane select Departments 2>
Administration->Application Setup->Zetadocs Setup - Zetadocs Delivery Settings.

General

Fax Enabled: Provides Fax functionality, requires the installation of the separate product Zetafax.
Reference Prefix: The reference prefix is the first part of the reference code printed onto documents sent
using Zetadocs, it can be a maximum of 15 characters long.

Sent Items
Archiving Sent Items Enabled: Checking this box results in documents, sent using Zetadocs PDF, being
archived in a central shared network folder. This occurs in addition to any SharePoint archiving setup.
Archive Location: The location of the shared network folder for archiving, it requires a suitable network
folder location. You must also ensure that all Zetadocs enabled users have permission to access this folder.
Note: This option does not support any of the Zetadocs for NAV search features which require SharePoint
integration.
Folder Name Structure: Subdivides archived documents into subfolders of the SharePoint document library
based on information from the sent record. You can specify up to three of these values to generate your file
plan using the Folder Option 1, 2 and 3 fields.

o COMPANY - The recipient NAV Customer name

o DATE - The Date with a format specified by the Date Folder Naming property

o DOCTYPE - The Archive Document Type as specified for the current Zetadocs Document Set, or its

override in the Zetadocs Report Settings

Date Folder Naming: Allows you to specify the format of the date folder structure in the SharePoint archive.
E.g. YYYY-MM-DD, DD-MM-YYYY, MM-DD-YYYY etc.
Further advice on file plan settings is available here.

7.4 Zetadocs Report Settings

The Zetadocs Report Settings is where Zetadocs enabled reports can be associated with a particular
Zetadocs Document Set and therefore a rule definition for sending (template, delivery method, archiving
settings, additional recipients). It is also where recipient information settings are specified. The
configuration data will populate these fields with our standard data setup, it may be necessary to adjust
these values to meet your requirements.

To access the Zetadocs Report Settings:

e Open the Role Tailored client and in the Navigation Pane select Departments >
Administration>Application Setup—>Zetadocs Setup 2> Zetadocs Report Settings.

Properties:
e Areport can only be associated with one Zetadocs Document Set.
e Many reports can be associated with the same Zetadocs Document Set.

Fields

Report ID: The Report ID is unique value given to identify each report.

Report Name: This field is populated when the Report ID is selected.

Document Set No.: The Document Set No. corresponds to the key field of the Zetadocs System Rule Table
linking the report to rules for its distribution.

Document Set Name: Contains the name of the rule that is being applied to the report, it is determined via
the Document Set No. selection.
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Company Type Code: This specifies a table relation between the report record and the recipient. For
example, the standard Sales Quote report is to be sent to a Customer. Therefore, we select ‘CUST’ for the
Company Type Code from the Company Type Code List.

Company No. Field No.: Specifies the field no. of the field in the table the report is based on where the
Company No. should be taken from. For example, the standard Sales Quote report is based on the Sales
Header table. The Customer No. in the Sales Header table is the field “Sell-to Customer No.” field no. 2.
Contact No. Field No.: Specifies the field no. of the field in the table the report is based on where the
Contact No. should be taken from. For example, the standard Sales Quote report is based on the Sales
Header table. The Contact No. in the Sales Header table is field “Sell-to Contact No.” field no. 5052.
Record No. Field No.: Specifies the field no. of the field in the table the report is based on where the records
No. should be taken from. This can be used as a dynamic field for writing the record no. into a template
message as a reference to the recipient and also as a searchable field in the Zetadocs SharePoint archive.
Default Batch Name: When a report prints a number of records to Zetadocs they are held in a batch in the
Zetadocs Client. This field allows you to specify a name for the batch that will be visible in the Zetadocs
Client document explorer.

Show Delivery Dialog: Controls the display of the delivery dialog which allows users to override the
sending rule result for a single report send. For example, the recipient email address.

Show Batch Delivery Dialog: Controls the display of the batch delivery dialog which allows users to
override the sending rule results for a batch of reports. This can be useful to allow users to fix any sending
rule result errors.

Preview in Zetadocs Client: Controls the default value of previewing the Zetadocs documents in the
Zetadocs Client before sending. If the delivery dialog is shown the default can be overridden by the user.
Test Mode: This field allows the administrator to prevent the report from printing the report results to
Zetadocs. It is useful when troubleshooting problems on a live system. When the report is run it will run as
normal up to the point of printing the report documents to Zetadocs.

Comments: Field for any additional information you may wish to add.

7.5 Template Settings

Zetadocs Templates combine stationery overlays and attachment documents as well as supplementary
addressing for any document sent using that template from the Zetadocs Client. The templates can be
created in the Zetadocs Client and saved to a shared network location. Zetadocs will already have created
entries for each type of report supported, these can be modified in the Zetadocs Client, the section on
document templates explains this further. Should you wish to change the template a report uses, for
example if you wished to send out all correspondence for a period with special attachments or a message
as part of a special offer. Then you can create additional templates in the Zetadocs client and assign them
by doing the following.

e Open the Role Tailored client and in the Navigation Pane select Departments >
Administration->Application Setup->Zetadocs Setup > Zetadocs Template List

Fields

Template ID: The ID specific to this particular template.

Path: Contains the path to the folder which stores your templates.
Name: Contains the filename of the template to be used.
Description: A description of the template to help you identify it.

To modify or create a template entry:
e Choose the Template you wish to modify or create a new record and select OK.
e Select Path to choose another template.
e The name field will automatically populate, add a suitable Description and close the window.

7.6 Understanding Zetadocs Rules

Before we discuss the Zetadocs Rule setup we need to outline how the rules operate. When printing a
Zetadocs enabled report, Zetadocs analyses each selected record in turn against the Zetadocs Rules. A rule
is a collection of specific settings which are applied when sending a document with specific properties.
These include details such as the recipient, delivery method (Email, Fax, Hard Copy), Archiving settings and
the template to apply.
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Zetadocs rules come in four levels. On printing a document to Zetadocs the rules are applied in ascending
order. a. Using rules it is possible to be highly specific about the way documents are handled allowing a
great deal of automation of the delivery process.

Rules Levels:
1. The Default Rule — a basic rule that can be used by any Zetadocs enabled report.
2. Per Document Set - specific settings for Zetadocs enabled documents by type.
3. Per Company - specific settings for Zetadocs enabled documents by company.
4. Per Company, per Document Set — specific settings applied to specific document types when sent
to a specific company.

Rule levels are much easier to understand by looking at an example. Our NAV user needs to send out three
Sales Orders to different customers called Sample Company 1, 2 and 3. In an effort to cut down on delivery
costs the standard way of sending documents (default level 1 rule) is to send using email and archive them
to SharePoint. The standard way of sending Sales Orders (a document set) is via Email using the Sales
Order Template (Lv2 rule per document set). There are numerous other settings available when creating
rules but we will focus on delivery method to keep this example simple, please note that other settings are
likewise overridden by higher level rules.

Record 1 Sales Order 33659

Company Sample Company 1

Rule Setup No specific company rules (Lv3 and Lvy4 rules).

Company Sample Company 2

Rule Setup This company likes to receive all correspondence via Fax (Lv3 per Company Rule).

Company Sample Company 3
Rule Setup This company likes to receive most correspondence via fax however they are happy to receive
Sales Orders via email (Lv3 and Lvy4 rules).

On selecting Print on the Sales Order card they are asked to filter to the desired records, on pressing Print
again each record in the print job will be processed in turn. On processing the Zetadocs rule settings are
interrogated to determine the delivery information to associate with each record.

For our first record the system will search for a Lv4 rule and on not finding one would check this would set
delivery to email and the template to the Sales Order template. The details necessary to delivery and
archive are attached as Embedded Commands and the Order is release to the Zetadocs Client for delivery
and archiving.

The second record is then considered, the level 3 rule for this means that Fax is the chosen delivery method
again the details necessary to delivery and archive are attached as Embedded Commands.

The final record has both level 3 and 4 rules, as level 4 rules override those below the document is set to be
delivered by email. The records are then gathered together and sent as a single print job to the Zetadocs
Client. Here the embedded commands are removed and analysed, the templates are applied and the email
message body is created as shown below with values from NAV in red. This provides automated generation
of personalised correspondence, with the delivery information also set the documents are ready to be
delivered and archived.

Subject: Order Confirmation for order number: 33659 for Sample Company 1
Message Body:
FAO: John Smith
Dear Customer,
I'm pleased to attach your order confirmation, reference number 33659.

Kind regards,
Sales Team
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7.7 Zetadocs System Rule
To access the Zetadocs System Rule Card:

e Open the Role Tailored client and in the Navigation Pane select Departments 2>
Administration>Application Setup->Zetadocs Setup - Zetadocs System Rule List.
e Select the system rule you wish to review and modify to open the Zetadocs System Rule Card.

General

Document Set No.: Identifies the document set being used.

Document Set Name: Describes the document set being used.

Template ID: Allows you to specify an alternate template to use when using this rule.

Template Name: Displays the selected template name.

Delivery Method Priority: Implies that if the contact information being used during the sending of a
document that uses this rule is missing addressing information, the next highest priority method will be
used. For example, if the Delivery Method Priority was “E-Mail, Fax, Hard-copy” and the contact
information being used had no email information but did have fax information, then fax addressing would
be used. Similarly, if there was neither email or fax information, then the document would be printed from
Zetadocs to the local system default printer.

Email From: Optional. The user must have access to send emails using the address entered. If left blank
the user’s default email account will be used.

Archive Sent Documents: Determines whether Zetadocs for NAV will attempt to archive sent documents.
Comments: Field for any additional information you may wish to add.

Additional Recipients: Optional. Enter additional recipients either by selecting a contact or by entering the
information manually. The delivery methods available are E-Mail (To, CC or BCC) and Fax. You can enter a
maximum of 5 additional recipients for a system rule. E-Mail distribution lists are supported but they must
be entered as their full E-Mail address and not an alias (E.g. support@equisys.com)

7.8 Customer and Vendor Rule Card

The Zetadocs Customer and Vendor Rule Cards allows you to create a sending rule for a particular
customer/vendor. You must set up a card for each rule, on which you enter the template to use, the contact
details of the recipient and how you want to send your documents.

To access the Zetadocs Customer and Vendor Rule Cards:

e Open the Role Tailored client and in the Navigation Pane select Departments >
Administration>Application Setup—>Zetadocs Setup 2> Zetadocs Customer Rules.

e This displays the Customer Rules List, select the Customer you wish or the new button to view the
Zetadocs Customer Rule Card.

e By replacing Vendor for Customer in the above steps you can access the equivalent vendor options.

General

Customer No.: Allows you to identify the customer, by selecting the arrow you can select them from the
Customer List.

Customer Name: This field is populated when you select the Customer No.

Document Set No.: Selecting the arrow in this field opens the Zetadocs Document Set List from which you
can select the document set.

Document Set Name: This field is populated when you select the Zd Document Set No.

Additional Recipients

Delivery Type: Use the drop down arrow to select the preferred method of sending the document.

Contact No.: Selecting the arrow in this field will open the contact list enabling you to select the additional
contact you wish to send the document to. Note: should you wish to send the item to an address not listed
in the contact list simply fill in the three (manual) fields below.

Name (manual): Enter the contacts name.

Company (manual): Enter the company name.

Address (manual): Enter the address to send documents to, it will be either email address or fax number
depending on the chosen delivery method.
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Delivery

Use Default Contact: The radio button is by default set this setting.

Use Contact: By selecting this option you can specify an alternate contact to use, by selecting the arrow you
can open the Contact List enabling you to choose an alternative contact.

Other: This option allows you to specify an alternate contact that is not contained within the Contact List.
Delivery Method: available options are Use Customer Default, Hard Copy, E-mail and Fax.

Template

Use Default Template: The radio button is by default set this setting.

Use Template: By selecting this option you can specify an alternate template to use, by selecting the arrow
you can open the Zetadocs Template List enabling you to choose an alternative template.

7.9 Zetadocs Delivery Rules

The Zetadocs System Rules were explained earlier as the ability to define how a message being sent is
delivered (Email, Fax or Hard-Copy), how it is formatted (Zetadocs Templates), from which address the
message is sent and where it is archived. Each Zetadocs Document Set can have a separate definition of
these sending settings.

Zetadocs for NAV also has Company Rules, these are the Zetadocs Customer Rules and the Zetadocs Vendor
Rules which add another level of control. The sending rules are best explained as a set of override rule
definitions. It can be viewed as a 4 level system which overrides particular rule settings dependent upon the
document set, the company or a combination of both.

LEVELS:
1. The Default Rule
o Allows you to specify a basic rule that can be used by any Zetadocs enabled report.
2. Per Document Set
o Allows you to specify more specific settings for Zetadocs enabled documents by type.
3. Per Company
o All Zetadocs enabled documents being sent to a particular company can have the
following rule settings overridden (This includes documents which are being sent using
either the Level 1 or a Level 2 rule settings):
i. The contact information to which the document will be sent
ii. The method of delivery by which the document will be sent (Email, Fax, Hard-
Copy)
4. Per Company, per Document Set
o All Zetadocs enabled documents being sent to a particular company and that are part of a
particular document set can have the following rule settings overridden (this includes
documents which are being sent using either the Level 1 or a Level 2 rule settings and has
had some settings already overridden by a Level 3 rule settings)
i. The Zetadocs Template that will be applied to the document
ii. The contact information to which the document will be sent
iii. The method of delivery by which the document will be sent (Email, Fax, Hard-

Copy)

The default Zetadocs for NAV Delivery Rules
By examining this table you should be able to identify the areas where the standard document delivery
settings differ from your needs. The steps below will explain how to adjust these settings.

Report Name Doc Set | Doc Set Name Template | Template Name Delivery  Delivery Delivery
No. ID. Method  Method  Method
1 2 3

Default 0 Default ZT00000 Blank
Purchase Quote | ZDooo1 | Purchase - ZTo0001 ZD-Purchase Email

Quotes Quote Template
Purchase Order | ZDooo2 | Purchase - ZT00002 ZD-Purchase Email

Orders Order Template
Purchase Return | ZDooo3 | Purchase - ZTo0003 ZD-Purchase Email
Order Return Orders Return Order

Template
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Blanket ZDooos4 | Blanket ZT00004 ZD-Blanket Email
Purchase Order Purchase Orders Purchase Order
Template
Sales Quote ZDooos | Sales Quotes ZTooo005 ZD-Sales Quote Email
Template
Order ZDooo6 | Order ZT00006 ZD-Order Email
Confirmation Confirmations Confirmation
Template
Sales Invoice ZDooo7 | Sales - Invoices | ZToooozy ZD-Sales Invoice Email
Template
Sales Credit ZDooo8 | Sales Credit ZTo0008 ZD-Sales Credit Email
Memo Memos Memo Template
Sales Return ZDooog | Sales Return ZT00009 ZD- Sales Return | Email
Order Orders Order Template
Blanket Sales ZDoo1o | Blanket Sales ZT00010 ZD- Blanket Sales | Email
Order Orders Order Template
Remittance ZDoo11 | Remittance ZToo011 ZD-Remittance Email
Advice Journal Advice - Journals Advice Journal
Template
Statements ZDoo12 | Statements ZT00012 ZD- Statements Email
Template
Purchase ZDoo13 | Purchase ZTo0013 ZD-Sales Invoice Email
Invoice Invoice Template
Work Order ZDoo14 | Work Orders ZT00014 Email
Purchase Credit | ZDoo1s | Purchase Credit | ZTooo1s Email
Memo Memo

Let’s look at an example of Zetadocs Rules and their configuration in action. In this case the default
configuration has been imported using the steps earlier in this guide. We will walk through a series of
scenarios which require the creation of level 2, 3 and 4 rules.

The Level 1 Rule — Default Rule
The Zetadocs System Rule card below shows the level 1 rule that will apply to all documents by default
unless overridden by a higher level rule. In this case documents are sent using email with the default
template. We can also set the archiving options on the Archiving Tab, in this example we will set the system

not to archive.

The Level 2 Rule - per document set

Requirement

The sales team has stated a requirement whereby all order confirmations are sent with a copy of the terms
and conditions and use a standard email template.

Solution

Zetadocs templates can be setup to provide all this functionality as described in section 9.1. Assuming we
have created a suitable template or modified one of the Zetadocs templates provided as required. A level 2
rule needs to be setup to ensure this template is applied but only to order confirmations.

e Select the Rule button and select List, next scroll to the Document Set name field and choose Order
Confirmations.

e The card will populate, notice how the ZD-Order Confirmation Template has been assigned as this
is configured as part of the standard configuration data imported earlier.

The level 2 rule details shown below will apply to all documents with the document set Order Confirmation,
meaning that any Order Confirmation document will be sent using the ZD- Order Confirmation Template
whilst the others will use the level 1 rule and thus the default template.

The Level 3 Rule - per Customer

Requirement

Following discussions with one of our customers New Concepts Furniture, the sales team has requested
that all correspondence be sent to Belinda Newman, with the exception of Order Confirmations which
should instead go to John Emory by fax.
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Solution
We need to make a change which affects all items sent to a particular customer, this is done by creating a
level 3 customer rule. We then need to specify a level 4 rule to cover Order Confirmations.

e Inthe NAV Windows Client type Zetadocs Customer Rule in the search bar and navigate to that
page.

e Select the Customer No. field and choose New Concepts Furniture.

e Select the Document Set No. field and set it to o the default value as this is to apply to all items.

e Select the delivery tab, shown below, and select Use Contact: if the new contact is already in your
NAV database or Use Alternate: if it is not.

e Inthis case we’re adding an existing user so select Use Contact and choose Belinda Newman.

e Alldocuments sent to New Concepts Furniture will now use these details.

The Level 4 Rule - per Customer per Document Set

Requirement
The previous level 3 rule will now send all documents to Belinda Newman, but there was also a requirement
for Order Confirmations to go John Emory by fax.

Solution
We need to make a change which affects all items sent using the Document set Order Confirmation and to a
particular customer, this is done by creating a level 4.

¢ Inthe NAV Windows Client type Zetadocs Customer Rule in the search bar and navigate to that
page.

o Create a new rule by pressing F3, select the Customer No. field and choose New Concepts
Furniture.

e Select the Document Set No. field and select Order Confirmation.

e Select the delivery tab and click Use Alternate.

Add the details of the recipient, in this case John Emory, as required.

Next go to the Delivery Method field and select fax.

Close the page and you have now created the level 4 rule.

Starting from the top then, the internal processing determines the send settings by building the results from
the lower level rules up. Assume we are sending an order confirmation and it uses the document set
ZDo0006 — Orders Confirmations.
This will determine the delivery information from the Level 1 & 2 rules specified above:

e Delivery Method: Email

e Template: ZToooo6 - Order

e Archiving Settings: Do not archive

e Contact: Use Default contact
When Zetadocs consults the Level 3 Rules it sees that any document being sent to “New Concepts
Furniture” will be sent to “Belinda Newman” instead of the contact specified by default for the company we
are sending to.
This would mean:
Delivery Method: Email
e Template: ZToooo6 - Order
e Archiving Settings: Do not archive
e (ontact: Belinda Newman

However when Zetadocs consults the Level 4 Rules, it sees that for situations where the company name =
New Concepts Furniture and the Document Set = ZDoooo6 or an Order Confirmation the Level 4 settings
need to be applied.

So the final settings will be:

e Delivery Method: Fax
e Template: ZDooo6 — Order Confirmation
e Archiving Settings: Do not archive
e Contact: John Emory
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Additional Recipients

The additional recipients define in the system and company rules do not override those from the lower level
rule as the other settings do. They are additive. If additional recipients are added for a document set
(ZDoooo6 — Order Confirmations for example), any document sent using that document set will be
addressed to these additional recipients, along with the additional recipients set at a higher level.

Continuing with your setup
This completes the installation of Zetadocs Delivery and Capture Essentials. The next sections cover the

Plus edition setup steps. You may now wish to validate your system, to do this we have a series of
recommended tests in section 20 Testing Zetadocs Delivery and Capture Essentials.
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8. Modifying the Zetadocs Standard Configuration
in NAV5 and 6 ® ©O@ o

Having imported the standard configuration data you should have a basic working system at this point. It
should be capable of sending reports from NAV to recipients using the standard templates included and,
should you have completed the SharePoint installation, documents should also be archived to SharePoint.
This chapter covers how you modify the standard configuration data to create fulfil your specific
requirements.

Contents
The Zetadocs General Settings Form
Zetadocs Document Queue Form
Zetadocs Delivery Settings Form
Zetadocs Report Settings
Template Settings
Understanding Zetadocs Rules
Zetadocs System Rule Card
Customer and Vendor Rule Card
Zetadocs Delivery Rules

The settings are contained in a number of different forms which each have a different area of focus, we will
go through each of these in turn and have provided a description of each of the fields.

8.1 The Zetadocs General Settings Form
The Zetadocs General Settings Form contains settings covering the logging level and archiving to
SharePoint. To access the Zetadocs General Settings:

o Navigate to Administration = Application Setup = Zetadocs Setup >Zetadocs General Settings
form.

EE Zetadocs General Settings i =101 x|

General | Archiving |

Zetadocs for NAV

Version . . . . . . . ... ZDX5.0.206.0,EQ5.0.207

Licence Number. . . . . .

LicenceType . . . .. .. Zetadocs PDF

loglevel . . . ...... |Error| =]

Copyright (c) 2007-2012 Equisys plc and its licensors. All rights reserved. Zetadocs is a registered trademark
of Equisys plc.

Functions w Help |

Figure 6 - Zetadocs General Settings

General Tab

Version: Contains the Zetadocs version numbers, which can prove useful in gaining technical assistance.
Licence Number: Displays the systems Zetadocs licence number.
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Licence Type: Displays the systems Zetadocs licence type.
Log Level: Determines the level of information stored in the Zetadocs log file, it offers the following options.
e ERROR - Only writes error information to the log
e INFO - Writes processing information such as key processing values and the error information
e  WARNING - Writes out any potentially problematic states during processing and the info and error
information
o DEBUG- Writes all levels of detail for troubleshooting difficult problems, recommended only when
obtaining support or during installation and configuration

Archiving tab
Archiving Enabled: This option denotes whether Zetadocs will attempt to archive documents to SharePoint
during Capture or Delivery processing.
SharePoint Site: This setting should be the address of your SharePoint site collection, should you be
utilizing one. e.g. https://example.SharePoint.com/sites/yoursitecollection
Note: If you are integrating with SharePoint online then you must specify the valid https://protocol and not
http://
Archive Library: Only specify the SharePoint document library name, not the full URL.
Archive URL: Displays the full target archive library by concatenating the SharePoint Site from the Zetadocs
System Settings and the Archive Library property.
Folder Name Structure: Subdivides archived documents into subfolders of the SharePoint document library
based on information from the sent record. You can specify up to three of these values to generate your file
plan.

e  COMPANY - The recipient NAV Customer name

o DATE - The Date with a format specified by the Date Folder Naming property

e DOCTYPE - The Archive Document Type as specified for the current Zetadocs Document Set, or its

override in the Zetadocs Report Settings

Date Folder Naming: Allows you to specify the format of the date folder structure in the SharePoint archive.
E.g. YYYY-MM-DD, DD-MM-YYYY, MM-DD-YYYY etc.

Further advice on file plan settings is available here.

8.2 Zetadocs Document Queue Form

The Document Queue Form contains a record for each of the configured document queues and is used to
control their functionality and actions. The Document Queue form settings were covered earlier in this
guide, please refer to the section 6.6 Setting Document Queue Settings.

Specializing Document Queues

It may be advantageous to modify the standard document queue configuration to suit your requirements.
You may want to remove some of the document queue actions if they will be unused or you may want to
create a new queue which has only one possible action. For example, having a document queue specifically
for processing quote requests will mean that there is only one action and therefore the user will not have to
select the action each time. TIP: Reducing the scope of a queue may improve the end user efficiency.

8.3 Zetadocs Delivery Settings Form

To access the Zetadocs Delivery Settings:

e Navigate to Administration - Application Setup = Zetadocs Setup ->Zetadocs Delivery Settings
form.

General Tab

Fax Enabled: Provides Fax functionality, requires the installation of the separate product Zetafax.
Reference Prefix: The reference prefix is the first part of the reference code printed onto documents sent
using Zetadocs, it can be a maximum of 15 characters long.

Network Archiving

Archive Delivered documents: Checking this box results in documents, sent using Zetadocs PDF, being
archived in a central shared network folder. This occurs in addition to any SharePoint archiving setup.
Archive Location: The location of the shared network folder for archiving, it requires a suitable network
folder location. You must also ensure that all Zetadocs enabled users have permission to access this folder.
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Note: This option does not support any of the Zetadocs for NAV search features which require SharePoint
integration.
Folder Name Structure: Subdivides archived documents into subfolders of the SharePoint document library
based on information from the sent record. You can specify up to three of these values to generate your file
plan.

o COMPANY - The recipient NAV Customer name

o DATE - The Date with a format specified by the Date Folder Naming property

o DOCTYPE - The Archive Document Type as specified for the current Zetadocs Document Set, or its

override in the Zetadocs Report Settings

Date Folder Naming: Allows you to specify the format of the date folder structure in the SharePoint archive.
E.g. YYYY-MM-DD, DD-MM-YYYY, MM-DD-YYYY etc.
Further advice on file plan settings is available here.

8.4 Zetadocs Report Settings

The Zetadocs Report Settings is where Zetadocs enabled reports can be associated with a particular
Zetadocs Document Set and therefore a rule definition for sending (template, delivery method, archiving
settings, additional recipients). It is also where recipient information settings are specified. The
configuration data will populate these fields with our standard data setup, it may be necessary to adjust
these values to meet your requirements.

To access the Zetadocs Report Settings:

e Open NAV and select the Administration option from the Navigation Pane.
e Select the Application Setup sub folder within it and then Zetadocs Advanced Setup.
e Select the Zetadocs Report Settings form.

Properties:
e Areport can only be associated with one Zetadocs Document Set.
e Many reports can be associated with the same Zetadocs Document Set.

&8 Blanket Purchase Order Purchase - Blanket Purchase Orders - =10 x|
General | Table Mapping I Options I
ReportID. . . .+ . . . {3009960 1]
ReportName . . . . . . IBIanket Purchase Order
Document SetNo.. . . . |ZD00004 By
Document SetName. . . |Purchase - Blanket Purchase Orders
Default Batch Name . . . |
Comments . . .. ... |
Setting vI Help |

Figure 7 - Zetadocs Report Settings Card — General Tab
Form Fields

General Tab

Report ID: The Report ID is unique value given to identify each report.

Report Name: This field is populated when the Report ID is selected.

Document Set No.: The Document Set No. corresponds to the key field of the Zetadocs System Rule Table
linking the report to rules for its distribution.

Document Set Name: Contains the name of the rule that is being applied to the report, it is determined via
the Document Set No. selection.
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Archive Document Type: The Archive Document Type determines the document type the report will be
stored under in SharePoint, please ensure you have created the appropriate content types in your
SharePoint archive to match these settings.

Default Batch Name: When a report prints a number of records to Zetadocs they are held in a batch in the
Zetadocs Client. This field allows you to specify a name for the batch that will be visible in the Zetadocs
Client document explorer.

Comments: Field for any additional information you may wish to add.

&5 Blanket Purchase Order Purchase - Blanket Purchase Orders - Ze

General Table Mapping IOpﬁons |

Company Type Code . . m
Company No. Field No. . |_2
ContactMo. FieldNo. . . [ 5052
Record No. FieldNo. . . [ 3

Figure 8 - Zetadocs Report Settings Card — Table Mapping Tab

Table Mapping Tab

Company Type Code: This specifies a table relation between the report record and the recipient. For
example, the standard Sales Quote report is to be sent to a Customer. Therefore, we select ‘CUST’ for the
Company Type Code from the Company Type Code List.

Company No. Field No.: Specifies the field no. of the field in the table the report is based on where the
Company No. should be taken from. For example, the standard Sales Quote report is based on the Sales
Header table. The Customer No. in the Sales Header table is the field “Sell-to Customer No.” field no. 2.
Contact No. Field No.: Specifies the field no. of the field in the table the report is based on where the
Contact No. should be taken from. For example, the standard Sales Quote report is based on the Sales
Header table. The Contact No. in the Sales Header table is field “Sell-to Contact No.” field no. 5052.
Record No. Field No.: Specifies the field no. of the field in the table the report is based on where the records
No. should be taken from. This can be used as a dynamic field for writing the record no. into a template
message as a reference to the recipient and also as a searchable field in the Zetadocs SharePoint archive.

=10l x|

£ Blanket Purchase Order Purchase - Blanket Purchase Orders - Ze

General | Table Mapping Options

..........

v
Show Batch Delivery Dialog v
Preview in Zetadocs Client v
Test Mode |

Figure 9 - Zetadocs Report Settings Card — Options Tab
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Options Tab

Show Delivery Dialog: Controls the display of the delivery dialog which allows users to override the
sending rule result for a single report send. For example, the recipient email address.

Show Batch Delivery Dialog: Controls the display of the batch delivery dialog which allows users to
override the sending rule results for a batch of reports. This can be useful to allow users to fix any sending
rule result errors.

Preview in Zetadocs Client: Controls the default value of previewing the Zetadocs documents in the
Zetadocs Client before sending. If the delivery dialog is shown the default can be overridden by the user.
Test Mode: This field allows the administrator to prevent the report from printing the report results to
Zetadocs. It is useful when troubleshooting problems on a live system. When the report is run it will run as
normal up to the point of printing the report documents to Zetadocs.

8.5 Template Settings

Zetadocs Templates combine stationery overlays and attachment documents as well as supplementary
addressing for any document sent using that template from the Zetadocs Client. The templates can be
created in the Zetadocs Client and saved to a shared network location. Zetadocs will already have created
entries for each type of report supported, these can be modified in the Zetadocs Client, the section on
document templates explains this further. Should you wish to change the template a report uses, for
example if you wished to send out all correspondence for a period with special attachments or a message
as part of a special offer. Then you can create additional templates in the Zetadocs client and assign them
by doing the following.

To access the Zetadocs Templates Settings:
e Open NAV and select the Administration option from the Navigation Pane.
o Select the Application Setup sub folder within it and then Zetadocs Advanced Setup.
e Select the Zetadocs Templates form.

Form Fields

Template ID: The ID specific to this particular template.

Path: Contains the path to the folder which stores your templates.
Name: Contains the filename of the template to be used.
Description: A description of the template to help you identify it.

To modify or create a template entry:

e Select Template->List or press Fs.
e Choose the Template you wish to modify or create a new record and select OK.
e Select Path to choose another template.
e The name field will automatically populate, add a suitable Description and close the form.
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=101 x|
Template ID. . . . . . . |zTonoo1
P va s e s [\INTERNATIONAL 1\Zetadocs Templat...
BT e e e r e | ZD-Purchase Quote Template
Description . . . . . . . |Purchase Quote Template|

Figure 10 - Zetadocs Template Card

8.6 Understanding Zetadocs Rules

Before we discuss the Zetadocs Rule setup we need to outline how the rules operate. When printing a
Zetadocs enabled report, Zetadocs analyses each selected record in turn against the Zetadocs Rules. A rule
is a collection of specific settings which are applied when sending a document with specific properties.
These include details such as the recipient, delivery method (Email, Fax, Hard Copy), Archiving settings and
the template to apply.

Zetadocs rules come in four levels. On printing a document to Zetadocs the rules are applied in ascending
order. a. Using rules it is possible to be highly specific about the way documents are handled allowing a
great deal of automation of the delivery process.

Rules Levels:
5. The Default Rule —a basic rule that can be used by any Zetadocs enabled report.
6. Per Document Set — specific settings for Zetadocs enabled documents by type.
7. Per Company — specific settings for Zetadocs enabled documents by company.
8. Per Company, per Document Set — specific settings applied to specific document types when sent
to a specific company.

Rule levels are much easier to understand by looking at an example. Our NAV user needs to send out three
Sales Orders to different customers called Sample Company 1, 2 and 3. In an effort to cut down on delivery
costs the standard way of sending documents (default level 1 rule) is to send using email and archive them
to SharePoint. The standard way of sending Sales Orders (a document set) is via Email using the Sales
Order Template (Lv2 rule per document set). There are numerous other settings available when creating
rules but we will focus on delivery method to keep this example simple, please note that other settings are
likewise overridden by higher level rules.

Record 1 Sales Order 33659
Company Sample Company 1
Rule Setup No specific company rules (Lv3 and Lv4 rules).

Record 2 Sales order 33660

Company Sample Company 2

Rule Setup This company likes to receive all correspondence via Fax (Lv3 per Company Rule).

Record 3 Sales Order 33661

Company Sample Company 3

Rule Setup This company likes to receive most correspondence via fax however they are happy to receive
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| Sales Orders via email (Lv3 and Lv4 rules). |

On selecting Print on the Sales Order card they are asked to filter to the desired records, on pressing Print
again each record in the print job will be processed in turn. On processing the Zetadocs rule settings are
interrogated to determine the delivery information to associate with each record.

For our first record the system will search for a Lv4 rule and on not finding one would check this would set
delivery to email and the template to the Sales Order template. The details necessary to delivery and
archive are attached as Embedded Commands and the Order is release to the Zetadocs Client for delivery
and archiving.

The second record is then considered, the level 3 rule for this means that Fax is the chosen delivery method
again the details necessary to delivery and archive are attached as Embedded Commands.

The final record has both level 3 and 4 rules, as level 4 rules override those below the document is set to be
delivered by email. The records are then gathered together and sent as a single print job to the Zetadocs
Client. Here the embedded commands are removed and analysed, the templates are applied and the email
message body is created as shown below with values from NAV in red. This provides automated generation
of personalised correspondence, with the delivery information also set the documents are ready to be
delivered and archived.

Subject: Order Confirmation for order number: 33659 for Sample Company 1
Message Body:
FAO: John Smith
Dear Customer,

I'm pleased to attach your order confirmation, reference number 33659.
Kind regards,

Sales Team

8.7 Zetadocs System Rule Card
To access the Zetadocs System Rule Card:

e Open NAV and select the Administration option from the Navigation Pane.
e Select the Application Setup sub folder within it and then Zetadocs Advanced Setup.
e Select the Zetadocs System Rule Card.
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8 0 Default - Zetadocs System Rule Card ) =10l x|
General I
Document SetNo.. . . . | 0 il
Document Set Name. . . (Default
TemplateID. . . . . . . IZTOOOOI i I
Template Name . . . . . lZD-Purchase Quote Template
Delivery Method Priority . |E-Mail | |Hard Copy >l |
E-MailFrom. . . . . .. |Sales@example.com
Archive Sent Documents. [V
Comments . . .. ... |
Delivery Type | Contact No. [Name | company | Address | Additional Recipient Information
| *p | E-Mail To 4| Name:
— Company:
— Address:
| o
«| | »
Rule vI Help I
Figure 11 - Zetadocs System Rule Card - General Tab
Form Fields
General Tab

Document Set No.: Identifies the document set being used.

Document Set Name: Describes the document set being used.

Template ID: Allows you to specify an alternate template to use when using this rule.

Template Name: Displays the selected template name.

Delivery Method Priority: Implies that if the contact information being used during the sending of a
document that uses this rule is missing addressing information, the next highest priority method will be
used. For example, if the Delivery Method Priority was “E-Mail, Fax, Hard-copy” and the contact
information being used had no email information but did have fax information, then fax addressing would
be used. Similarly, if there was neither email or fax information, then the document would be printed from
Zetadocs to the local system default printer.

Email From: Optional. The user must have access to send emails using the address entered. If left blank
the user’s default email account will be used.

Archive Sent Documents: Determines whether Zetadocs for NAV will attempt to archive sent documents.
Comments: Field for any additional information you may wish to add.

Additional Recipients: Optional. This field is available on both the general and archiving tabs. Enter
additional recipients either by selecting a contact or by entering the information manually. The delivery
methods available are E-Mail (To, CC or BCC) and Fax. You can enter a maximum of 5 additional recipients
for a system rule. E-Mail distribution lists are supported but they must be entered as their full E-Mail
address and not an alias (E.g. support@equisys.com)

8.8 Customer and Vendor Rule Card

The Zetadocs Customer and Vendor Rule Cards allows you to create a sending rule for a particular
customer/vendor. You must set up a card for each rule, on which you enter the template to use, the contact
details of the recipient and how you want to send your documents.
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{ Progressive Home Furnishings Purchase - Return Orders - Zetadocs Customer Rule Card ) =101 x]

General IDeIivery I Template I

TG Contact Information
AL Name  Mr. ScottMitchel
Customer Name E-Mail progressive.home. furnishin. ..
D nent Seto 0000 En
Document Set Name
Comments
Template Information

Name ZD-Purchase Return Order ...

| |Delivery T... | Contact No. | Name Company | Address | Additional Redipient Information
o | EE - ]| e

Company

Address

54
< | »

Rule vl Help I

Figure 12 - Zetadocs Customer Rule Card — General Tab

General Tab

Customer No.: Allows you to identify the customer, by selecting the arrow you can select them from the
Customer List.

Customer Name: This field is populated when you select the Customer No.

Document Set No.: Selecting the arrow in this field opens the Zetadocs Document Set List from which you
can select the document set.

Document Set Name: This field is populated when you select the Zd Document Set No.

Delivery Tab

Use Default Contact: The radio button is by default set this setting.

Use Contact: By selecting this option you can specify an alternate contact to use, by selecting the arrow you
can open the Contact List enabling you to choose an alternative contact.

Other: This option allows you to specify an alternate contact that is not contained within the Contact List.
Delivery Method: available options are Use Customer Default, Hard Copy, E-mail and Fax.

Template Tab

Use Default Template: The radio button is by default set this setting.

Use Template: By selecting this option you can specify an alternate template to use, by selecting the arrow
you can open the Zetadocs Template List enabling you to choose an alternative template.

Additional Recipients

The additional recipients section is visible on all tabs at the bottom of the card.

Delivery Type: Use the drop down arrow to select the preferred method of sending the document.

Contact No.: Selecting the arrow in this field will open the contact list enabling you to select the additional
contact you wish to send the document to. Note: should you wish to send the item to an address not listed
in the contact list simply fill in the three (manual) fields below.

Name (manual): Enter the contacts name.

Company (manual): Enter the company name.

Address (manual): Enter the address to send documents to, it will be either email address or fax number
depending on the chosen delivery method.

8.9 Zetadocs Delivery Rules
The Zetadocs System Rules were explained earlier as the ability to define how a message being sent is
delivered (Email, Fax or Hard-Copy), how it is formatted (Zetadocs Templates), from which address the
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message is sent and where it is archived. Each Zetadocs Document Set can have a separate definition of
these sending settings.

Zetadocs for NAV also has Company Rules, these are the Zetadocs Customer Rules and the Zetadocs Vendor
Rules which add another level of control. The sending rules are best explained as a set of override rule
definitions. It can be viewed as a 4 level system which overrides particular rule settings dependent upon the
document set, the company or a combination of both.

LEVELS:
5. The Default Rule
o Allows you to specify a basic rule that can be used by any Zetadocs enabled report.
6. Per Document Set
o Allows you to specify more specific settings for Zetadocs enabled documents by type.
7. PerCompany
o All Zetadocs enabled documents being sent to a particular company can have the
following rule settings overridden (This includes documents which are being sent using
either the Level 1 or a Level 2 rule settings):
i. The contact information to which the document will be sent
ii. The method of delivery by which the document will be sent (Email, Fax, Hard-
Copy)
8. Per Company, per Document Set
o All Zetadocs enabled documents being sent to a particular company and that are part of a
particular document set can have the following rule settings overridden (this includes
documents which are being sent using either the Level 1 or a Level 2 rule settings and has
had some settings already overridden by a Level 3 rule settings)
i. The Zetadocs Template that will be applied to the document
ii. The contact information to which the document will be sent
iii. The method of delivery by which the document will be sent (Email, Fax, Hard-

Copy)

The default Zetadocs for NAV Delivery Rules
By examining this table you should be able to identify the areas where the standard document delivery
settings differ from your needs. The steps below will explain how to adjust these settings.

Report Name Doc Set | Doc Set Name Template = Template Name Delivery  Delivery @ Delivery
No. ID. Method Method Method
1 2 3
Default 0 Default ZT00000 Blank Email
Purchase Quote | ZDooo1 | Purchase - ZT00001 ZD-Purchase Email
Quotes Quote Template
Purchase Order | ZDooo2 | Purchase - ZT00002 ZD-Purchase Email
Orders Order Template
Purchase Return | ZDooo3 | Purchase - ZTo0003 ZD-Purchase Email
Order Return Orders Return Order
Template
Blanket ZDoooy4 | Blanket ZT00004 ZD-Blanket Email
Purchase Order Purchase Orders Purchase Order
Template
Sales Quote ZDooos | Sales Quotes ZToo005 ZD-Sales Quote Email
Template
Order ZDooo6 | Order ZT00006 ZD-Order Email
Confirmation Confirmations Confirmation
Template
Sales Invoice ZDooo7 | Sales - Invoices | ZToooo7 ZD-Sales Invoice Email
Template
Sales Credit ZDooo8 | Sales Credit ZTo0008 ZD-Sales Credit Email
Memo Memos Memo Template
Sales Return ZDooo9 | Sales Return ZTo0009 ZD- Sales Return | Email
Order Orders Order Template
Blanket Sales ZDoo1o | Blanket Sales ZToo010 ZD- Blanket Sales | Email
Order Orders Order Template
Remittance ZDoo11 | Remittance ZT00011 ZD-Remittance Email
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Advice Journal Advice - Journals Advice Journal
Template
Statements ZDoo12 | Statements ZT00012 ZD- Statements Email
Template
Purchase ZDoo13 | Purchase ZTo0013 ZD-Sales Invoice Email
Invoice Invoice Template
Work Order ZDoo14 | Work Orders ZT00014 Email
Purchase Credit | ZDoo1s | Purchase Credit | ZTooo1s Email
Memo Memo

Let’s look at an example of Zetadocs Rules and their configuration in action. In this case the default
configuration has been imported using the steps earlier in this guide. We will walk through a series of
scenarios which require the creation of level 2, 3 and 4 rules.

The Level 1 Rule — Default Rule
The Zetadocs System Rule card below shows the level 1 rule that will apply to all documents by default
unless overridden by a higher level rule. In this case documents are sent using email with the default

template. We can also set the archiving options on the Archiving Tab, in this example we will set the system
not to archive.

=Y
General |
Document SetNo.. . . . [—0]
Document Set Name. . . |Default
Template 1D, . . . . . . [zroooor &l
Template Name . . . . . |ZD-Purchase Quote Template
Delivery Method Priority . [E-Mail | |Hard Copy >l ~|
EMailFrom. . . . ... |Sales @example.com
Archive Sent Documents. [V
Comments . . . . ... |
Delivery Type | Contact No. [Name | company | Address | Additional Recipient Information
E-Mail To |  Name:
Company:
Address:

LI

Figure 13 — Level 1 Zetadocs System Rule Card

The Level 2 Rule - per document set

Requirement

The sales team has stated a requirement whereby all order confirmations are sent with a copy of the terms
and conditions and use a standard email template.

Solution

Zetadocs templates can be setup to provide all this functionality as described in section 9.1. Assuming we
have created a suitable template or modified one of the Zetadocs templates provided as required. A level 2
rule needs to be setup to ensure this template is applied but only to order confirmations.

e Select the Rule button and select List, next scroll to the Document Set name field and choose Order
Confirmations.
e The card will populate as shown in the figure below, notice how the ZD-Order Confirmation

Template has been assigned as this is configured as part of the standard configuration data
imported earlier.
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The level 2 rule details shown below will apply to all documents with the document set Order Confirmation,
meaning that any Order Confirmation document will be sent using the ZD- Order Confirmation Template
whilst the others will use the level 1 rule and thus the default template.

-iaix]
General I
Document SetNo.. . . . m
Document Set Name. . . |Order Confirmations
TemplateID. . . . . . . [zrooooe 4
Template Name . . . . . |ZD-Order Confirmation Template
Delivery Method Priority . [E-Mail E3 | I |
EMailFrom. . . . ... |
Archive Sent Documents. [
Comments . . . . ... |
Delivery Type | Contact No. [Name | company | Address | Additional Recipient Information
E-Mail To 4| Name:
Company:
= Address:

HRREEC

-
«| | »

Figure 14 - Level 2 Zetadocs System Rule Card
The Level 3 Rule - per Customer

Requirement

Following discussions with one of our customers New Concepts Furniture, the sales team has requested
that all correspondence be sent to Belinda Newman, with the exception of Order Confirmations which
should instead go to John Emory by fax.

Solution

We need to make a change which affects all items sent to a particular customer, this is done by creating a
level 3 customer rule. We then need to specify a level 4 rule to cover Order Confirmations.

e Select the Administration option in the Navigation pane and then Application Setup.

e Open the Zetadocs Setup > Advanced Settings section and select the Zetadocs Customer Rule
Card.

e Select the Customer No. field and choose New Concepts Furniture.
e Select the Document Set No. field and set it to o the default value as this is to apply to all items.

e Select the delivery tab, shown below, and select Use Contact: if the new contact is already in your
NAV database or Use Alternate: if it is not.

e Inthis case we’re adding an existing user so select Use Contact and choose Belinda Newman.
e Alldocuments sent to New Concepts Furniture will now use these details.
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B8 New Concepts Furniture Default - Zetadocs Customer Rule Card g = |EI|£]
General Delivery I Template I
i Contact Information
Us Name Belinda Newman
e Gt ICT100152 E-Mail belinda.newman@cronusco...
" Use Alternate: ot
§ a5y [
EMai S rersis sz sz [
FaxNo, . . |
Delivery Method . . . . . . JUse Customer Default ~] Template Information
Name ZD-Purchase Quote Template
Delivery T... [ContactNo. [ Name [ Company [Address [ Additional Recipient Information
| #p | E-Mail To a| Name
— Company
— Address
| A
< | »

Figure 15 - Level 3 rule shown on Customer Rule Card

The Level 4 Rule - per Customer per Document Set

Requirement

The previous level 3 rule will now send all documents to Belinda Newman, but there was also a requirement
for Order Confirmations to go John Emory by fax.

Solution

We need to make a change which affects all items sent using the Document set Order Confirmation and to a
particular customer, this is done by creating a level 4.

e Select the Administration option in the Navigation pane and then Application Setup.
e Open the Zetadocs Setup section and select the Zetadocs Customer Rule Card.

Create a new rule by pressing F3, select the Customer No. field and choose New Concepts
Furniture.

Select the Document Set No. field and select Order Confirmation.
Select the delivery tab and click Use Alternate.

Add the details of the recipient, in this case John Emory, as required.
Next go to the Delivery Method field and select fax.

Close the form and you have now created the level 4 rule.
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- Contact Information
Use Default fe John Emory
€ Use Contact: | E| E-Mail john.emory@newconcepts...
& Use Alternate: FaxNo. 555-316 5279
Names: G ties |30hn Emory
EMal. s s mbecd site Jiohn.emory @newconceptsfurnitur. ..
FakNO 5% sl o [555-316 5279
Delivery Method . . . . . . [Fax =l Template Information
Name ZD-Order Confirmation Tem...
Delivery T... [Contact No. [ Name [ company | Address | Additional Recipient Information
E-Mail To 4| Name
Company

Address

[T ITTTIe]

<« |

Figure 16 - Level 4 rule shown in the Customer Rule List

Starting from the top then, the internal processing determines the send settings by building the results from
the lower level rules up. Assume we are sending an order confirmation and it uses the document set
ZDo0006 — Orders Confirmations.
This will determine the delivery information from the Level 1 & 2 rules specified above:

e Delivery Method: Email

e Template: ZToooo06 - Order

e Archiving Settings: Do not archive

e Contact: Use Default contact
When Zetadocs consults the Level 3 Rules it sees that any document being sent to “New Concepts
Furniture” will be sent to “Belinda Newman” instead of the contact specified by default for the company we
are sending to.
This would mean:

e Delivery Method: Email

e Template: ZToooo6 - Order

e Archiving Settings: Do not archive

e Contact: Belinda Newman

However when Zetadocs consults the Level 4 Rules, it sees that for situations where the company name =
New Concepts Furniture and the Document Set = ZDoooo6 or an Order Confirmation the Level 4 settings
need to be applied.

So the final settings will be:

Delivery Method: Fax

Template: ZDooo6 — Order Confirmation

Archiving Settings: Do not archive

Contact: John Emory

Additional Recipients

The additional recipients define in the system and company rules do not override those from the lower level
rule as the other settings do. They are additive. If additional recipients are added for a document set
(ZDoooo6 — Order Confirmations for example), any document sent using that document set will be
addressed to these additional recipients, along with the additional recipients set at a higher level.

Continuing with your setup

This completes the installation of Zetadocs Delivery and Capture Essentials. The next sections cover the
Plus edition setup steps. You may now wish to validate your system, to do this we have a series of
recommended tests in section 20 Testing Zetadocs Delivery and Capture Essentials.
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Zetadocs for NAV has a number of preconfigured document templates included within it to make setting up
a system quicker and easier. These templates contain Zetadocs stationery and a message body which have
been deliberately constructed to provide a starting point from which to build and customize your system.
Should you wish to construct your own templates instructions on manually creating them are available in
the help installed with the Zetadocs Client. You should though find it easier to follow the instructions here
to modify the standard templates to your needs.

Note: If you are installing in a language other than English you should first check your templates folder as it
should contain a folder with templates specific to your language. Copy these files into the main templates
folder replacing the existing English language templates before proceeding with the steps below.

Contents
Preconfigured Document Template Features
Template Wizard - Adding an attachment to a template
Replacing the stationery
Adjusting the Email message

9.1 Preconfigured Document Template Features
The document templates contain Zetadocs stationery and a suitably generic message body reflective of
each templates purpose.

Attachments
The document templates come without an attachment included to allow you to include your own company
specific documents like terms and conditions that you may wish to distribute.

Stationery

A single stationery file has been provided which by default is applied to all ZD Templates included with your
installation. This means you would only be required to update this stationery once for it to apply to all
document templates.

Message Body Text

The message body text contains a default message which would form the email message body and subject
when the document is sent using Zetadocs for NAV. This allows for the use of dynamics fields to populate
information from NAV automatically into the email reducing the time required to process business
documents. In the message in section 9.4 you can clearly see several examples of these fields.

Viewing the Template details
To view the Zetadocs for NAV template details simply:

Open the Zetadocs Client.
Select the Shared network folder setup earlier containing your templates in the accessories pane
on the right hand side using the folder drop down box shown below. If the accessories pane is not
displayed select the Accessories button from the toolbar to display it.
e Ensure the Type drop down box is set to Templates.
Double click on the Template you wish to adjust to open the Document Template Wizard.
The pages of the wizard cover contain:
o AnIntroduction to templates

o Assignment of attachments
o Assignment of Stationery
o Email properties
o Template Review and Save
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Accessonies ]
Folder: Zetadoos for May s | 3¢
Type: Templates v

_/v:| Bazic

_/-zf| Conditions of Purchase

_/+f| Conditions of 5 ale

(vf| General ZDMAY T emplate

_/vf| Purchasze Invoice ZDNAY Template
_/+f| Purchase Order ZDMN&Y T ernplate
E{II Sales Invoice ZDMAY Template

LY

Sales Order ZDNAY Template

Figure 17 — Opening the Document Template Wizard

9.2 Template Wizard - Adding an attachment to a template

The preconfigured templates supplied do not come with an attachment included as this would make them
unusable *out of the box’ as such if you require attachments to be sent along with your business documents
then please follow the steps below.

Any file that you use on a regular basis can be stored as an attachment file for ease of use. These files can
be attached to any spooled document prior to sending quickly and easily using the Accessories tool. By
specifying an attachment in a template you ensure it is always included when a document is sent using that
template with Zetadocs for NAV.

Note: That if your attached file is large this may reduce performance when sending large batches as the
attachment would have to be processed for each document delivered. As such we would recommend that
you check to ensure that attachments are as efficient in terms of memory required as possible.

To add an attachment simply:

e Copy your desired attachment (e.g. terms and conditions) in pdf format into the shared folder
location, likely to be in the form \\ServerName\Zetadocs Templates\

e Open the Zetadocs Client and select the template you wish to modify by double clicking on it in the

Accessories pane, see Figure 17.

The template wizard will open, Select Next to reach the attachments step of the wizard.

Select the Shared Network Folder by selecting the Folder drop down box.

Your attachment should appear as one of the attachment options.

Select the attachment and click the Add button.

Select Next to be taken to the stationery template wizard page. If you are happy with the existing

settings in the remaining wizard steps skip past them using next and select Finish to save your

changes.

9.3 Replacing the stationery

The templates comes with stationery included, this single piece of stationery is applied to all of the
templates provided. As such by simply replacing this one file you can ensure your stationery is applied to all
of the provided templates.

Note: That if your stationery file requires a large amount of memory this may reduce the performance of
Zetadocs when sending large batches. This is because it would have to be processed for each page of each
document delivered. To reduce the size of this document we would recommend ensuring that any images
used are of a suitable format, quality and size. We would also recommend that users avoid scanning their
existing paper stationery as this creates large files, it is better instead to isolate and extract any images or
required elements before recreating the overall effect using word for example. It should be possible to
create stationery of a suitable quality which is around 30kb's in size or less.
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Adding company stationery to the Zetadocs client
To add your stationery to the Zetadocs Client simply open your existing company stationery and print it
selecting the Zetadocs PDF printer using the steps below.

Open your stationery in Word or another suitable application. The standard stationery has been
provided to you in Word format in the templates folders as well, so you can adjust and print that if
desired.

e Select print and select Zetadocs PDF as your printer.

e This will open the Zetadocs client with your stationery within it.

e Select the File menu and then Save As Stationery.

e You will then be prompted to provide the name and save location of the stationery, you should
select the shared network folder mentioned earlier this is likely to be in the form
\\ServerName\Zetadocs Templates\.

e Ifyou wish to apply this stationery to the existing preconfigured templates this file should be
named ZD - Stationery.zds this will over-right the existing standard stationery and will now be
used by all of the templates provided.

e Should you wish to apply this stationery to a single template, name the file as you see fit then open
the Zetadocs client.

o Next open the template wizard by double clicking on the template you wish to modify.

e Go to the third page of the wizard using the next button the screen shown in Figure 18 will appear.

e Select your stationery by selecting the Folder drop down box and selecting the Shared Network
folder.

e Selecting the existing stationery from the selected stationery window as shown.

F}. Document Template Wizard
Please choose your stationery equisys
ZETAQOCS
If you wish to add stationery, please select one or more items from the list and press the Add button. Use the
Falder option to browse for stationery in other folders.
Folder: [Zetadocs for NAV templates
01 ZDNAV-Equisys letterhead-TopLeft
[ ZDNAV-Equisys letterhead
Selected Stationery:
o ZD - Stationery
Figure 18 — The Document Template Wizard

e C(lick the Remove button.

e Select your new stationery file and press Add.

e Select Next to be taken to the email message template wizard page. If you are happy with the
existing message select next again and then select Finish to save your changes. Note: the class
feature is not required for NAV users.
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9.4 Adjusting the Email message

The preconfigured templates contain an email message populated with dynamics field data from NAV and
static text generically phrased to allow them to be applicable in a number of situations. The messages, like
the one shown below, work with NAV to automatically create a personalised message that contains contact
details, names, order numbers and organization names.

Messages using Dynamics Fields

Subject: Order Confirmation for order number: %%/[ZetadocsRecordNo] for
%%][Organization]

Message Body:
FAO: %%][Name]

Dear Customer,
I'm pleased to attach your order confirmation, reference number %%[ZetadocsRecordNo].

Kind regards,
Sales Team

When sent using the Zetadocs for NAV Client these fields are replaced with the corresponding fields from
NAV, and would appear thus:

Message with Dynamic Fields Populated
Subject: Order Confirmation for order number: 300381 for Equisys plc

Message Body:
FAO: John Smith

Dear Customer,
I'm pleased to attach your order confirmation, reference number 300381.

Kind regards,
Sales Team

By amending the document template you will be able change the content of every email message sent using
that template. It is possible to include a variety of other dynamically populated fields within your email; by
default you will have access to the following:

%%[Name]
%%[FirstName]
%%[Surname]
%%[ZetadocsCompanyNo]
%%[ZetadocsRecordNo]
%%[Organization]
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F]' Document Template Wizard (3]

Please enter your email properties equisys

ZETACOCS
Subject: Order Confirmation for order number: % [Zetadocs RecordMa] for %% [Organization]

Standard = Tahoma  12pt - =
9 B I U= 4 3B HM

i— m—

4

»

FAQ: %%[Name,Customer]
Dear Customer,

I'm pleased to attach your order confirmation, reference number %% J
[ZetadocsRecordNo].

Kind regards,

Sales Team

Help <Back || MNet> || Cancel

Figure 19 - Document Template Wizard - Email Message Body

To adjust the email message you need to view the template in the Zetadocs Client using the document
template wizard. To open the document template wizard for a particular template follow the steps in section

9.1.

The first three pages of the wizard contain:
An introduction to templates

The assignment of attachments

The selection of stationery

page (see Figure 18 above).

e Adjust this content to match your needs remembering that the dynamic fields use the format

%%[Name] and will be replaced in the message by the corresponding NAV value.
e Click Next to review the templates contents and select Finish to save your changes.
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10.SDK Primer ® o

Zetadocs for NAV Installation Guide

The Zetadocs for NAV SDK is made up of two parts, Zetadocs Capture Plus and Zetadocs Delivery Plus. It
was created to allow NAV developers to further customize the Zetadocs for NAV features to meet bespoke
requirements. With the SDK it is easy to leverage the core features of Zetadocs for NAV, Delivery and
Capture, to provide complex, high value business processes that are fully integrated into NAV.

NOTE: To get the most from the Zetadocs for NAV SDK it is recommended that you take a moment to
understand the goals of the SDK and the logic behind the framework. This section aims to give a short
overview of the SDK framework which will then simplify your understanding of the Capture and Delivery
Plus examples in the subsequent chapters and help you in designing good solutions with Zetadocs.

10.1 Goals of the SDK

It is common in the NAV community that customizations are implemented as and where the developer sees
fit. Most NAV objects are open to developers to modify. The positive aspect of this is the speed of
implementation. However there is a negative aspect and that is the cost of maintenance and upgrade.
Equisys identified the challenge this presents for developers and has designed this SDK with this in mind.
Our goal is to make upgrades and patches of the Zetadocs for NAV product much simpler and faster by
removing the need to merge customizations into updated object versions. Our SDK goals are:

1. Structured - Provide designated entry points for NAV developer code
2. Flexible - Integrate Zetadocs for NAV features with any records of NAV*
3. Intuitive — Use a framework to provide a consistent style of customization implementation

*This refers to the use of the typeless RecordID and RecordRef types over the strongly typed Record type. There is no guaranteed of
the suitability of any NAV record for use with Zetadocs.

10.2 Understanding the Framework
There are three elements to the Zetadocs for NAV SDK. They are:

1. Interfaces
e This is the name given to existing NAV forms, pages, codeunits or reports that are
modified to call the Zetadocs for NAV Core codeunits to provide Zetadocs for NAV
functionality. Our aim is to make these modifications as minimal as possible.
2. Zetadocs Core Codeunits
e These are our codeunits which developers do not have modify permissions for. They
perform the bulk of Zetadocs for NAV processing and call the Integration and
Customization codeunits to run developer code.
3. Integration and Customization Codeunits
e These are our codeunits which developers with the Zetadocs SDK granule do have modify
permissions for. They provide simple call out functions which the developer implements
his custom code in.

Developers should look to understand the integration and customization entry points before designing their
solution.

10.3 Process Flow
The processing flow follows the same pattern in both Plus feature areas.

1. The interfaces calls the Zetadocs Core codeunits which use the Zetadocs for NAV settings to
perform the action.

2. Ifthere is no suitable configuration available for the records being processed then the Zetadocs
Code calls out to the Integration and Customization codeunits to get the information. It is here that
the developer can implement bespoke settings and integrate with custom records.

3. Once all processing has been completed, the Zetadocs Core calls out to the Customization
codeunits with modifiable data sets to instruct the core codeunits on how to complete the action
processing. It is here that the developer can implement custom business logic, enhanced Zetadocs
feature functionality and integration with other subsystems.
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4. Finally, having processed the developer modifications, the Zetadocs Core codeunits call outside of
NAV to use the Zetadocs for NAV Client components to complete the functionality.

/—Zetadocs Code codeunits—\ Zetadocs
( Integration N\
CAPTURE & 7 — I
SEND Functions
Interface ~ Zetadocs
/" Customization )
Override
Functions
o J AN J
NAV ‘ \
j External Components
Codeunit
Table
ﬁ‘mm’ Interfaces
Private Public
Notation
Figure 20 - Zetadocs for NAV SDK Architecture
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1. Zetadocs Capture Plus <

Note: The following sections of the installation guide cover the installation and setup of the features
provided as part of the Zetadocs for NAV Capture Plus module. These changes can only be made by those
with the Zetadocs Capture Plus SDK which requires Capture Plus module licence from Equisys.

The Zetadocs Capture Plus is an optional component of Zetadocs for Microsoft Dynamics and is required for
implementing custom Document Queues and bespoke business logic in Zetadocs for NAV capture features.
At its core is the Zetadocs Server which runs on your server and converts documents placed into a Shared
Network folder into PDF/A format. It works with Microsoft Dynamics NAV and enables the document queues
to work with a wide range of documents by converting inbound documents into PDF/A. As standard the
document queue supports a variety of file types, allowing viewing, processing and eventual archive of these
documents to SharePoint.

This provides a number of benefits:
e Documents are stored in a standard storage format (PDF/A)
e Document content is searchable within SharePoint including text which is part of graphics, if OCR
is enabled (optional requires additional licence)

By storing all documents within SharePoint you enable a wider range of your company’s staff to access
these documents despite perhaps not having a copy of the native software for the document. It also means
that you have a copy of the document that is an accurate representation of the document when it was
received.

The list below covers some of the options available to Capture Plus customers, typically these are used to
streamline document handling and management processes.

Capture Plus Features Include:
e  Capture and Conversion of inbound documents to PDF/A format
Custom Document Queues
Optical Character Recognition
Barcode Recognition
On screen approval with workflows
Document Association
Bespoke business logic and capture feature customizations

11.1 Understanding the Capture Plus SDK Framework
Before continuing it is recommended that you read the Zetadocs for NAV SDK Primer section of this
document.

The three elements to the Zetadocs for NAV Capture Plus SDK are:

1. Interfaces
e Zetadocs Document Queue (Form / Page)
o This has been designed to work for any queue and should not be modified to
implement customizations without consulting Equisys plc.
o NAS
o Itis possible to author a NAS service to automatically perform scheduled
document queue processing.
2. Zetadocs Core Codeunits
e Zetadocs Capture codeunit
o This codeunit provides functions that are called by the Interfaces to complete
linking actions.
3. Integration and Customization Codeunits
e Zetadocs Capture Integration codeunit
o This is currently not used and is only present for backward compatibility with
earlier versions
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e Zetadocs Capture Customize codeunit
o This codeunit has functions called by the Zetadocs Core codeunits to allow the
developer to implement custom queues and bespoke business logic.

11.2 Process Flow
The processing flow follows the standard Zetadocs for NAV SDK pattern.

Zetadocs Capture codeunit: Zetadocs
. ° ) Capture
Integration
Document
Queue U CAPTURE S S— Integration
CORE Functions
PROCESSING

\— Zetadocs —/

) Capture
Zetadocs Settings /—Customizalion

Tables

Integration,

— S— Metadata and

Customization
Functions

NAS codeunit

A J ~~—

NAV ‘ \

j External Components

Codeunit:
Table Records
Interfaces (Filtered Table)

Notation

Figure 21 - Zetadocs Capture Plus Process Flow

11.3 Capture Plus Example Scenario

It is easier to understand how these features all come together by looking at a brief example of how they
can be used to improve document handling.

Scenario: A company sends out Shipment notes printed from NAV with their deliveries, these are signed by
the customer and returned before being processed and filed.

Solution: By using Capture Plus you can automate and streamline this process significantly, firstly on
printing the Shipment note from NAV, Zetadocs can add a Barcode to the document. It is then signed as
usual by the customer but on return it is simply scanned. Zetadocs can then recognise the barcode and
automatically adds a Pdf copy of the document to your archive and associates it with the original order that
the Shipment note was based upon. This is done using a custom Shipment Document Queue. It gives the
user processing these documents a single location from where they can view the signed Shipment Note and
create and send the corresponding invoice. This provides the organisation with an archive that is populated
with related records e.g. a Quote, Order, Shipment Note, Returned Signed Shipment Note, Invoice which
enables them to view the whole transaction workflow from SharePoint. We will demonstrate how to setup
this Shipment example in the coming pages.

The sample code to achieve this is shipped as part of the Zetadocs-Capture Customize codeunit (9009964).

11.4 Overview of the Zetadocs Capture Plus Install
Zetadocs Capture Plus is based around the integration of the Zetadocs Server with NAV and your other
Zetadocs components to provide a range of enhanced functionality.
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This section will take you through the setup of each of the following:

Zetadocs Server

Custom Document Queues

Barcode support

Adding Document Queues to a Role Center

11.5 Zetadocs Server Install

Installing the Zetadocs Server for use as part of the Capture Plus solution is no different to a standard
Capture Essential installation. The only steps that are different in this example scenario will be the creation
of a Shared Network folder specifically for our custom Shipment Queue and configuring the Zetadocs Server
to point at this folder. Please refer to the sections in the chapter Capture Essentials Setup for instructions
on how to install the Zetadocs Server and adding a queue to the configuration either instead of or on top of
configuring the Sales and Purchase Queue paths add a Document Queue section for the Shipment Queue
depending on your requirement.

Summary of steps:
1. Install the Zetadocs Server
2. Create a shared network folder on the same machine and share as:
o \\*yourmachinename*\Shipment Queue
3. Configure the Zetadocs Server to point at this shared network folder as one of the queues.

11.6 Custom Document Queue Configuration in NAV

To start processing documents from a queue we need to add the queue settings to Zetadocs for NAV. Let’s
continue our example by configuring the Shipment Queue in NAV.

First you need to decide on the actions that you will implement for your queue. The action that is performed
is up to you. Obviously the typical action is to associate (often referred to as linking) the document with a
record in NAV and then to archive the document. There is potential to use the document queues as events
that will start other operations or modify NAV data tables. It is entirely up to you what you want to
implement in your actions. In this example we will implement just one linking action. To add new actions
you need to run the Zetadocs Doc. Queue Actions table from the Object Designer and enter the item.

1. Runtable 9009991
2. Add a new action ID ZDSHIP and its description

i

= Zetadocs Doc. Queue Actions - Table EI@

D Description
ZDSHIP Link to an existing Sales Shipment -
*#}

Help

Figure 22 - Creating new Document Queue Actions codes

Next you need to create a new Zetadocs Document Queue.

e Open the Zetadocs Document Queue Card
o For NAV 2013 select Administration—>Application Setup—>Zetadocs Setup—>Zetadocs
Document Queue List and select the queue you wish to modify to open the card.
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o For NAV 5 and 6 select Administration—>Application Setup—>Zetadocs Setup—>Zetadocs
Document Queue Setup.
e Create a new queue record noting the No. allocated.
e Enter the rest of the details as shown below. Note that the Caption added here will be displayed to
the user when processing in the document queue and so it should give sufficient information to the
user about the action. However, when there is only one action it is performed by default.

fE= ZDO0020 - Zetadocs Document Queue Card EI@
| General |
L Z0Q0020
Mame . . .. ... ... Shipment Gueue
Path. . .. .. v v v v W*yourmachinename*\Shipment Qu... [+]
Archive Documents . . .+ . . . . Wryourmachinename®\Shipment Queu e‘\|
Delete After Archive . . . . . .
Show Delete Confirmation. . . .
Auto Link Documents . . . . . . [}
Caption Menu Code ID
b | Link to existing Sales Shipment ZDSHIP -

m

Settings v] [ Help

Figure 23 - Document Queue Settings

11.7 Adding Document Queues to your NAV Menusuite NAV
To enable users to quickly access your document queues you can add them to your menusuite, to do this
simply follow the simple steps below.

e Open the object designer within NAV and select the menusuite option.

e Create a new menusuite or edit an existing one as per your requirements.

e |fcreating a new one select the New button and then select the Design level appropriate to your
install, e.g. Company.
Locate the area in the Navigation pane where you wish to add the item to the menusuite.
Right click on the area and select Create item.
Select the object type of Form and pick the document queue in question from the object id field.
Select OK when satisfied and the use ctrl+shift and the arrow keys to move your new item around
the menusuite until you are happy with its location.

e  Press ctrl+s to save your changes.

e Repeat for any remaining document queues.
Note: Document Queues will not be available via the menusuite until you have closed and restarted NAV.
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11.8 Adding Document Queues to a Role Centre

Overview

The NAV role tailored client is designed around a user’s role and each role has its own Role Centre. This is
the ideal place to show information about the Zetadocs document queues, as each one is a queue of
documents that needs processing.

The following section gives a step by step guide explaining how to show document queue information in the
Activities area of the order processor Role Center in the role tailored client. The same steps can be used to
display document queue information on any Role Center for any role.

Add document queues to the Role Center
The page that you need to modify for this example is number go6o — SO Processor Activities.
e Add the following global variables:

Name Data Type Sub Type

Queueltems Record Zetadocs Doc. Queue Item
QueueSettings Record Zetadocs Document Queue
ZdDocQueue Page Zetadocs Document Queue

e Add the following line of code to the OnOpenPage trigger where ZDQooo1 is the ID of the document
queue that you want to display the information for:

Queueltems.SETRANGE(Queueltems."Zetadocs Doc. Queue No.", 'ZDQ0001');

e Add a group to the page with a sub type of CueGroup. Set the caption to Zetadocs Document
Queues.

e Add a field to the group. Set the caption to Document Queue and set the source expression to
Queueltems.COUNT as shown in the screenshot below:

Page 9060 SO Processor Activities - Page Designer =2 E=R==
Name Caption Type SubType SourceExpr
«Control 1900000001 «Contral1900000001 Container ContentArea «
<Controll=> For Release Group CueGroup
<Sales Quotes - Open > <3ales Quotes - Open > Field "Sales Quotes - Open”
<Sales Orders - Open> <Sales Orders - Open> Field "Sales Orders - Open”
<Controlg> Sales Orders Released Not 5., Group CueGroup
<Ready to Ship= <Ready to Ship=> Field "Ready to Ship™
<Partially Shipped > <Partially Shipped> Field “Partially Shipped™
<Delayed> <Delayed> Field Delayed
<Control18 Returns Group CueGroup
<Sales Return Orders - All> <Sales Return Orders - All>  Field "Sales Return Orders - Al"
<5ales Credit Memos - All> <5ales Credit Memos - All>  Field “Sales Credit Memos - Al
<Control 1000000000 > Zetadocs Document Queues Group CueGroup
3 <Control 1000000001 Document Queue Field Queueltems, COUNT -

Figure 24 - SO Processor Activities - Page Designer

e Select the new field and press Fg to view code. Add the following code to the OnDrillDown trigger:

IF QueueSettings.GET('ZDQooo1") THEN

BEGIN
ZdDocQueue.SetQueueSettings(QueueSettings);
ZdDocQueue.RUN;

END;

The previous steps can be repeated to add any other document queues to the display.
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11.9 Modify record forms for archive search and retrieval

To allow a user to search, retrieve and view captured documents from a NAV record form it is necessary to
modify the form to provide a menu item that will do the search. For example the Posted Sales Shipment
record form would be modified to add a Zetadocs Archive item on the Shipment menu, as below.

General |;[nuoimg |S}m:g |BizTaJk |

Now oo d PostingDate . . . . . .
Sell-to Customer No. . . Document Date . . . . .
Selo ContactMo. .. .| | Requested Delivery Date | |
Sell-to Customer Name . |Selangarian Ltd. Promised Delivery Date . l:l

|
Sell-to Address . . . . . | 153 Thomas Drive | QuoteNo. . ... ... |:|
Sel-to Address 2 . . . . | | OrderMo.. . ...... 101012
Sell-toCity . . . . . .. | coventry | External Document Mo, . |:|
Sell-to County fPost Code | | |C\|'G 1GY | Salesperson Code . . . .
Sel-to Contact . . . . . [Mr. Mark McArthur | Responsbiity Center . .| |
Mo.Printed . . . . . . . [ &
T... No. Description Location ... Quantity  UnitofM... Quantity ... Planned ... F
p L. 19285 {AMSTERDAM Lamp | GREEM 5 PCS 5 170111 =~

Statistics

Comments

Dimensicns

Approvals

Zetadocs Archive

Figure 25 - Posted Sales Shipment form showing Zetadocs Archive menu item

In our example scenario we need to modify the Posted Sales Shipment form (and page if using RTC) to show
the related document from the archive. To do this, please follow the instructions in section 4.5 Zetadocs
Interface Modification Tool.

If you are using the Role Tailored Client, then make the equivalent changes in the page editor for the RTC
record page.

11.10 Implementing you Custom Document Queue Actions (Custom Queues Only)

Overview
In this section we write the code to enable document linking and archiving for a particular document queue
action. Zetadocs Capture Essentials comes with some standard Sales and Purchase Order actions already
implemented. This section shows you how to implement your own custom actions. There are a number of
functions that Zetadocs calls in the Zetadocs-Capture Customize codeunit that you need to implement. The
steps to follow are:

e  Write code in the GetLink function

e Write code in the GetAdditionalMetadata function
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e Add permissions to codeunit
e Test document archiving

The following sections provide more detail on each step.

Write code in the GetLink function
For each action that is defined for the Archive button, you need to write some code in the function GetLink,
to carry out that action in NAV.

For example, if the action is to link the captured document to an existing record, then in this function you
would code the lookup that displays a form to allow the user to select the record and then return that
RecordID. Zetadocs will then use the record ID during the document archive and extract the correct
metadata.

The GetLink function has the following parameters:

Name Type | Sub-type  Read/Write Description
ZdArchiveContext Record Zetadocs Read A read only runtime table to
Archive provide context information like
Context the queue the item is in and the
menu item that was clicked by
the user.
ZdLinkResult Record Zetadocs Link | Read/Write A writable runtime table to allow
Result you to return the un-typed

RecordID reference to a NAV
record, error states and

messaging.
ZdControlFile Text Read Path to the DQF file for the
[250] document queue item (XML file).

Provided to allow you to fetch
other information about
converted files.

Sample Code:

This sample code shows an implementation of the GetLink function allowing the user to select the
associated Sales Shipment record. Note that this function will be called for every Action. You will need to
add a CASE statement using the Menu Code ID to identify the action the user has selected and write the
appropriate code against each case.

PROCEDURE GetLink@1000000007(ZdArchiveContext@1000000000 : Record 9009992;VAR
ZdLinkResult@1000000001 : Record 9009997;ZdControlFile@1000000002 : Text[250]);
VAR
SalesShipmentRec@1000000003 : Record 110;
RecRef@1000000004 : RecordRef;
BEGIN
ZdUtilities.Log(0, 'C9009964 - Link");
/I Menu Code ID find out what action to perform

II'if there are any errors during processing set the error flag in ZdLinkResult to TRUE
/I 'and set the error description field to a useful error message

CASE ZdArchiveContext."Menu Code ID" OF
'ZDSHIP": // link to existing sales shipment
BEGIN

/I make sure the sales shipment record does not have any filters
SalesShipmentRec.RESET;
/I run the lookup form and check the result
IF FORM.RUNMODAL(0, SalesShipmentRec) = ACTION::LookupOK THEN
BEGIN
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I'if the user selected a record use a RecordRef to get the RecordID for the record
/I'and modify the ZdLinkResult record to include it
RecRef.GETTABLE(SalesShipmentRec);
ZdLinkResult."Record ID" := RecRef. RECORDID;

END

ELSE

BEGIN
II'if the user cancelled, set the cancel flag in ZdLinkResult to true
ZdLinkResult.Cancel := TRUE;

END;

/I Call MODIFY to save the changes to the record

ZdLinkResult. MODIFY;

END;
END;
END;

Write code in the GetAdditionalMetadata function
Zetadocs calls the function GetAdditionalMetadata to get the values of metadata to be added to
SharePoint when the document is archived.

The GetAdditionalMetadata function has the following parameters:

Name ~ Type Sub-type Read/Write Description
ZdArchiveContext Record Zetadocs Read A read only runtime table to
Archive provide context information like
Context the queue the item is in and the
menu item that was clicked by the
user.
ZdLinkResult Record Zetadocs Link | Read/Write | A writable runtime table to allow
Result you to return the un-typed

RecordID reference to a NAV
record, error states and

messaging.
ZdArchiveMetadata Record Zetadocs Read/Write | A writable runtime table to allow
Archive you to modify the field values
Metadata being archived to SharePoint and

to fill in custom metadata that has
multi-level table relations.

Sample Code:

This sample code shows an implementation of GetAdditionalMetadata that sets the values for the metadata
for Record Type, Record Number, Company Number, Name and Organization. Note that this function will be
called for every Action. You will need to add a CASE statement using the Record ID to identify the linked
record and then write the appropriate code against each case to pull the specific metadata required.

PROCEDURE GetAdditionalMetadata@1000000005(ZdArchiveContext@ 1000000000 : Record
9009992;ZdLinkResult@1000000001 : Record 9009997;VAR ZdArchiveMetadata@1000000002 : Record 9009993);
VAR
RecRef@1000000003 : RecordRef;
fRef@1000000004 : FieldRef;
BEGIN
ZdUtilities.Log(0, 'C9009964 - GetAdditionalMetadata);

I/ Use the record id to get the table number. From the table number we know which fields to get the metadata from.
/I We are using short codes for the standard Zetadocs SharePoint fields.
/I These codes will be translated into the correct field names.

Il For custom fields just put the full field name in and it will be used.

IF RecRef.GET(ZdLinkResult."Record ID") THEN
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BEGIN
CASE RecRef.NUMBER OF
110: // Sales Shipment Header Table
BEGIN

I/ First fill in the record type
ZdArchiveMetadata.INIT;
ZdArchiveMetadata.Name := 'ZetadocsRecordType';
ZdArchiveMetadata.Value := 'Posted Sales Shipment';
ZdArchiveMetadata. Type := ZdArchiveMetadata.Type::STRING;
ZdArchiveMetadata.INSERT;

/I Field 3- "No."

fRef := RecRef.FIELD(3);

ZdArchiveMetadata.INIT;

ZdArchiveMetadata.Name := 'RECORDNUMBER;
ZdArchiveMetadata.Value := fRef. VALUE;
ZdArchiveMetadata.Type := ZdArchiveMetadata. Type::NUMBER,;
ZdArchiveMetadata.INSERT;

/I Field 2 - "Sell-to Customer No."

fRef := RecRef.FIELD(2);

ZdArchiveMetadata.INIT;

ZdArchiveMetadata.Name := 'COMPANYNUMBER';
ZdArchiveMetadata.Value := fRef.VALUE;
ZdArchiveMetadata. Type := ZdArchiveMetadata.Type::STRING;
ZdArchiveMetadata.INSERT;

/I Field 84 - "Sell-to Contact"

fRef := RecRef.FIELD(84);

ZdArchiveMetadata.INIT;

ZdArchiveMetadata.Name := 'NAME";
ZdArchiveMetadata.Value := fRef. VALUE;
ZdArchiveMetadata.Type := ZdArchiveMetadata.Type::STRING;
ZdArchiveMetadata.INSERT;

/I Field 79 - "Sell-to Customer Name"
fRef := RecRef.FIELD(79);
ZdArchiveMetadata.INIT;
ZdArchiveMetadata.Name := 'ORGANIZATION';
ZdArchiveMetadata.Value := fRef. VALUE;
ZdArchiveMetadata.Type := ZdArchiveMetadata.Type::STRING;
ZdArchiveMetadata.INSERT;
END;
END;
END;
END;

Add Permissions to codeunits

It is advisable to check that the correct permissions are granted to the Zetadocs-Capture Customize and the
Zetadocs-Capture Integration codeunits for the table data of the records you wish to link to. This ensures
that the codeunits will be able to read all the record information necessary as part of your custom link
actions.

Test document archiving

At this stage you should test that the functionality you have added works by doing the following:
e Scan adocument to your new document queue.
e Check that the document is listed in the document queue within NAV and can be viewed correctly.
e With the document selected click the Archive button and complete the actions.
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Browse to the SharePoint library and check that the document has been archived successfully in
the correct location.

View the document properties in SharePoint and check these are as expected.

Check the Zetadocs Archive option from the record form finds the archived document in
SharePoint.

(Finally, when you have completed your testing delete any test documents from the SharePoint
archive.)
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12. Enabling Barcode Support <

Zetadocs for NAV Installation Guide

Zetadocs supports the addition of barcodes to reports printed from NAV using a barcode font to print
unique information about an NAV object. This places a barcode into the report output, which can be used in
a number of manners. For example, with documents like invoices or sign off sheets which are distributed
from NAV before being signed or filled in and returned. In these cases when the document is added back
into the system document queue via scanning or email etc, it is captured back into the system and OCR’d.
This process detects the barcode and decodes the information contained within it. It is then used to link the
returned document to the original document in the archive. This enables users to track documents through
a variety of business processes.

Barcode Formats

Zetadocs for NAV supports Code 128 format barcodes only, however the OCR software has the capacity to
read and process those listed below. We recommend a minimum of Font-size 32 and a scanner resolution
dpi of 300 or greater. It should also be noted that some barcode formats only support upper case letters,
such as Code 39, if using such a barcode format please ensure you only use supported characters in your
barcodes.

Numeric-only barcodes
e  EAN-13 (European Article Numbering, an international retail product code)
EAN-8 (compressed version of EAN code for use on small products)
UPC-A (Universal Product Code seen on almost all retail products in the USA and Canada)
UPC-E (compressed version of UPC code for use on small products)
Code 11 (used primarily for labelling telecommunications equipment)
Interleaved 2 of 5 (compact numeric code, widely used in industry, air cargo, other applications)
Industrial 2 of 5 (older code not in common use)
Standard 2 of 5 (older code not in common use)
Codabar (older code often used in library systems, sometimes in blood banks)
Plessey (older code commonly used for retail shelf marking)
MSI (variation of the Plessey code commonly used in USA)
PostNet (used by U.S. Postal Service for automated mail sorting)

Alphanumeric barcodes
e Code 39 (de facto standard for Government, Manufacturing, BarCode Industry, Education, and
Business applications, in use world-wide)
e Code 93 (compact code similar to Code 39)
e Code 128 (very capable code, excellent density, high reliability; in very wide use world-wide)
e LOGMARS (same as Code 39, this is the U.S. Government specification)

Barcode Options

e The Zetadocs server searches for barcode information when processing graphics and PDF image
files. Any barcodes which are included in the file are saved alongside the document, and can be
used by custom processing functions to identify the document and automate its processing.

e Atypical usage is to encode the NAV document number directly — eg adding the shipping note
number as a barcode. However for more complex requirements a separate ID could be stored
instead — eg storing a lookup key into a custom table within NAV which is used to store custom
information about the document. Barcode information is passed transparently to the custom code
when processing for maximum flexibility.

e Zetadocs for NAV is supplied with a standard barcode font. When used with this font, the barcode
recognition supports the following features:

o Encoding of variable length data strings, including letters A-Z (from ANSI standard Western
European character set), digits 0-9, plus a selection of punctuation characters.
Barcode including text (user readable) version for manual checking or processing.
Protection against misreading, using automatically generated checksum data.
Support for documents scanned upside down.
Most other common barcode formats can also be supported. Please contact Equisys for
further details if there is a requirement to use a specific barcode format.
o Barcode processing requires the OCR add-on module.

O O O O
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o Use of the barcode to identify and process the document requires customization work by
the VAR using the Zetadocs for NAV Capture SDK, as described below.

Note: This method works for most reports; however, due to the customizable nature of reports it may not fit
all reports exactly. Therefore, the location of where to insert the code below may need to vary but the code
will remain the same.

Installation Overview

In this section we write the code to enable document auto linking and archiving. You will need to modify the
printed report to include a barcode and there are also a number of functions that Zetadocs calls from the
Zetadocs-Capture Customize codeunit that you need to implement. The steps to follow are:

Installing the barcode font

Modify a report to add a barcode

Write code in the GetLinkDisplayString function
Write code in the GetAutoLink function

Test document auto linking

The following sections provide more detail on each step.

12.1 Installing the barcode font

Barcodes can be added to reports by simply using a suitable font. The chosen barcode font must be
installed on each client PC that will be used to print the report. There are many different types of barcode
font available, but we have found that Code 39 barcodes work well with Zetadocs. You can download and
install a free Code 39 barcode font from http://www.barcodesinc.com/free-barcode-font/. Choose either
the standard or extended font and follow the included instructions to install the font on each client PC.
Barcode fonts often have limited character support e.g. A-Z and 0-9. So please ensure that the characters
you wish to use are supported by the font.

12.2 Modify an NAV report to add a barcode

Before you modify your report, you need to decide what unique piece of information you will use for the
barcode, so that the printed report can subsequently be identified in the capture stage. This will usually be
the record number of the NAV record. For example for the Shipment Note report you could use the
Shipment record number from the Posted Sales Shipment Record.

Follow these instructions to modify a report to add a barcode:

Open the NAV Development Environment/classic client and open the Object Designer (Shift+F12).

Locate the report you wish to modify in the Object Designer and select Design.

In the Report Designer select View—>Sections.

Open the toolbox View>Toolbox.

Select the text box tool and create one in a suitable location for the barcode - we suggest the main

header section.

Right-click on the text box and select properties.

e Set the text box FontName to the barcode font name
e.g. FontName = Free 3 of 9 Extended

e Edit the FontSize to a suitable value, we recommend a minimum size of 32.

e Set the text box SourceExpr property to the value to be used for the barcode
e.g. SourceExpr = STRSUBSTNO('*SHIP%1*'," Sales Shipment Header"."No.")

e Ensure that the barcode starts with and ends with “*”, otherwise the barcode will not be
recognized by the scanner.

e We also suggest that you add another text box below the barcode to display the value in a
standard font so that it is also human readable.

e Save the changes to the report.

e Test that the report prints OK and that the barcode is clearly legible.

If you are using the Role Tailored Client, then make the equivalent changes in the report editor for the RTC
report.
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12.3 Adding code to the GetLinkDisplayString function

Zetadocs calls the function GetLinkDisplayString to allow you to return a suitable text string to be
displayed in the document queue form. If no value is returned by this function, then the display will default
to the barcode text for the first barcode found in the captured document. If the document contains multiple
barcodes, these will be represented as multiple records in the table.

The GetLinkDisplayString function has the following parameters:

Parameter ~ Type  Sub-type Read/Write Description
ZdDocQueueBarcodes Record Zetadocs Read Aread only runtime table that
Doc. Queue allows you to access the values of
Barcodes all barcodes from the document
gueue item.
Return Value Text[120] Write The text to display in the
document queue “Link” column.

e Openthe NAV Development Environment/classic client and open the Object Designer (Shift+F12).

e Locate the Codeunit ID:9009964 Zetadocs-Capture Customise in the Object Designer and select
Design.

e Scroll down to the GetLinkDisplayString section.

e You will notice the code matches that displayed below, this indicates that it is setup for the
Shipment Report, which we provide as a sample report.

e To add support for other reports we need to add additional if statements to ensure your system is
configured to deal with barcodes which start with other details.

Sample Code:
This sample code shows an implementation of GetLinkDisplayString that returns a display string for a
Shipment record.

/I Call reset to clear any filters that may be on the barcodes temporary table
ZdDocQueueltemBarcodes.RESET;

IF NOT ZdDocQueueltemBarcodes.FIND('-") THEN
BEGIN
Il There are no barcodes so we leave the link string blank
EXIT(");
END;

info := ZdDocQueueltemBarcodes.Value;

II'if the barcode starts with SHIP
IF (STRLEN(info) > 4) AND (COPYSTR(info, 1, 4) = 'SHIP') THEN
BEGIN
info ;= STRSUBSTNO(strSalesShipment, COPYSTR(info, 5));
END;
END;

Customising the GetLinkDisplayString function

The document specific section of code below contains an IF statement which enables the codeunit to add
additional information to the document queue when it detects a barcode which begins with SHIP. The
makeup of this string is obviously determined by the unique value you wish to use for your barcode.

String in the report which generates the barcode
SourceExpr = STRSUBSTNO("*SHIP%1*,"Sales Shipment Header"."No.")

This would for example generate a value of *SHIP 102028*.

Corresponding code required in the codeunit
I'if the barcode starts with SHIP
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IF (STRLEN(info) > 4) AND (COPYSTR(info, 1, 4) = 'SHIP") THEN
BEGIN

info ;= STRSUBSTNO(strSalesShipment, COPYSTR(info, 5));
END;

The code then detects that our barcode starts with SHIP and acts accordingly.

Adding additional IF statements for other reports

If then you wanted to add barcode support to another report then you would need to modify the report as
per the steps in section 12.2 adding the SourceExpr value shown below. Note you can use whatever
identifier seems appropriate in this case we have chosen to setup a Sales Invoice report so have chosen
SINV and have replaced Sales Shipment Header for Sales Invoice Header.

SourceExpr = STRSUBSTNO("*SINV%1*,"Sales Invoice Header"."No.")
We then need to add an additional if statement to match this:

II'if the barcode starts with SINV
IF (STRLEN(info) > 4) AND (COPYSTR(info, 1, 4) ="' SINV ') THEN
BEGIN
info ;= STRSUBSTNO(strSalesInvoice, COPYSTR(info, 5));
END;

This can be repeated as desired for any remaining reports.

12.4 Write code in the GetAutoLink function

Zetadocs calls the function GetAutoLink for each item in the queue so that you can determine if it can be
automatically associated with a NAV record. Details of recognized barcodes are included so that you can
write any necessary functionality to lookup the NAV record. If you plan to have this function called
automatically from the NAS server or from other codeunits, it is recommended that you do not include user
input operations.

The GetAutoLink function has the following parameters:

Parameter ~ Type \ Sub-type Read/Write Description
ZdArchiveContext Record Zetadocs Read A read only runtime table to
Archive provide context information like
Context the queue the item is in and the
menu item that was clicked by the
user.
ZdDocQueueBarcodes Record Zetadocs Read A read only runtime table that
Doc. Queue allows you to access the values of
Barcodes all barcodes from the document
queue item.
ZdLinkResult Record Zetadocs Read/Write A writable runtime table to allow
Link Result you to return the un-typed

RecordID reference to a NAV
record, error states and

messaging.
ZdControlFile Text Read Path to the DQF file for the
[250] document queue item (XML file).

Provided to allow you to fetch
other information about converted
files.

Sample Code:
This sample code shows an implementation of GetAutoLink that finds and returns the matching record ID.
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PROCEDURE GetAutoLink@1000000006(ZdArchiveContext@1000000002 : Record 9009992;VAR
ZdLinkResult@1000000001 : Record 9009997;ZdControlFile@1000000000 : Text[250];VAR
ZdDocQueueBarcodes@1000000003 : Record 9009995);

VAR

msgNoBarcodes@1000000005 : TextConst 'DAN=Auto linking failed. No barcodes were detected on the
document.;DEU=Auto linking failed. No barcodes were detected on the document.;ENU=Auto linking failed. No barcodes
were detected on the document.;ESP=Auto linking failed. No barcodes were detected on the document.;FRA=Auto linking
failed. No barcodes were detected on the document.;ITA=Auto linking failed. No barcodes were detected on the
document.;NLD=Auto linking failed. No barcodes were detected on the document.;ENG=Auto linking failed. No barcodes
were detected on the document.’;

msgCouldNotFindRecord@1000000006 : TextConst 'DAN=Auto linking failed. Could not find record matching barcode:
%1;DEU=Auto linking failed. Could not find record matching barcode: %1;ENU=Auto linking failed. Could not find record
matching barcode: %1;ESP=Auto linking failed. Could not find record matching barcode: %1;FRA=Auto linking failed.
Could not find record matching barcode: %1;ITA=Auto linking failed. Could not find record matching barcode:
%1;NLD=Auto linking failed. Could not find record matching barcode: %1;ENG=Auto linking failed. Could not find record
matching barcode: %1";

barcodeVal@1000000004 : Text[80];

ShipmentRec@1000000007 : Record 110;

RecRef@1000000008 : RecordRef;

BEGIN
ZdUtilities.Log(0, 'C9009964 - AutoLink’);

This code should be the same for every report and doesn’t need repeating with each if statement.
Il Use the barcodes that are passed in to find the record to link to.

I/ Call reset to clear any filters that may be on the barcodes temporary table
ZdDocQueueBarcodes.RESET;

IF NOT ZdDocQueueBarcodes.FIND(-') THEN

BEGIN
/I There are no barcodes so don't modify the record.
Il Processing will fall back to calling the Link function for the manual method.
EXIT;

END;

barcodeVal := ZdDocQueueBarcodes.Value;

IF Statement
II'lf the barcode starts with SHIP it means it is a shipment note.
/I The barcode will be in the format SHIP000000, where 000000 is the shipment number
IF (STRLEN(barcodeVal) > 4) AND (COPYSTR(barcodeVal, 1, 4) = 'SHIP') THEN
BEGIN
ShipmentRec.RESET;
ShipmentRec."No." := COPYSTR(barcodeVal, 5);
II'if we can find the record that the barcode refers to
IF ShipmentRec.FIND THEN
BEGIN
I'if the user selected a record use a RecordRef to get the RecordID for the record
II'and modify the ZdLinkResult record to include it
RecRef.GETTABLE(ShipmentRec);
ZdLinkResult."Record ID" := RecRef. RECORDID;
ZdLinkResult. MODIFY;
END;
END;

EXIT;
END;
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Modified IF Statement for the Sales Invoice

II'if the barcode starts with SINV it means it is a Sales Invoice.
/I The barcode will be in the format SINV000000, where 000000 is the Sales Invoice number
IF (STRLEN(barcodeVal) > 4) AND (COPYSTR(barcodeVal, 1, 4) = 'SINV') THEN
BEGIN
ShipmentRec.RESET;
ShipmentRec."No." := COPYSTR(barcodeVal, 5);
II'if we can find the record that the barcode refers to
IF ShipmentRec.FIND THEN
BEGIN
I'if the user selected a record use a RecordRef to get the RecordID for the record
/I and modify the ZdLinkResult record to include it
RecRef. GETTABLE(ShipmentRec);
ZdLinkResult."Record ID" := RecRef. RECORDID;
ZdLinkResult. MODIFY;
END;
END;

EXIT;
END;

Test document auto linking
At this stage you should test that the functionality you have added works by doing the following:
e Print a modified report that includes a barcode.
Scan the printed report into your new document queue.
Check that the document is listed in the document queue within NAV and can be viewed correctly.
Check that the scanned document displays the appropriate text in the Link column.
Click the Archive button and complete the actions.
Browse to the SharePoint library and check that the document has been archived successfully in
the correct location.
View the document properties in SharePoint and check these are as expected.
e (Finally, when you have completed your testing delete any test documents from the SharePoint
archive.)

12.5 Further Capture Customizations

Overview
In this section a number of advanced functions are described that will help you to do further customisation
of the document queue capture process. The functions available are:

e PreArchive

e PostArchive

PreArchive

The PreArchive function is similar to the OverrideSendResult function in the delivery parts of the Zetadocs
SDK. This function gives a writable copy of the final information to be used in the archiving of the document
from the queue. It is at this point that you get the opportunity to override the archive location and content

type.

The PreArchive function has the following parameters:

Parameter Type | Sub-type Read/Write Description
ZdArchiveContext Record Zetadocs Read A read only runtime table to
Archive provide context information like
Context the queue the item is in and the
menu item that was clicked by the
user.
ZdArchiveSettings Record Zetadocs Read/Write A writable runtime table to allow
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Parameter Type | Sub-type Read/Write Description
Archive you to modify properties of the
Settings archive action such as whether to

archive and the archive location.

PostArchive
Zetadocs calls the PostArchive function to inform you of the archiving result and to allow you to implement
workflow based on that information.

The PostArchive function has the following parameters:

Parameter Type | Sub-type Read/Write Description
ZdArchiveContext Record Zetadocs Read A read only runtime table to
Archive provides context information like
Context the queue the itemis in and the
menu item that was clicked by the
user.
ZdArchiveResult Record Zetadocs Read/Write A writable runtime table to allow
Archive you to find out if the archive was
Result successful and get the URL of the
archived file.

12.6 Capture Reference

Overview

This section gives details of the records used by the capture functions:
e Zetadocs Archive Context

Zetadocs Archive Metadata

Zetadocs Archive Result

Zetadocs Archive Settings

Zetadocs Doc. Q. Item Barcode

Zetadocs Link Result

Zetadocs Archive Context

Table 9009992 Zetadocs Archive Context - Table Designer o= |
E.. Field Mo.  Field Name Data Type Length Description
v 1 Mo. Integer Always 1 as table only used to represent one capture activety =
v 10 Zetadocs Doc. Queue Mo, Code 10 Doc Queue that the dick is from
v 11 Menu Code ID Code 10 Menu Item that was didked
v 40 UIEnabled Boolean Whether or not UI should be allowed

Figure 26 - Zetadocs Archive Context Table

The Zetadocs Archive Context table has the following fields:
e No.: Table record entry - please ignore
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e Zetadocs Doc. Queue No. : Foreign Key to Zetadocs Document Queue table to allow you to know
from which document queue the Link function has been called.

e Menu Code ID: Foreign Key to Zetadocs Document Queue Menu Item No. table to allow you to
know which menu item had been selected by the user. Blank if used with GetAutoLink function.

e UlEnabled: Indicates whether Ul (User Interface) dialogs should be shown or suppressed.

Zetadocs Archive Metadata

i~ -

Table 9009993 Zetadocs Archive Metadata - Table Designer E@
E.. Field Mo,  Field Name Data Type Length Description
v 1 Mame Text 100 #
v 2 Value Text 250
b 3 Ty'pel Option

Help

Figure 27 - Zetadocs Archive Metadata Table

The Zetadocs Archive Metadata table has the following fields:
o Name: Archive column name in SharePoint
e Value: The metadata value expressed as a string
o Type: The metadata type. Available types are NUMBER, DATE and STRING.

Zetadocs Archive Result

Table 9009936 Zetadocs Archive Result - Table Designer EI@
E.. FieldMo.  Field Name Data Type Length Description
v 1 Mo. Integer Always 1 as table only used to represent one capture activety
v 10 Record ID RecordID Record to assodate with
v 70 Archive Document Boolean Flag indicating if we tried to archive the document
v 71 Archive Location Text 250 The URL of the archived document in SharePoint
v 72 Archive Succeeded Boolean Flag indicating if the archive operation succeeded
v 80 Delete After Boolean Flag indicating if the document should be deleted after archiving
v 81 Show Delete Confirmation Boolean Flag indicating if a confirmation message should be shown
v 110 Error Boolean Flag indicating if there has been an error
v 111 Error Description Text 250 Description of any errors that occurred
v 112 Stop Batch Processing Boolean Flag indicating if batch processing should be stopped
v 200 Additional Param Text 250 Used to store custom data
| b |

Figure 28 - Zetadocs Archive Result Table

The Zetadocs Archive Result table has the following fields:
e No.: Table record entry - please ignore

e Record ID: Un-typed record ID of the NAV record that the captured document is associated with.
e Archive Document: Indicates if the captured document is to be archived to SharePoint
e Archive Location: The URL of the archived document in SharePoint.
e Archive Succeeded: Indicates if the archive was successful.
o Delete After: Indicates if the document should be deleted
e Show Delete Confirmation: Indicates to Zetadocs whether prompt the user for confirmation of
delete.
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e Error: Indicates to Zetadocs whether an error occurred during the function.

e  Error Description: A description of the error that occurred.

e Stop Batch Processing: Used only when auto linking where this Boolean indicates whether batch
processing should stop or continue.

e Additional Param: Additional parameter to allow extra data to be passed between Zetadocs
functions.

Zetadocs Archive Settings

Table 9009994 Zetadocs Archive Settings - Table Designer E\@
E.. Field Mo, Field Name Data Type Length Description
v 1 Ma. Integer Always 1 as table only used to represent one capture activety  »
v 10 Record ID RecordID Record to assodate with
v 70 Archive Document Boolean Flag indicating if document should be archived
v 71 Archive Location Text 250 The location to archive the document to
v 73 Archive Document Type  Text 250 The sharepoint content type that will be used
b v 110 Error Boolean Flag indicating if there has been an errarl
v 111 Error Description Text 250 Description of any errors that occurred
v 112 Stop Batch Processing Boolean Flag indicating if batch processing should be stopped
v 200 Additional Param Text 250 Used to store custom data

Figure 29 - Zetadocs Archive Settings Table

The Zetadocs Archive Settings table has the following fields:
e No.: Table record entry - please ignore
Record ID: Un-typed record ID of the NAV record that the captured document is associated with.
Archive Document: Indicates if the captured document is to be archived to SharePoint
Archive Location: The location to archive the document to in SharePoint.
Archive Document Type: The SharePoint content type to be used when archiving.
Error: Indicates to Zetadocs whether an error occurred during the function.
Error Description: A description of the error that occurred.
Stop Batch Processing: Used only when auto linking where this Boolean indicates whether batch
processing should stop or continue.
e Additional Param: Additional parameter to allow extra data to be passed between Zetadocs
functions.
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Zetadocs Doc. Q. Item Barcode

i~

Table 9009996 Zetadocs Doc. Q. tem Barcode - Table Designer =[] ]
E.. Field Mo.  Field Name Data Type Length Description
v 1 Mao. Integer line id -
v 2 Value Text 250
b v 3 B Integer page barcode was on

Figure 30 - Zetadocs Doc. Q. Item Barcode Table

The Zetadocs Doc. Q. Item Barcode table has the following fields:
e No.: Table record entry - please ignore
e Value: The barcode expressed as a string
e Page: The page number the barcode was on

Zetadocs Link Result

Table 9009997 Zetadocs Link Result - Table Designer ===
E.. Field Mo.  Field Name Data Type Length Description
v 1 Mo. Integer Always 1 as table only used to represent one capture activety =+
v 10 Record ID RecordID Record to assodate with
v 110 Error Boolean Flag indicating if there has been an error
v 111 Error Description Text 250 Description of any errors that occurred
v 112 Stop Batch Processing Boolean Flag indicating if batch processing should be stopped
v 113 Cancel Boolean Flag indicating if the user cancelled a link operation
b v 200 Additional Param Text 250 Used to store custom datal

Figure 31 - Zetadocs Link Result Table

The Zetadocs Link Result table has the following fields:
e No.: Table record entry - please ignore
Record ID: Un-typed record ID of the NAV record that the captured document is associated with.
Error: Indicates to Zetadocs whether an error occurred during linking.
Error Description: A description of the error that occurred.
Stop Batch Processing: Used only when auto linking where this Boolean indicates whether batch
processing should stop or continue.
Cancel: Indicates whether the Archive action should be cancelled.
e Additional Param: Additional parameter to allow extra data to be passed between Zetadocs
functions.
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13. Automation using Extracted Text <

Now that we have covered how you can use barcodes to automate some of your processes, we are going to
demonstrate how text extraction on document capture can be used to add yet further automation. This
section will deal with how to extract the text from a captured document and then an example of how this
can be used to automate processes.

13.1 Enabling Zetadocs Document Capture Text Extraction

Zetadocs Capture Plus supports the parsing of document text, this can be used for identification numbers
and metadata to facilitate document recognition. This then allows the automated linking and archiving of
documents with NAV records. Implementing automated document recognition has many benefits including
the streamlining of processes, by the automation of tedious repetitive activities and by automatically
initiating internal workflows. To access this functionality you must enable text extraction on Zetadocs
Document Queues configurations in the Zetadocs Server and then use a Zetadocs for NAV SDK function to
get the path to the extracted text file.

Enabling text extraction in the Zetadocs Server

Each configured queue in the Zetadocs Server can have text extraction enabled independently. This allows
you to enable text extraction processing on the queues in which you expect to implement document
recognition. Furthermore it means that the unnecessary processing of documents is avoided. It is therefore
recommended that you create separate queues for documents for which you intend to implement document
recognition and for those you do not.

Configuring the Zetadocs Server
The image below shows a sample Zetadocs Server config.xml file. Note the element
<EnablePDFTextExtractionToFile> on each queue <DocsQ>.

To enable text extraction set the value of the xml element to true to enable text extraction. NOTE: Due to
xml serialization the value is case sensitive and must be set to true or false. True or TRUE or any other
variation will be invalid.

<?xml version="1.0" encoding="utf-8"?>
<Config xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmins:xsd="http://www.w3.0rg/2001/XMLSchema">

<docsQueue>
<DocsQ Description="Sales Document Queue" Location="\\User specified queue location\Sales Document Queue\">
<EnablePDFTextExtractionToFile>false</EnablePDF TextExtractionToFile>
<BatchScanSplitType>Barcode</BatchScanSplitType>
<BatchScanPagelnterval>1</BatchScanPagelnterval>
<BatchScanBarcodePrefix></BatchScanBarcodePrefix>
<BatchScanBarcodeDeleteSplitPage>false</BatchScanBarcodeDeleteSplitPage>
</DocsQ>
<DocsQ Description="Purchase Document Queue" Location="\\User specified queue location\Purchase Document
Queue\">
<EnablePDFTextExtractionToFile>false</EnablePDF TextExtractionToFile>
<BatchScanSplitType>Off</BatchScanSplitType>
<BatchScanPagelnterval>1</BatchScanPagelnterval>
<BatchScanBarcodePrefix></BatchScanBarcodePrefix>
<BatchScanBarcodeDeleteSplitPage>false</BatchScanBarcodeDeleteSplitPage>
</DocsQ>
</docsQueue>
<PDFQuality>Better</PDFQuality>
<EnableAbbyy>true</EnableAbbyy>
<StellentTimeOut>10</StellentTimeOut>
<StellentBypassPDF>true</StellentBypassPDF>
<LogLevel>Error</LogLevel>
<LogToFile>true</LogToFile>
<LogToEventLog>false</LogToEventLog>
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<EnableBarcodeDetection>true</EnableBarcodeDetection>
</Config>

Accessing the extracted text file from NAV
Once you have enabled the text extraction in the Zetadocs Server you will need to implement parsing of the
text file in NAV. This is done using the Zetadocs Capture Customize codeunit.

In the Zetadocs- Capture Customize codeunit trigger GetAutoLink() the path to the control file for queue
items is available as the ZdControlFile :Text[250] parameter. Using this you can call a Zetadocs Utilities
function to return the associated extracted text file path for that item.

textFilePath := ZdUtilities.GetExtractedTextFilePath(ZdControlFile);

You can now implement your own functionality to parse the text file for expected text metadata which will
help you to identify the document and its associated record in much the same manner as is described for
the barcode recognition feature of Zetadocs for NAV. For more information, please see section 12.

13.2 Approvals in NAV using Extracted Text
Now that we have successfully identified and extracted the information we require we can put it to work in
NAV, in this example we will be setting NAV so that it starts an approval process.

In this example we will be looking at the following business process:

Raise and send out a purchase order from NAV using Zetadocs

Received by the vendor who will raise a sales order and send the goods.

They will attach a shipment note to the delivery and also send a purchase order.

These documents will be Captured into the relevant Zetadocs Document Queue either via scanning

of hardcopies or processing of other documents by the Zetadocs Server.

o When the Purchase Invoice is Captured, Zetadocs extracts the text including the original purchase
order number.

e When the Purchase Invoice is processed and added to the Zetadocs Archive this set in motion the

approval process in NAV.

The existing Document Queues as setup by default do not support the initialization of the approval process.
As such we need to adjust the Zetadocs-Capture Customize codeunit so that it begins the approval process
when an invoice is archived.

Creating the IsValuelnFile function
e Select the Zetadocs-Capture Customize codeunit in the object designer, and select Design.
e Select View->C/AL Globals and choose the functions tab.
e Add the function IsValuelnFile, details below.

Name IsValuelnFile ( Value, FilePath)
Description Searches if a given Value is present in the file pointed by FilePath
Arguments Value text[30] The value to search for
FilePathtext[1024] The associated text file to look in
Returned value True ifthe numberis present
False ifnot

Adding Code into the IsValuelnFile function

Now that we have added the function into the codeunit we need to add the following code, open the C/AL

editor (Fg) and paste in the code below into the IsValuelnFile section. We recommend that you review this
now to gain an understanding of how it operates, comments have been included throughout to explain the
various sections.

CODE:
IsValuelnFile(text[30] Value; text[1024] FilePath)

I/ Set file to be opened in text mode and for reading only
file. TEXTMODE(TRUE);
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file. WRITEMODE(FALSE);

II'lf we can't open the file, just return false as we cannot match a value
IF NOT file.OPEN(FilePath) THEN
BEGIN
EXIT(FALSE);
END;

Il Cycle through all lines in the file until we find te value we were
I/ looking for or
Il we reach the end of the file
REPEAT
I/ Read each line at a time
IF file.READ(line) <> 0 THEN
BEGIN
Il Check if value appears anywhere in the line
/I NOTE: If values wrap over more than one line they will not be matched
pos := STRPOS(line, Value);
IF (pos <> 0) THEN
BEGIN
/I We've found the value we were looking for, close the file and
I return true
file.CLOSE;
EXIT(TRUE);
END;
END;
UNTIL file.POS = file.LEN; // Check if we have reached the end of the file

I We've reached the end of the file without finding the value we were
INooking for

I Close the file and return false

file.CLOSE;

EXIT(FALSE);

}

Creating the GetMatchingPurchaseOrder function
e Next return to the functions tab, View—>C/AL Globals.

e Add the function GetMatchingPurchaseOrder, details below.
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Name GetMatchingPurchaseOrder (Orders, ZdControlFile)
Description Searches through the ZdControlFile to find a matching Purchase Order
Arguments Orders record List of opened purchase orders

ZdControlFile text[1024] The control file of the document queue item
Returned value True if the Order matches the DQF file

False if not

Adding Code into the GetMatchingPurchaseOrder function

Now that we have added the function into the codeunit we need to add the following code, open the C/AL
editor (F9) and paste in the code below into the GetMatchingPurchaseOrder section. We have included

comments throughout to explain the various sections.

CODE:
GetMatchingPurchaseOrder (Record Orders, Text[1024] ZdControlFile)

I Clear any filters on the Orders record
Orders.RESET;

Il Set range so we are only looking at orders

Orders.SETRANGE(Orders."Document Type",Orders."Document Type"::Order);
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I/ Make sure there are records to search through

IF Orders.FIND(-") THEN

BEGIN
//Loop through records until we find a matching one or reach the end

REPEAT
I/ Check if the order number can be found in the file
/I NOTE: For this example we have changed the orders number
I/series so order numbers will look like:
/I"PO-00001" This should be unique in the file so we don't get
I/false matches
IF IsValuelnFile(  Orders."No.",

ZdUtilities.GetExtractedTextFilePath(
ZdControlFile)) THEN

BEGIN
Il We've found the right purchase order so return true
EXIT(TRUE);
END;
UNTIL Orders.NEXT = 0;
END;
I/ Reached the end of the orders without matching one, so return false
EXIT(FALSE);
}

Adjusting the GetAutoLink Function
Now we have created and added code to our variables we need to adjust the GetAutoLink function. This is
so it can look through all the Orders and find out if one of them matches up the Purchase Order number that

is present in the associated file being archived. Scroll to the GetAutoLink section and add the code so that it
surrounds the existing code as shown below.

CODE:

GetAutoLink (...)

{

ZdUtilities.Log(0, 'C9009964 - AutoLink');

CASE ZdArchiveContext."Zetadocs Doc. Queue No." OF
'ZDQ0020','ZDQ0021":
/I Purchase Invoice and Purchase Receipt Document Queues
BEGIN
Il Use the information in the control file to find a matching purchase order
IF GetMatchingPurchaseOrder(Orders, ZdControlFile) THEN
BEGIN
Il use a RecordRef to get the record id for the matching record
RecRef.GETTABLE(Orders);
ZdLinkResult."Record ID" := RecRef.RECORDID;
ZdLinkResult. MODIFY;
END;
END
ELSE
BEGIN

<< EXISTING CODE HERE >>

END
EXIT;
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Adjusting the PostArchive Function
Next we need to add some extra code into the PostArchive function to send the Purchase Approval for a
given item. Again this code needs to be pasted around the existing code.

PostArchive (...)

Il Check if the archive was successful

IF NOT ( ZdArchiveResult."Archive Document" AND
ZdArchiveResult."Archive Succeeded") THEN

BEGIN

EXIT;

END;

/I Check this is the purchase invoice document queue
IF ZdArchiveContext."Zetadocs Doc. Queue No." = 'ZDQ0020' THEN
BEGIN
Il Use a RecordRef to get values from the record
IF NOT RecRef.GET(ZdArchiveResult."Record ID") THEN
BEGIN
/I Could not get the record from the record id
EXIT;
END;

Il Get a fieldref to the document type field
fRef := RecRef.FIELD(1);

I/ Store the value as an integer so that we can compare it
DocType = fRef.VALUE;

/I Check we have linked to an order
IF (DocType <> PurchaseOrder."Document Type"::Order) THEN
BEGIN
II'lf it is not an order we cannot start approval, so exit
EXIT;
END;

/I Get a fieldref to the No. field
fRef := RecRef.FIELD(3);

/I Store the order no
OrderNo := fRef.VALUE;

Il Set range of the purchase order record so only looking at

Il orders

PurchaseOrder.SETRANGE( "Document Type",
PurchaseOrder."Document Type"::Order);

Il Set range so only looking at this specific order
PurchaseOrder.SETRANGE("No.",OrderNo);

/I Check that an order exists in the range
IF PurchaseOrder.FIND('-') THEN
BEGIN
/I Call into approvals management codeunit to start the approval process
IF ApprovalsMgmt.SendPurchaseApprovalRequest(PurchaseOrder) THEN;
END;
END;
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{
<< EXISTING CODE HERE >>

This should complete the setup required for the Purchase Invoices to generate an approval process, obviously
the above example can be modified using different queue id’s to effect different queues and thus document
types.

This edition 5" December 2012 © Copyright Equisys plc 2012 All trademarks acknowledged All rights Page 85
reserved



. . equisys
Zetadocs for NAV Installation Guide ZETAOOCS®

Capture. Deliver. Share.

Delivery Plus o,

This following sections setup of the features provided as part of the Zetadocs for NAV
Delivery Plus module. Users who wish to install and utilise these features will need to
purchase the appropriate licence from Equisys.

Chapters

Zetadocs Delivery Plus
Send Any Report
Bespoke Contacts and Company Types

Zetadocs-Send Customize codeunit

cquisys
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The Zetadocs for NAV Addin can be split into 2 main areas, data and processing. The installation guide dealt
primarily with setting up the data that would determine our report formatting and send information when
sent to the Zetadocs Client. We saw how reports could be grouped into Document Sets which share a
common rule for formatting and archiving and we saw how rules can be stored which alter formatting and
send information dependant on who we were sending to. It is assumed then that we have a good
understanding of the information involved in sending a report using Zetadocs for NAV. In this architectural
overview the process of collating the sending information, which we refer to as the “Send Results”, is
explained. This includes a breakdown of the main processing areas and their use in integrating with NAV as
well as an insight into the customization potential and extensibility of Zetadocs for NAV.

14.1 Understanding the SDK Framework
Before continuing it is recommended that you read the Zetadocs for NAV SDK Primer section of this
document.

The three elements to the Zetadocs for NAV Delivery Plus SDK are:

1. Interfaces
e NAV Reports
o Reports need to be modified to call the Zetadocs for NAV Core sending codeunits.
Instructions on this are available in section 4.6 the Zetadocs Report Modification
Tool.
2. Zetadocs Core Codeunits
e Zetadocs Send codeunit
o This codeunit provides functions that are called by the Interfaces.
3. Integration and Customization Codeunits
e Zetadocs Send Integration codeunit
o This codeunit provides functions called by the Zetadocs Core codeunits to
integrate Zetadocs Delivery functionality into bespoke records or other areas of
NAV beyond Sales and Purchase Order Processing
e Zetadocs Send Customize
o This codeunit has functions called by the Zetadocs Core codeunits to allow the
developer to implement bespoke business logic and delivery and archive settings.

14.2 Process Flow

Now let’s look at the flow of data that occurs when sending a report. The following diagram helps to
visualize the process and will aid us in discussing the relevant parts of the product.

As you can see from the diagram it starts with a NAV report that has been modified for Zetadocs for NAV. A
report is generally based on a set of records that are used to produce some report output, a document for
each record. The records contain information that relates to a contact and possibly a company, to whom the
report should be sent (i.e. the recipient). Sometimes that information can be a direct table reference to an
existing table that represents a contact or company for example, or it may contain some other form of
references which can be used to find the contact information from another source. This could be a look up
table of some sort based on some bespoke logic. The Zetadocs Send Results Gen codeunit is the central
processing controller and builds a runtime list of send results in a temporary table of type “Zetadocs Send
Result” for each record in the report.
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Figure 32 - Zetadocs for NAV Delivery Plus Architecture

Interfacing with the Zetadocs Send Results Gen codeunit (1.)

A report modified for Zetadocs for NAV will call the three trigger functions on the Zetadocs Send codeunit.
Firstly, Initialize (1.) is called to set the report that is being printed. The initialization information allows us
to determine what report settings, if any, have been specified (2.). After initialization we start to process
individual record specifics. Each record reference is passed to the send results codeunit by calling
AddRecord (1.). Each record is then processed to extract the contact information (3.). Depending on who the
company is we may apply specific rules covering how the contact or the template is determined. Once all
the records have been added Process Records (1.) is called to start finalizing the results. When all rules and
settings have been applied the “Zetadocs Customize” codeunit is called to offer overriding of the result (4.)
. Lastly, Zetadocs Send code will run to offer run-time user result override and error resolution dialogs.

Querying the Zetadocs Settings (2.)

Based on the ID of the report that is being printed we can determine what template and archiving settings
to use for the report and potentially how to automatically find the company and contact references from the
report records. Internally the Zetadocs Send Results Gen codeunit will query the Zetadocs Report Settings
using the report ID. These settings control the flow of processing from this point on.
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[Z5 Zetadocs Report Settings =nE=h ==
ReportID  Report Mame Zd Docum... Zd Docum... Archive D... Company ... Company ... ContactNo... Record No. ... Defaultl
4 59987 Purchase - Invoice 0 Default VEND 2 5049 3
4 m [3
Help

Figure 33 - Zetadocs Report Settings

Resolving the Company and Contact Information (3.)

This can happen in a number of ways depending on the Zetadocs Report Settings for that report. The report
settings control whether the Zetadocs Send Results Gen codeunit can copy the company and contact
references from a field in the record or whether it should call out to the “Zetadocs-Send Integration”
codeunit for the information. It is in this public codeunit that a VAR will implement their custom integration
code for their system. This is explained in more detail in a later section of this guide; however, this should
highlight the main purpose of the Zetadocs-Send Integration codeunit and the Zetadocs Send Result table
being public. It means that when we need to access data from typed NAV tables this code is exposed to the
VAR developer to allow them to integrate or customize successfully. The private Zetadocs Send Results Gen
codeunit only correlates and manages the data, unaware of its meaning (typelessly).

Overriding in Customize Codeunit (4.)

There is the ability to alter the Zetadocs Send Results record directly in this codeunit before continuing with
sending of a report. Each send result is passed to this codeunit by calling OverrideSendResult internally in
the Zetadocs Send Results Gen codeunit. This gives the VAR a great opportunity to implement customized
business logic above that offered by Zetadocs for NAV. An example would be altering the recipient (contact)
depending on the value of an order. The second potential customization is to add additional embedded
commands for tailoring email messages using dynamic fields in Zetadocs Templates or adding extra
metadata to be archived with the document.

14.3 Summary

Now that we have been introduced to the architectural overview of Zetadocs for NAV it should be easier for
us to understand the sections which follow and begin to allow us to imagine the potential customizations
and workflow that could be created with the Zetadocs for NAV Addin.
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In the installation guide earlier we saw how to configure Zetadocs for NAV to send reports from the Sales
Order and Purchasing processes. We edited the NAV reports for Zetadocs for NAV and set the report
settings to point at the Customer or Vendor reference for that report and the respective Contact reference.
With this information Zetadocs for NAV was able to extract the references and query the names, email
addresses and fax addresses of the contact, as well as, cross reference the company (Customer or Vendor)
reference with the associated Zetadocs Customer or Vendor rules tables to apply per company formatting
and addressing logic. This however is not the limit of Zetadocs for NAV functionality. This principle of field
reference and related information resolution can be applied to almost any report. In this section we will see
how small changes in the report settings can control and alter the information used to address, format,
send and archive a report using Zetadocs for NAV.

15.1 Configured Send

It should be clear by now from the installation guide that by setting the “Company Type Code”, “Company
No. Field No.” and “Contact No. Field No.” fields in the Zetadocs Report Settings that you can configure
Zetadocs for NAV to automatically resolve your contact information and apply company specific rules if they
exist. In this way it is possible to reference any fields which contain the right type of reference (i.e.
customer/vendor or contact etc). There is some logic to the application of these settings that is important to
know to help decide what settings to enter but it also gives the opportunity for some variations in
configuration.

Zetadocs Report Settings Field No.’s Reference Logic (Pseudo Code)

IF Company Type Code <> NULL THEN
IF Company No. Field No. <> NULL THEN
Get the Company No. from Record using Field No.
ELSE
CALL Integration codeunit GetCompanyForReport for VAR to get Company No.
END
END

Send Result.VALIDATE(Company No., Company No. Value)

IF Contact No. Field No. <> NULL THEN
Get the Contact No. from Record using Field No.
ELSE
CALL Integration codeunit GetContactForReport for VAR to get Contact No.
END

Send Result.VALIDATE(Contact No., Contact No. Value)

From this it is important to notice the order that validation happens in as this coordinates with the Zetadocs
Send Result table OnValidate trigger code for “Company No.” and “Contact No.”. Since the company
information is validated first no contact reference will be set yet. We can check for this and default to using
the company’s communication information, later when the contact reference is validated we can override
the addressing information (email, fax). This provides the fallback addressing logic of Zetadocs for NAV so
that if a record has a blank reference for a contact we will still end up with the company correspondence
information. This means that we can deliberately control what information is used by altering the settings. It
also means that this behavior can be customized by the VAR by implementing the get trigger functions in
the Zetadocs-Send Integration codeunit and/or changing the OnValidate triggers in the Zetadocs Send
Result table.

Company Type Code Company No. Field No. Contact No. Field No. Resulting Addressing

Info Used
SET SET SET Contact Info unless the
reference in record is
blank THEN Company
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Info

SET NULL SET Contact Info unless the
reference in record is
blank THEN Company
Info using Company
Reference implemented
by VAR

SET NULL NULL Contact Info using
Contact Reference
Implemented by VAR
unless that reference is
blank THEN Company
Info using Company
Reference implemented

by VAR
NULL NULL SET Contact Info
NULL SET SET/NULL Invalid — You must

specify a company type
to enable use of
company field.

Table - Zetadocs Report Settings Addressing Information Control Options

To get a strong understanding of this it is recommended that you review the OnValidate triggers for
“Company No.” and “Contact No.” in the Zetadocs Send Result table and familiarize yourself with the
trigger functions in the Zetadocs-Send Integration codeunit. These are explained in detail in the next
section.

15.2 Custom Send

We saw in the last section how selecting certain report settings can control the flow of the operation of the
Zetadocs processing codeunits. By exploiting these settings and implementing the trigger functions in the
Zetadocs-Send Integration codeunit we can highly customize our report sending. In this section we will
focus on the trigger functions in the Zetadocs-Send Integration codeunit and explain how they can be used.

GetZetadocsArchivelD
This function has been deprecated in version 5.0 of Zetadocs for NAV and remains in the code for backward
compatibility. For system upgrades please read the warning below.

WARNING: This function should be left unchanged. It is only exposed in this codeunit to allow a VAR to add
additional permissions to the codeunit for reading and writing the Zetadocs Archive ID value to and from
additional tables!

OverrideSendSettings

Apart from setting up the company and contact field number references in the Zetadocs Report Settings
there are a number of other options that control the display options and the report batch information
settings. During the Initialize function (See Understanding the SDK Framework) these settings are copied in
to a temporary table called the Zetadocs Send Settings. This gives us the ability to adjust these settings at
runtime. Once the report settings have been copied into the temporary send settings table described, the
Zetadocs Send Results Gen codeunit calls the OverrideSendSettings trigger function in the Zetadocs-Send
Integration codeunit. Here you can modify the settings based on some logic for that send instance. Let’s
have a look at the Zetadocs Send Settings table.
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Table 9009975 Zetadocs Send Settings - Table Designer [ = | ][]
E.. Field MNo. Field Mame Data Type Length Description
v 1 Report ID Integer #
b v 2 Batch MName Text 120 |
v 3 Show Delivery Dialog Boolean
v 4 Show Errar Dialog Boolean
v 10 Company Type Code Code 20
v 20 Client Preview Boolean
v 30 TestMode Boolean
4 I I
Help

Figure 34 - Zetadocs Send Settings

e Report ID: WARNING: This is not for editing. It is here to allow the developer to determine which
report is being printed in the trigger and to branch CASE or IF statements depending on its value.

e Batch Name: In the Zetadocs Report Settings you have the ability to specify Default Batch Name.
This is the name that will be displayed in the Zetadocs Client for the report records printed to
Zetadocs. This default value can be overridden in this function.

e Show Delivery Dialog, Show batch Delivery Dialogs, Preview in Zetadocs Client and Test Mode: All
these can be dynamically overridden in this trigger at runtime.

o Company Type Code: Similar to the Report ID, this value is not for editing but is present to allow
the developer to determine the target company type configured for this report without having to
query the Zetadocs Report Settings Table.

A good example of when you might use this function is if you wish to have a report run uninterrupted by Ul
dialogs and previewing in the Zetadocs Client if it is being sent during the night. All previews could be
turned off.

GetContactForReport

As explained in the previous section, not specifying a Contact No. Field No. means that this function will be
called for you to return the value. This means that you are not restricted to extracting the reference directly
from the record being reported. The report id, record id and send settings are passed as parameters into
this function and therefore you can implement your own custom logic for each report and record type to
determine a contact. Note that the return value Code is not typed and is extra long. This means that the
code is not tied to a specific NAV type. This will be covered more in the next chapter.

GetCompanyForReport

Similar to GetContactForReport this function allows you to implement custom logic for determining the
Company No. value. The report id, record id and send settings are passed as parameters to this function
and therefore you can implement your own custom logic for each report and record type to determine a
company. Note that the return value Code is not typed and is extra long. This means that the code is not
tied to a specific NAV type. This will be covered more in the next chapter.

GetHardCopyPrinter

This function is always called to get the printer to use for the current user when the delivery method is set
to Hard Copy. It defaults to using the NAV Printer Selections setting for that user for that report otherwise it
uses the user’s system default printer. It is provided here to allow you to change this logic.
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GetOutputFileName

When a report is printed to Zetadocs, converted to a pdf and sent to a recipient it is desirable to be able to
name that pdf file something relevant. This function is called from the AddRecord function in the Zetadocs
Send Results Gen codeunit (i.e. once per report record) to allow you to specify independent file names.

GetRecordNoForReport

Similar to the Company No. Field No. and Contact No. Field No. settings in the Zetadocs Report Settings
there is an option to specify the Record No. Field No. This field’s purpose is primarily for customizing
Zetadocs message content. For example it is often desirable to include a Ref. number in the subject of email
correspondence. This can be set by adding %%][ZetadocsRecordNo] into the subject of a Zetadocs Template.

11! Document Template Wizard @
Please enter your email properties equisys
ZETACOCS
Ta...
Subject: Order Corfimmation for order number: %3%[ZetadocsRecordMo] for % 3% [Organization] More =
Standard = Tahoma 1t - E = E E| = =

4

9 0B I U || # @B HM

FAQ: %%[Name,Customer]

Dear Customer,

I'm pleased to attach your order confirmation, reference number %% L
[ZetadocsRecordNo].
Kind regards,

Sales Team

Help <Back || MNet> || Cancel

Figure 35 - Zetadocs Template Wizard

Once again this field no. reference setting operates similar to Contact No. Field No. such that if the field is
left blank in the Zetadocs Report Settings then this function will be called from the AddRecord function in
the Zetadocs Send Results Gen codeunit. This may be necessary if your reference number is composed of
more than one field value. If so these field values could be concatenated and returned from this function.

GetCompanyRule

This function is exposed here for a number of reasons. Firstly it allows the customization of rules
dynamically at runtime but primarily it can used in conjunction with the Company Type Code to provide
company rules for bespoke company types (i.e. types other than Customer and Vendor). This is explained in
more detail in the next chapter. The important thing to note about this function is the parameter that is
passed. The “Zetadocs Company Rule” is another temporary table maintained in the Zetadocs Send Results
Gen codeunit. This is used to get the rule override information irrespective of the company type. This will
become clearer in the next chapter. It is recommended that you review the implementation of this trigger
function in the Zetadocs-Send Integration codeunit to further your understanding.
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Due to the nature of NAV system installations and the hugely customizable potential it is acceptable that
some systems may or may not use the company tables 18 Customer and 23 Vendor. Similarly some systems
may not use the Contact Management Module or the native NAV 5050 Contact table. These entities may
have bespoke tables, this section details how Zetadocs for NAV can be integrated into such systems. This
section focuses on the abstract relationship between the “Zetadocs Company Types” table and the tables
that represent these types. We will also see how Zetadocs for NAV can be extended to integrate with other
existing native company types.

16.1 Company Types

Zetadocs for NAV integrates with two native company types in its initial configuration, Customer and
Vendor. However, the code which directly accesses these tables is kept in 2 locations that are public to a
NAV VAR. As an example of how one could implement a new bespoke company type or in fact edit one of
the existing company types CUST and VEND the following example is presented.

NOTE: the Zetadocs Sales Document Queue form (9009962) operates for the Sales process only and uses
direct references to the Customer and Contact names field in the Sales Header table. If you have modified
the Sales Header table (36) to work with your bespoke Customer and/or Contact implementations then you
may need to alter the references to Sell-to Customer... and Sell-to Contact... field references.

BANK Example
Consider the business relation BANK. To integrate Zetadocs for NAV with reports that are sent to BANK
contacts you would follow these instructions.

e C(Create a Zetadocs Company Type BANK.

(= Zetadocs Company Type List [ | =[]
Code Description
Ak JBanks B
CUST Customers
VEMD Vendors

Figure 36 - Zetadocs Company Types

e Implement the BANK IF case to get the bank name and addressing information from your bank
table in the Zetadocs Send Result table (9009968) similar to the CUST case.
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Table 9009968 Zetadocs Send Result - C/AL Editor

Company Ho. - OnValidatef}

IF "Company Mo."™ <> '' THEH
BEGIN

IF "Company Type Code' = "CUST' THE
BEGIN
IF Cust.GET{"Company Ho.") THEH
BEGIN
“Company Name" := Cust.Name;
IF "Contact Ho."™ = '' THEH
BEGIN
IF Cont.GET{Cust."Primary Contact Mo.") THEMN
BEGIH
"E-Hail™ == Cont."E-Mail™;
“Fax Ho." :== Cont."Fax Ho.";
IF Cont.Type = Cont.Type::Company THEN
“Contact Name" := Cust.Contact
ELSE
“Contact Hame" := Cont.Hame;
END
ELSE
BEGIN
“E-Hail"™ := Cust."E-Mail";
“Fax Ho." := Gust."Fax Ho.";
“Contact Name" := Cust.Contact;
END;
END;
END
ELSE
BEGIHN
HESSAGE{msqCompanyHotFound);

zdUtilities.Log{2, '
END;
END
ELSE IF "Company Type Code" = "UEHD' THEHN

Please check that “Company No. Field No."

4 (m

//"Company Mame" := ZdIntegration.GetNameFromCompany{“Company Type", "Company Ho."};

zdUtilities.Log{2, STRSUBSTHO('T9889972 - Company No. - OnValidate: Customer %
is correct

(E=1 B )

Figure 37 - Zetadocs Send Result Table Code

e Also update the Company No. - OnLookup trigger and Contact No. - OnLookup trigger to include

the IF case for your BANK type.

e Update the thContName - OnLookup trigger in the Zetadocs Delivery Form (9009966) to use the

correct ContactBusinessRelation information if necessary.
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P

Forr 9009956 Zetadocs Delivery - Form Designer = [ =[]
&
'| Please confifm delivery settings before continuing” =~ © © © © (Tl
k:nnml:tNo. P e e | =<"Contact Mo." =
tnmﬁ-:t Mame .-. ... . | =<"Contact MName ">
EMal . ... || =<E-Mail">
FaxMNo. .. ........ ||=<Faxho.>
Delivery Method . . . . . .| =<Delivery Method™>
'| ' Template Selection I
Template ID . . . . . ... | =<"Zd Template ID">
h’emplate Mame. .. . . . . | =<"7d Template Mame™=
|l General '
_ Preview Document in Zetadocs Client Before Sending &
[ o [ cncel [ bep |

Figure 38 - Zetadocs Delivery Form “tbContName” textbox

e Thenin the Zetadocs Report Settings set the BANK Company Type for the report that has BANK
recipients and set the respective Company No. Field No. and Contact No. Field No. references for
the report source table.

o Ifyou have implemented a bespoke Customer table for use with Sales and Marketing then you may
need to update the Zetadocs Sales Document Queue Form (9009962) to use your bespoke
Customer record type references where necessary.

16.2 Contacts

Similar to Company it is possible that there may be a bespoke implementation of Contact information or
there may be a requirement to change the default contact address resolution logic of Zetadocs for NAV.

Validating

As has been explained the Zetadocs Report Settings the Contact No. Field No. determines whether the
contact reference can be extracted from a field in the record that is passed to the Zetadocs Send Results
Gen codeunit or whether this is implemented by the VAR and called from the codeunit. Once the reference
has been set in the Contact No. field in the Zetadocs Send Result table the OnValidate trigger is called.

Therefore to modify the contact addressing resolution or to change the code to use a bespoke contact table
you must follow these instructions:

e Modify the Contact No. — OnValidate trigger in the Zetadocs Send Result table (9009968) to get the
name and addressing information from your bespoke contact.
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Table 9009968 Zetadocs Send Result - Table Designer [ = |[(= |[£2 |
Enabled Field Mo.  Field Name Data Type
v 1 Record ID RecordlD =
v 2 Record No. Code
v 10 Company Type Code Code
v 11 Company No. Code
v 12 Company Name Text
v 20 Delivery Method Option
] s0lContactNo, ________|Code ]
v
v Table 8009968 Zetadacs Send Result - C/AL Editor E=n EoN (==
v Contact No. - OnUalidate{} o
v
v IF "Contact Ho." <> '' THEN
v BEGIN
v IF Cont.GET{"Contact MHo.") THEM
v BEGIN
v “Contact Hame" :=Cont.Hame;
v “E-Mail™ := Cont.”E-Mail";
v “Fax Mo." := Cont."Fax Ho."; |
v END E
v ELSE
v BEGIN
v HMESSAGE(msgContactNotFound);
v zdUtilities.Log{2, STRSUBSTHO('T9889972 - Contact No. - OnValidate: Contact %
zdUtilities.Log{2, ' Please check that "Contact Mo. Field Ho." is correc
< | END;
END
ELSE
BEGIN
//%hould we blank values? HO*
| EMD; -
1

Figure 39 - Zetadocs Send Result table - Contact No. code

e Modify the Contact No. — OnLookup trigger in the Zetadocs Send Result table (9009968) to use the

correct ContactBusinessRelation information dependant on the Company Type Code.

e Update the Zetadocs Delivery Form (9009966) references to contact information to use your bespoke

contact record type and correct ContactBusinessRelation information if necessary.

e Ifyou have implemented a bespoke Customer table for use with Sales and Marketing then you may
need to update the Zetadocs Sales Document Queue Form (9009962) to use your bespoke contact

record type references where necessary.
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By now you should have a good idea of what this codeunit is for. Up until now we have been exploring the
internal processing and control flow of the Zetadocs for NAV Addin. By using specific settings and writing
some code in the Zetadocs-Send Integration codeunit and the Zetadocs Send Result table triggers it is
possible to completely integrate and customize Zetadocs for NAV into an NAV system. We have also seen
the potential to implement business specific logic into the sending mechanism and expand on the Zetadocs
for NAV product functionality. There is still however room to take it further.

This section details the two basic functions in the Zetadocs-Send Customize codeunit (9009962) that allow
the implementation of more business specific send logic as well as document formatting and archiving
customizations.

17.1 GetAdditionalEmbComms
This function is deprecated in version 5.0 of Zetadocs for NAV. It remains for backward compatibility with
the old report mark-up method. Please use WriteAdditionalEmbCommsTofFile instead.

17.2 OverrideSendResult

As the name suggests this function gives you the whole send result. At this point the result has been
completely resolved by Zetadocs and any custom code that has been implemented by you in the various
areas explained earlier in this document. This then allows you to modify the completed record as a whole.
The only place the results can be edited after this are in the Zetadocs Delivery Dialogs or the Zetadocs
Errors Dialogs depending on your display settings for these dialogs, as specified in the Zetadocs Report
Settings (potentially overridden by the OverrideSendSettings in the Zetadocs-Send Integration codeunit).
Let’s examine the Zetadocs Send Result table a little more closely now for the first time.

Table 9009968 Zetadocs Send Result - Table Designer =n =<
E.. Field Mo,  Field Name Data Type  Length Description
b v 1 m RecordID The record to which the result ., =
v 2 Record Mo, Code 80 Optional storage of arecard n...
v 10 Company Type Code Code 20 Type of Company
v 11 Company Mo, Code 30
v 12 Company Mame Text S0 Company Mame
v 20 Delivery Method Option The delivery addressing bo use ..,
v 30 Contact Mo, Code 80 Reference to the Contact spedi...
v 31 Contact Mame Text 50 Contact Mame
v 40 E-Mail Text 250 The Email To address line
v 41 E-MailCc Text 250 Customizable Co adressing
v 42 E-MailBcc Text 250 Customizable Boe addresssing
v 43 E-MailFrom Text 80 The Email From address line
v 50 Fax MNo. Text 250
v 60 Printer Text 250
v 70 ArchivingEnabled Boolean
v 71 Archive Location Text 250 The roat sharepoint archive Fal...
v 72 archive Document Type Text 50
v 80 Zetadocs Archive ID GUID
v 85 Zetadocs Record Link Text 250 The Zetadocs Record Link for ...
v 86 Zetadocs Record Link Type Text 10 The Type of record link
v 90 Zd Template ID Code 20 The Zetadocs Template to use, ...
v 91 Zd Template Name Text 100 Mame From Template table,
v 110 Errar Boolean Error flag
v 111 Error Descripkion Text 250
v 112 Skip Boolean Should the record be skipped in...
v 130 Qukput File Mamne Text 150 Customizable output name of p...
v 140 Lines MNo. GUID Used ko references other resul...
v 150 Record ID String Text 250 The record to which the result ...
v 160 MetworkarchivingEnabled Boolean
v 161 Metwork Archive Location Text 250 The root network archive folder =
Help

Figure 40 - Zetadocs Send Result
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Some of these fields will be familiar from having worked with the Zetadocs Company Rule used in the
GetCompanyRule trigger function in the Zetadocs-Send Integration codeunit. Let’s break them up into their
respective parts and get familiar with their use and how we can exploit this to implement our specific
business logic and workflow.

Record Fields (1-2)

The Record ID and Record No. represent the typeless and typed references to the record we are sending.
Record ID is used by the core processing of Zetadocs for NAV to tie the send results and records together.
Record No. is what will ultimately be passed to Zetadocs for use as an external reference by either the
recipient or in archiving to SharePoint. For more information on Record No. click here.

Example Usage:
Having the Record ID of what you are sending means you can get that record and query or use values from
that record to implement logic for changing other fields in the Zetadocs Send Result.

Company Fields (10 - 12)

These fields and their use should be extremely clear by now. The Company Type Code allows us to integrate
with native and bespoke company tables such as Customer, Vendor and one of your own design. Company
No. and Company Name are then obvious references to the id and display name of the company.

Delivery Method (20)

This controls the addressing that is selected for sending, E-Mail, Fax or Hard Copy. Some obvious
customization possibilities include implementing a company policy such as “Any company sensitive
information should not be emailed under any circumstance and should be faxed or printed only.”
Depending on particular reports or recipients the delivery method could be checked or changed to uphold
company policy.

Contact Fields (30 -31)

In collaboration with the Company fields these fields can integrate with native and bespoke systems for
contact addressing information resolution. By setting and validating this field is it possible to pull the
information from the contact based on the logic that is implemented in the Zetadocs Send Result table
triggers as discussed previously.

Addressing Fields (40 - 60)

Provides the ability to set additional email recipients in the Cc and Bcc fields, these fields are without
relationships to the contact and company references that may or may not be present in the send result
record. This means that addressing information can be taken from anywhere for the respective email, cc,
bcc, fax and print addressing fields. Care should be taken to clear the company and contact no. fields before
setting these values manually.

Archiving Fields (70 - 72)

Set in the Zetadocs General Settings, the SharePoint archiving settings are available for per record
modification. This can be used for example in deciding whether or not the document is archived depending
on its content or changing the archiving location to a limited permissions document library in SharePoint, or
sub categorizing documents using the Zetadocs Archive Document Type.

Properties:
e Archiving Enabled — per document archiving
e Archive Location — the archive connection string takes the following format
“sharepoint: <site>, <archive library>[/subfolder[/subfolder...]]”
E.g. “https://mysite.sharepoint.com, Zetadocs/Mysubfolder”
e Archive Document Type

WARNING: Consideration should be taken when modifying the subfoldering of documents to SharePoint as
this can dramatically affect performance or visibility of document from SharePoint in NAV. Please refer to
the advice on file planning in this guide.
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Zetadocs Archive ID (80)
This field has been deprecated in version 5.0 of Zetadocs for NAV and should be ignored. It remains for
backward compatibility. For upgrade systems, please read the warning below.

WARNING: This field will contain data which contains a reference for an NAV record to archived documents.
It should not be edited or you risk breaking the archive search functionality of Zetadocs for NAV.

Zetadocs Record Link (85)
WARNING: This field will contain data which contains a reference for an NAV record to archived documents.
It should not be edited or you risk breaking the archive search functionality of Zetadocs for NAV.

Zetadocs Record Link Type (86)
WARNING: This field will contain data which contains a reference for an NAV record to archived documents.
It should not be edited or you risk breaking the archive search functionality of Zetadocs for NAV.

Zetadocs Template Fields (90-91)

The “Zd Template Name” field is set automatically as the “Zd Template ID” field has a table relation with the
Zetadocs Template table. The uses of this field are fairly obvious, change the Zetadocs template being used
depending on some custom business logic.

Error Fields (110-111)

The Zetadocs Send Result table (9009968) has a trigger function CheckErrors. This function is called for
each results record in the Zetadocs Send codeunit during the ProcessRecords function. This happens after
all possible modifications of the send result values have taken place in the Zetadocs-Send Integration
trigger functions and Zetadocs-Send Customize codeunit override function OverrideSendResult. This
function checks the addressing information (email, fax, and printer) against the specified Delivery Method
(Email, Fax, Hard Copy) to pre-empt potential send failures in the Zetadocs Client. If an error is found in a
Zetadocs Send Result record the Error field is set to TRUE and a description of the error written in Error
description. It is possible to implement your own error checks by editing the code in the CheckErrors
function in the Zetadocs Send Result table. Note that the presence of an just 1 error record in the Zetadocs
Send Result record for a particular send will cause the Zetadocs Batch Delivery Dialog to display IF the
Zetadocs Send Settings for that send has Show Batch Delivery Dialog set to TRUE otherwise all errors will
be marked as Skip = TRUE.

Skip (112)

When Skip = TRUE this will cause the report to use CurrReport.Skip for the associated record. For example if
your report contains 3 reports and one is marked to skip then only 2 will be printed to Zetadocs. If the
Zetadocs Batch Delivery Dialog is displayed either by there being errors in the send results or by the user
choosing to preview the send results, they can manually set a report to skip particular report records.
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ZLetadocs Batch Delivery Settings E@
Please correct any errors listed or select to skip the records before continuing
Skip All Errors Preview Documents in Zetadocs Client Before Sending
Record ID  Company M... Contact Mo, ContactM... Delivery ... Template  Error Error Des... Skip E-Mail Fax MNo.
b |SalesHe... Autohaus... CTO00062 Autohau... E-Mail ZD-Order... autohaus... -
Sales He... Designstud... CTO00045 Designst... E-Mail ZD-Order... designst...
ok | [ Edt | [ Edtal | [ cancel | [  Hep

Figure 41 - Zetadocs Batch Delivery Dialog

Output File Name (130)

When a report is printed to Zetadocs and split into the addressable documents each document is given a
name. It is desirable to be able to control the name of these documents as it will be the name of the PDF file
produced and attached to emails as well as archived to SharePoint. This field allows you to set that
document name. A good example of its use would be to generate the name based on the type of report and
the record no. For example: “Order Confirmation: 10045”. Using the RecordID you can retrieve any
information about the record for generating the output file name.

Lines No. (140)
WARNING: This field will contain data used internally by the Zetadocs core processing.
It should not be edited or you risk breaking functionality of Zetadocs for NAV.

Record ID String (150)
WARNING: This field will contain data used internally by the Zetadocs core processing.
It should not be edited or you risk breaking functionality of Zetadocs for NAV.

Network Archiving Fields (160 - 161)

Set in the Zetadocs Delivery Settings, the archiving settings are available for per record modification. This
can be used for example in deciding whether or not the document is archived depending on its content or
changing the archiving location.

Properties:
o Network Archiving Enabled — per document archiving
e Network Archive Location — the archive connection string is the desired network archive path and
takes the following format
“/ [*yourmachinename*/*yoursharedfolder*[/subfolder[/subfolder...]]”

17.3 WriteAdditionalEmbCommsToFile

In the final stage of the reporting process for Zetadocs for NAV the GetRecordCustComms function is called
from the report on the Zetadocs Send Results Gen codeunit to retrieve the formatted embedded commands
which represent the send result for each report record. Internally in the Zetadocs Send Results Gen codeunit
we create the Zetadocs embedded commands but before we return it we call this trigger function
WriteAdditionalEmbCommsToFile in the Zetadocs-Send Customize codeunit. This allows you to return
additional embedded commands which can be used to customize your document message subject and
body text as well as additional archive metadata to associate with the document when it is archived.
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Dynamic Fields
Dynamic Fields are name/value pairs that can be used to pass any information to Zetadocs. The format of
the command is:

% %l[field: <name>, <value>]

For Example:
%%]field: salutation, Mr.]

By using this in conjunction with a Zetadocs Templates you can personalize the message as follows.
%%]field: salutation, Mr.]

%%[field:name, McCarthy]

%%l[field: company, Widgets Inc.]

%%l(field: quote_number, 1234]

%%l[field: myname, Sam]

Document Template

When merged to a document template containing the following text:

Dear %%[salutation] %%[name]

I'm pleased to attach your quotation as discussed along with our conditions of sale and product brochure.
Our quotation number for your reference is %%[quote_number], please include this on your sales order.
Regards,

%%[myname]

Expected Output
Zetadocs creates the following email message body:

Dear Mr. McCarthy

I'm pleased to attach your quotation as discussed along with our conditions of sale and product brochure.
Our quotation number for your reference is 1234, please include this on your sales order.

Regards,

Sam

Archiving Metadata
It is also possible to archive any of the dynamic fields as metadata. To do this the embedded command
should include the ARCHIVE flag at the end. Here is the format:

%%[field: <name>, <value>, ARCHIVE]
For Example:
%%l[field: Postcode, N7 oJE , ARCHIVE]

Whether the dynamic field is used in personalizing the message or not its value name pair will be passed to
the SharePoint archive as a content type column.

There are a couple of things to note about this. If the column name does not exist already in SharePoint it
will need to be created as a column of the content type Zetadocs or of a content type that is a sub type of
the Zetadocs content type, this needs to be done in SharePoint in advance.

Zetadocs documents default to using a Zetadocs content type. If you have specified an Archive Document
Type then the content type must be a child type of the Zetadocs content type. NOTE: It is essential that the
SharePoint columns and content types are created before archiving a document and that it is well tested
before roll out.
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Appendices

The appendices contain advice on how to troubleshoot your system as well
as details on how to perform installations which do not follow the standard
pattern, such as upgrades and Terminal Services installs.

Contents

Technical Information

Zetadocs NAV Licensing

Archiving File plan

Zetadocs Server Information

Testing Zetadocs Delivery and Capture Essentials
Testing Delivery and Capture Plus

Manual Modification of the NAV pages, forms and reports
Adding Capture Essentials features in other areas of NAV
Troubleshooting

Routine Activities

Migrating to the live database

Installing Zetadocs for NAV using Group Policy
Upgrading Zetadocs Express to the full product
Uninstalling Zetadocs for NAV

Assigning a specific icon for your pdf files in SharePoint (Optional)
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18.Technical Information

18.1 Microsoft Dynamics NAV Compatibility

This product has been developed and tested against Microsoft Dynamics NAV versions 5.0 SP1, 6.0. R2 and
7 (NAV 2013). We also support earlier version databases of NAV, when used with a version 5 SP1 client or
later. Database version support starts at NAV 3.6. Some of the integrations and modifications of NAV will
require a developer licence.

18.2 Installation Pack Contents
The software is supplied as a download and contains the following:

Zetadocs NAV Server Components
Folder containing the updates for NAV and installation support files:
e NAV .fob files containing code/table/form/pages etc. objects to import into NAV

Zetadocs for NAV Client
Installs everything that is needed on the end user desktop:
e Zetadocs Client application with NAV extensions
e Zetadocs API runtime
Target OS: Windows Server 2012, Windows Server 2008, Windows Server 2003, Windows 7, XP, Vista,

Zetadocs SharePoint Extensions

e SharePoint Extensions wsp file
Target OS: Windows Server 2012, Windows Server 2008,
SharePoint 2010 full, foundation and online.

Zetadocs Server
e Zetadocs Server Installer
Target OS: Windows Server 2012, Windows Server 2008, Windows Server 2003,

Documentation
e Documentation (installation, configuration and deployment instructions)
e Zetadocs for NAV help files

Supported Language
English, French, German, Danish, Italian, Spanish, Dutch

NAV Databases supported out of the box
AU-NZ, NA, DK, FR, DE, IN, IE, IT, NL, ES, GB, W1, AT, BE

18.3 Technical Specifications
This section details the minimum system requirements suitable for using Zetadocs for NAV.

Client Operating systems supported

e  Windows 8 (32-bit and 64-bit)
Windows 7 (32-bit and 64-bit)
Windows Vista Business, Ultimate and Enterprise (32-bit and 64-bit)
Windows XP Professional (32-bit)
Windows Server 2012 (64-bit)
Windows Server 2008 R2 (64-bit)
Windows Server 2008 R2 with Remote Desktop Services
Windows Server 2008 R2 with Citrix XenApp 5 and 6
Windows Server 2008 Standard Edition (32-bit and 64-bit)
Windows Server 2008 with Windows Terminal Services
Windows Server 2008 with Citrix Presentation Server 4.5
Windows Server 2003 Standard Edition (32-bit and 64-bit)
Windows Server 2003 with Windows Terminal Services
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e Windows Server 2003 with Citrix Presentation Server 4.5
Platform Specific Steps: Please see the additional information available via the links below if you are
installing on these platforms - Terminal Services, Group Policy.

Requires Microsoft.NET Framework® version 3.5
Integrates with Microsoft Office Outlook® 2003 SP2, Microsoft Office Outlook 2007 and Microsoft
Office Outlook 2010

e Integrates with Lotus® Notes® V6.5 and above

e Integrates with SMTP email systems

e Active Directory® integration for rapid and easy deployment to all network users

Client Hardware requirements
e Itis recommended that systems have Pentium® class CPUs of 1 GHz or higher with 1GB RAM or
more

PDF capabilities

Create PDF files which are readable using Adobe® Reader® software version 5 and later
Supports PDF attachments created in PDF 1.2, 1.3, 1.4 and 1.5 standards

Specify PDF security options such as allow printing, content extraction and password protection
Password protection using 40-bit and 128-bit encryption

18.4 Product Variants

Zetadocs Delivery Essentials
Provides the core functionality of Zetadocs for NAV, with delivery rules to automate document delivery and
SharePoint archiving.

Zetadocs Capture Essentials

Capture essentials provides you with our drag and drop capture facility, this means that documents and
emails can be dragged into the specifically created areas in our Zetadocs for NAV modified forms within the
NAV Role Tailored Client. These are then added to your archive. It also provides the Sales and Purchase
Document Queues.

Zetadocs Delivery Plus

Note: Can only be installed by Advanced Solution Partners

Delivery Plus provides a whole host of customisation options for Zetadocs. It is designed for use by NAV
VARs and systems integrators with experience in programming within NAV, but can also be used by Equisys
to fulfil bespoke requirements for individual systems. For full details on what can be achieved and
suitability for your requirements please contact Equisys technical support.

Zetadocs Capture Plus
Note: Can only be installed by Advanced Solution Partners
Zetadocs Capture Plus provides document capture for on screen reference and approval, providing a
complete transactional document management system for Microsoft Dynamics that is based upon Microsoft
SharePoint. It contains a wide range of features for customising the behaviour of the Capture functionality
in a Zetadocs for NAV system. It is designed for use by NAV VARs and systems integrators with experience
in programming within NAV, but can also be used by Equisys to fulfil bespoke requirements for individual
systems.
Features Include:

e Capture and conversion of inbound documents to PDF/A format
Custom Document Queues
Optical Character Recognition
Barcode Recognition
On screen approval with workflows

o Document Association
For full details on what can be achieved and suitability for your requirements please contact Equisys
technical support.
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18.5 Point Solutions

Zetadocs offers a range of specific point solutions to resolve specific business requirements, the setup of
these are documented by Technical notes on our website. Details of these will have been provided with
your licencing information.

18.6 Zetadocs NAV Licensing

To successfully install Zetadocs for NAV you require a Zetadocs for NAV VAR NFR granule to be added to
your license and the appropriate Zetadocs licence for the features and user numbers you are setting up.
You will also need a refresh of your standard NAV licence to obtain the free Zetadocs Express Granule.

Required Granules
To use Zetadocs for NAV you require the Zetadocs for NAV Granule to be added to your license.

VAR - Programming access

Granule 9009961 — Zetadocs Execute Granule

End User — Execute only access

Granule 9009970 — Zetadocs for NAV Granule

Granule 9041210 — Zetadocs Express (was added to NAV licenses after June 2011.)

Optional Granules

To take advantage of Zetadocs integration with NAV contacts you require the Contact Management Granule.
Granule 5500 — Contact Management

Granule 5510 — Contact Management — Basic

Zetadocs Feature Licencing
The licence key provided by Equisys reflects the feature set and number of users purchased. The table
below identifies the different licences available and their corresponding features.

License Options Features
Send functionality
Zetadocs PDF No batch capability — basic embedded addressing commands

Client displays success dialog after send (No silent mode)

SharePoint Online (Office 365) only

Simple file plan (Zetadocs library only — no sub-folders)

Simple metadata (organisation, record number, from)

Documents Factbox with Simple approval workflow

Save and send from standard Sales and Purchase pages

Drag and drop to any page. Standard Sales and Purchase pages shipped.
Zetadocs Express Functionality plus:

Works with SharePoint 2010 on premise and on-line

Single send via print button, Batch send via print button (%%[Batch] commands)

Zetadocs Express

Silent mode (Zetadocs client )

Zetadocs Deliver
y Support for bespoke tables and reports from NAV

Essentials
Populate standard metadata fields on archive (date sent, email to, cc, bcc, recipient,
document type, company number)
Delivery method rules engine (additional recipients, templates)
Sent Items (Network folder save)
Zetadocs Express Functionality plus:
Works with SharePoint 2010 on premise and on-line
Document queues with standard actions (Sales, Purchase and other using standard actions).
Zetadocs Capture Local scan button on Documents Factbox
Essentials Populate standard metadata fields on archive (record type, date received, company

number)

PDF/A conversion (using Stellent)

OCR of captured documents (requires additional Abbyy license)

Zetadocs Delivery Essentials and Express Functionality plus:

Customisation in NAV by writing C/AL code including:

Zetadocs Delivery Plus . adding additional embedded commands (e.g. add additional attachments)
bespoke business logic to modify recipient or preparation details

Custom metadata, file plan (site, content type, folders)
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Zetadocs Capture Essentials and Express Functionality plus:

Document queues with own actions (non-standard)

Zetadocs Capture Plus Customisation in NAV by writing C/AL code (Run additional business logic)
Automated filing using barcodes (requires additional Abbyy license)
Custom metadata, file plan (site, content type, folders)

18.7 Archiving File plan

Zetadocs allows you to archive captured and delivered documents to a SharePoint archive using our file
plan settings to ensure it is all filed according to your settings. Below is advice on how to get the best
performance from your SharePoint archive as building very large libraries can impact performance of
SharePoint and the rate at which Zetadocs can access your archive.

Settings Available
Zetadocs has settings which determine the plan for storing documents which is set via the General Settings
Form. This allows you to configure the following options to create subfoldering for your site.

Folder Name Structure: Subdivides archived documents into subfolders of the SharePoint document library
based on information from the sent record. You can specify up to three of these values to generate your file
plan.

o COMPANY - The recipient NAV Customer name

o DATE - The Date with a format specified by the Date Folder Naming property

o DOCTYPE - The Archive Document Type as specified for the current Zetadocs Document Set, or its

override in the Zetadocs Report Settings

Date Folder Naming: Allows you to specify the format of the date folder structure in the SharePoint archive.
E.g. YYYY-MM-DD, DD-MM-YYYY, MM-DD-YYYY etc.

Recommended Settings

It is recommended that you attempt to ensure that the foldering options reflect the likely rate of archiving
on the system. For performance reasons it is best to keep the contents of a subfolder to less than 1000
items. For example if you were to process 250 invoices a week, a folder structure changing on a monthly
basis would be sufficient to avoid any potential performance issues.

For details on appropriate SharePoint server sizing click here.
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19. Zetadocs Server Information

Technical Specifications

Operating systems supported

e Windows Server 2012 (64-bit)
Windows Server 2008 R2 (64-bit)
Windows Server 2008 R2 with Remote Desktop Services
Windows Server 2008 Standard Edition (32-bit and 64-bit)
Windows Server 2008 with Windows Terminal Services
Windows Server 2008 with Citrix Presentation Server 4.5
Windows Server 2003 Standard Edition (32-bit and 64-bit)
Windows Server 2003 with Windows Terminal Services
Windows Server 2003 with Citrix Presentation Server 4.5

Hardware requirements
e Itis recommended that systems have a minimum of a Pentium® class CPUs of 1 GHz or higher with 1
GB RAM or more. Should the server be running other applications we would recommend you
expand the hardware requirements appropriately for more information on suitable configurations
please consult Equisys at support@equisys.com.

Licensing Requirements
e The Zetadocs Server requires the purchase of an additional upgrade.

Note: It is recommended that you install Zetadocs Capture Essentials first if you are installing both
modules.

19.1 How the Zetadocs Server works

Conversion

Documents are added to the document queue by placing them in a shared network folder. These are then
displayed within the document queue allowing the user to process the document and create associated
Dynamics entries and documents. The Zetadocs Server application automatically converts documents
placed within the shared network folder into PDF/A whilst storing a copy of the original document in
another folder.

PDF Format

The Zetadocs Server converts documents in supported formats into PDF 1.4 (PDF/A-1a) format. This is an
international ISO standard ISO 19005-1:2005 for more details on this format please see
(http://www.pdfa.org/doku.php?id=pdfa:en:pdfa_whitepaper).

OCR

If you choose to include OCR as part of your solution all documents converted to PDF will support full text
search. This includes graphics documents or documents that contain graphics (e.g. a PDF with embedded
graphics), this requires special processing. To provide this we have the ZD OCR Processor, this is an
optional module which incorporates the Abbyy FineReader Engine. The full text that is recognised is added
to the created PDF file as a text layer, this enables full text search.

Supported Inbound File Formats

The following file formats are supported, how they are processed depends on whether the ZD OCR
Processor has been included:

If the OCR module is installed then the following file types will be processed with OCR:

PDF (.pdf)

e BMP and DIB (.bmp, .dib)
e PCXand DCX (.pcx, .dcx)
» JPEG, JIFF (jpg, .jpeg, .jpe, .jfif)
° GIF (glf)
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e TIFF (.tif, .tiff, .g3n, .g3f)
e DjVu (djvu, .djv)

If the ZD OCR Processor is not included files will be passed for conversion without being OCR’d, we support
the following file types:
e Office files (v2003 and v2007) — Word and Excel (.doc, .docx, .xls, .xlsx)
Rich text files (.rtf)
Web pages (.html, .htm)
Text files (.txt)
Email messages (.msg format is recommended as htm format doesn’t include attachments)

Email message conversion of .msg files results in conversion of the email message body text and the
unpacking and conversion of any supported attachments. Should any of the attachments not be in a
supported format then the whole message will be flagged as having failed to convert so the user can review
it in its original format.

The following file types are not supported:
e Compression: Zip, Rar, ARJ, TAR, TGZ, CAB ...
o Media: MP3, WMV, AVI, MPG, MPEG, MP4, WAV...
e Executable types: EXE, DLL, BAT, VBS ...

Multipart Files

The Document Converter supports multipart files e.g. an email with an attached purchase order, this is then
converted into a pdf file with two or more pages with bookmarks to indicate where the various elements of
the message are contained. In the above example you would be presented with a first page containing the
email subject line, body text, addressing information and email message.

The following Email metadata is also retained:
Sent —time/date

Received - time/date

From

To

CC

Priority

Next would follow the attachments, each with its own separate bookmark within the pdf.

Note: Hosting the document queue folders on a separate machine to the one the Zetadocs Server is
running on is not supported.

Batch Scan
The Zetadocs Server supports batch scan splitting from a network scanner.

Zetadocs
Document AW AN
Converter

Network
Batch Scanner Split documents

Document Queue

It does this by monitoring a Batch Split subfolder in each of the configured document queues and

processing any documents which are deposited in it for splitting. As such you will need to configure settings on

your network scanner to drop scanned documents into the relevant folder e.g.:
<DocumentQueuePath>\Batch Split
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The Zetadocs Server processes the batch and submits the split documents to your Document Queue using
the specified splitting method, these are:

o Page Interval - The Zetadocs Server splits the batch of documents using a constant page interval
which can be configured, e.g. resulting in the batch being split every 4 pages.

e Barcode - The Zetadocs Server reads the document and splits it on detecting a barcode. If you are
using a barcode as a whole splitter page, if for example you were adding specific barcode pages to
separate the batch, you may want to delete the split page. In this case the Zetadocs Server can be
configured to discard the splitter page automatically.

e Barcode value change - If you are scanning batches with barcodes on each page, the Zetadocs
Server splits the document each time the detected barcode value changes.

Note: The barcode batch splitting methods require Capture Plus and the Abby Software installed and
configured. If you are scanning documents that contain several barcodes on the same page, a filtering prefix
can be configured exclude all barcodes without a specific prefix.
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Now that you have successfully completed the install of the Zetadocs Delivery and Capture Essentials
features it is recommended that you test them to ensure that these features operate as expected. For those
customers also installing the Delivery Plus or Captures features we would recommend you perform some of
these tests to validate your install thus far. Further testing instructions are provided later to cover this extra
Advanced functionality following their install.

Contents
Testing Delivery Essentials
Testing Optional Delivery Features
Testing Capture Essentials Features
Continuing the Installation

20.1 Testing Delivery Essentials

Your system should by this stage have the core delivery functionality successfully installed and configured,
as well as potentially having some optional archiving features. Instructions on testing both features are
below.

Zetadocs for NAV Document Delivery
The test scenarios below will demonstrate how to test delivery of the Sales Order report under a number of
different rule configurations.

Zetadocs Rules
Zetadocs enables you to precisely control how your documents are configured using our system of delivery
Rules, these work on four levels:

1. The Default Rule — a basic rule that can be used by any Zetadocs enabled report.

2. Per Document Set - specific settings for Zetadocs enabled documents by type.

3. Per Company — specific settings for Zetadocs enabled documents by company.

4. Per Company, per Document Set — specific settings applied to specific document types when sent

to a specific company.

For more details on how rules and document delivery work with Zetadocs please see section 8.6
Understanding Zetadocs Rules.

Rule Testing

Rules are created by making modifications to the settings on the Zetadocs Customer/Vendor Rule Cards
and the Zetadocs System Rule Card. The standard configuration data will have created a level 1 and 2 rules
by default, so edits to these settings can simply be undone by setting the fields to their previous values.
However creating level 3 and 4 rules creates an additional level of rules, these need to be removed as usual
in NAV by pressing F4 to delete the entry.

Level 2 Rule Test - Single Send
e Select the Administration option in the Navigation pane and then Application Setup, open the
Zetadocs Setup section and select the Zetadocs System Rule Card, or search for it in the NAV 2013
Windows Client.
e Select the document set relevant to the report you are testing, the figure below shows this card, it
is used to determine how a document set is to be delivered.
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ZD00007 Sales - Invoices - Zetadocs System Rule Card

General | Archiving

ZD00007 @

Document Set Mo.. . . .

iSales - Invoice:

Document Set Name. . .
Template ID. . . . . . .

6]

ZD-5ales Invoice Template

E-Mail =)

Template Name
Delivery Methad Priority .
E-Mail From

Comments

Delivery Type ContactMNo. MName Address

#*p | E-Mail To

Company

lLom | »

« (1 | 2

Rule v] [ Help

===

Additional Redipient Information
Mame:
Company:

Address:

Figure 42 - System Rule Invoice

e Select the Sales and Marketing option in the Navigation pane.
e Open the Order Processing section and select Orders, or search for it in the NAV 2013 Windows

Client.

e Select a suitable order record and select Print & Order Confirmation.

e The usual print dialog will appear, select Print.

e The Zetadocs Delivery card may appear (shown below) depending on your system settings, this will
contain all of the delivery details according to your current rule setup.
e Select OK to send the report, check to ensure it delivers as expected and archives if this has been

configured as well.

Note: If you have configured higher level rules for the customer in question these will supersede the

level 2 rule.

Sales Header: Order, 101016 - Zetadocs Delivery ==

Please confirm delivery settings before continuing

Contact Selection
ContactMo. . . . . . ... CT200136
ContactMame . . .. ... Mindy Martin
EMail . .. ... .. ... mindy.martin@cronuscorp.net
FaxMo. . . ... ... ..
Delivery Method . . . . . . E-Mail (=]

Template Selection
TemplateID . . . ... .. ZT00006 (]
Template Mame, . . . . . . Z0-Order Confirmation Template

General
Preview Document in Zetadocs Client Before Sending ]
oK ] [ Cancel ] [ Help ]

Figure 43 - Zetadocs Delivery Dialog
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Level 2 Rule Test — Batch Send
e Open the Order Processing section and select Orders.
Select a suitable order record and select Print > Order Confirmation.
Select a suitable rage of records and select Print > Order Confirmation.
The usual print dialog will appear, select Print.
The Zetadocs Batch Delivery card may appear depending on your system settings, this will contain
all of the delivery details according to your current rule setup.
e Select OK to send the reports, check to ensure they deliver as expected and archive if this has been
configured as well.
Note: If you have configured higher level rules for the customers in question these will supersede the level
2 rule.

Modifying the Level 2 Rule
e Return to the Zetadocs System Rule Card for the report in question and change the delivery details
for that particular document set.
e Repeat the above send tests to ensure that they operate as expected.
e Return any settings to your previous values as determined by your requirements.

Level 3 Rule Test

e Go to the Customer Card and select a customer with an order (or one you are able to create one
for).

e Click the Customer Button and select Zetadocs Rules.

e The Zetadocs Customer Rule Card will open.

e Select the Delivery Tab and select a sending option other than Use Default and/or change the
delivery address (by changing any of those settings on that page you create a Level 3 Rule for that
customer).

The Cannon Group PLC Order Confirmations - Zetadocs Custorner Rule Card = =] =

|General | Delivery |Templahe |

Contact Information
@) Use Default Mame Mr. Andy Teal

Use Contact: CI2001365 E-Mail the.cannon.group.plc@co...

Use Alternate:

Fax Mo.

= Template Information
MName ZD-Order Confirmation Tem...

Delivery Type Contact No. Name Company Address Additional Redpient Information
» |E-Mail To - MName
Company

m

Address

Rule v| | Help

Figure 44 - Customer Card - Zetadocs Tab page
e Send an Order to this customer and check that the NAV document has been delivered as expected.

Modifying the Level 3 Rule
e Return to the Zetadocs Customer Rule Card for the customer in question and change the delivery
details for them.
e Repeat the above send tests to ensure that they operate using the new rule details as expected.
e Return any settings to your previous values as determined by your requirements.
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Level 4 Rule Test
e Go to the Customer Card and select a customer with an order (or one you are able to create one
for).
Click the Customer Button and select Zetadocs Rules.
The Zetadocs Customer Rule Card will open.
Set the Document Set No. to the document set you wish to modify or create a rule for.
Modify the settings on the form as desired.
Print a NAV document and check in the Zetadocs Client that the appropriate settings from that
Customer Rule have been applied.

20.2 Testing Optional Delivery Features

You may remember that earlier you were shown a number of steps which would add functionality to a
Zetadocs system but which were not required on all setups. Should you have installed any of the features
discussed below please ensure you perform the relevant tests to ensure they operate as expected.

NAV Role Tailored Client Compatibility

Those systems which have performed the Role Tailored Client compatibility modifications either manually
or by importing the Zetadocs for NAV Interfaces - NAVW16.10 (Pages).fob file need to perform the relevant
test below to ensure setup has been successful.

e Logintothe Role Tailored Client as a user with a role with access to the modified sections within
NAV.

e Locate one of the modified forms setup to work with Zetadocs e.g. Sales Order

e Either select an existing document or create a new one and click Print.

e Ensure the document is handled as expected and in-line with the earlier delivery tests.

SharePoint Archiving Support

Those systems with SharePoint Archiving configured should already have populated there archive whilst
performing the earlier document delivery and rule tests earlier. As such viewing the document library
created earlier should display the items archived. For those without any existing content in their archive you
can modify your system settings using the steps in section 8.1 to enable archiving before repeating any of
the earlier document delivery tests.

Adding the Documents FactBox to NAV pages
The Documents tab enables Zetadocs to display related documents from your SharePoint archive within the
NAV Role Tailored Client.
e Loginto the Role Tailored Client as a user with a role with access to the modified sections within
NAV.
e Locate one of the modified pages setup to work with Zetadocs e.g. Sales Order
e Open one of the modified pages in NAV and the Documents FactBox should be displayed in the top
right hand side of the page.

Checking Zetadocs Form and Zetadocs Archive option additions to NAV

You will need to perform this test if you have imported the Zetadocs for NAV Interfaces .fob file or
performed the equivalent manual steps. The fob file will have added the menu items to the following
locations, we would recommend you test a selection of them as a minimum using both the Role Tailored
and Classic clients if applicable.

The Zetadocs Archive search menu item can be added to the cards listed in the table below:
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Form No. Form Name

21 Customer Card

26 Vendor Card

41 Sales Quote

42 Sales Order

43 Sales Invoice

44 Sales Credit Memo

507 Blanket Sales Order
6630 Sales Return Order

130 Posted Sales Shipment
132 Posted Sales Invoice
134 Posted Sales Credit Memo
6660 Posted Return Receipt
49 Purchase Quote

50 Purchase Order

51 Purchase Invoice

52 Purchase Credit Memo
509 Blanket Purchase Order
6640 Purchase Return Order
138 Posted Purchase Invoice
6650 Posted Return Shipment
140 Posted Purchase Credit Memo
136 Posted Purchase Receipt

equisys .
ZETAQOOCS

Capture. Deliver. Share.

The Zetadocs Rules menu item can be added to the cards listed in the table below:

Form No. Form Name
21 Customer Card
26 Vendor Card

Open NAV and choose one of the cards above e.g. the Customer Card.
Click on the Customer button and it will expand revealing a number of options.
Zetadocs Archive and Zetadocs Rules should appear at the bottom of this list as shown in the

figure below.

Contact

10000 The Cannen Group PLC - Customer Card

Statistics

General |Communiaﬁon I Invoicing | Payments | Shipping | Fa

Statistics by Currencies

NOo e 10000 (=) &

Mame, . . . 00 The Cannon Group PLC

Address . . . ... .. 192 Market Square

Address 2, . . . . . ..

Post Code/City . . . . . B27 T [#]| |Birmingham
Country/Region Code . . |GB (]

Phome Mo, . . v o v o

Primary Contact Na.. . . (]

Contact. . . . ... .. Mr, Andy Teal

Entry Statistics

Sales
Cross References

Service Contracts

Service ltems
Jobs
Online Map

Zetadocs Rules
Zetadocs Archive
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Figure 45 — Customer Card with Zetadocs Rules menu item added
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20.3 Testing Capture Essentials Features

If you have installed the Capture Essentials features throughout this guide you will have added a
Documents FactBox to several of your NAV systems pages in the Role Tailored Client. This will enable you to
drag and drop items into your SharePoint Archive linking them to the document currently displayed within
NAV. To test that these are operating as expected you need to do the following.

e Loginto the Role Tailored Client as a user with a role with access to the modified sections within
NAV.

e lLocate one of the modified pages setup to work with Zetadocs e.g. Sales Order

Open one of the modified pages in NAV and this will display the Documents FactBox in the top right

hand side.

Drag and drop a document to the Drage Files Here area and release it.

Open the SharePoint archive for the system and search for the original NAV record.

This should display the document you dragged and dropped into the Documents tab.

Repeat this with a selection of file types and from locations like the Outlook inbox to ensure they

function as expected.

20.4 Document Queues
This section details how to test that the Document Queue is functioning correctly. The terminology
“Zetadocs Document Queue” in this section is used to describe all document queues.

Check Scanning (Optional)

If a scanning device is connected, perform the following checks to ensure correct operation.
e Click the Queue = Scan... button to initiate scanning which uses the Zetadocs client settings.
e Scanadocument; once scan is complete the user should be prompted to name the document.

Please enter unique name for scanned document (File will be saved as pdf)

SEVCE-CMMScan 20071024 103130

[ Cancel J[ Save J

Figure 46 — Enter Scanned Document Name

e Upon Save, the scanned document name should appear in the Zetadocs Document Queue as the
latest entry. The file (typically “filename.pdf”) should also be in the Zetadocs Document Queue
shared folder location.

Check Shared Location Updating

e Create an email with an attachment and save it as a .msg file into the Zetadocs Document Queue’s
shared folder location.

e Select the Queue->Refresh menu button and ensure that the saved email.msg file is now in the
Document Queue converted into pdf format.

e Select the entry in the Zetadocs Document Queue and click Iltem—>View, ensure that the item is
viewable in pdf format

e Select the entry in the Zetadocs Document Queue and click Item->View Original, ensure that the
item is viewable in its original format.

Check Printing
e Select the scanned .pdffile and click Item—->Print, when prompted select a physical printer and
click print. Ensure that the document prints to the printer.
e Select the recently added email with attachment(s) now stored as a pdf file and click Iltem->Print,
when prompted select a physical printer and click Print. Ensure that the document prints to the
printer and that the attachments are printed out also.
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Check Delete
e Select an entry in the Zetadocs Document Queue and click Item—->Delete. Ensure that the
document is removed from the Queue and also that it successfully deletes the file from the
Zetadocs Document Queue network folder location.

20.5 Creating Documents using the Sales and Purchase Document Queues

The Sales and Purchase Document Queues have the capacity to generate a number of different documents
within NAV. These are predetermined and you should do a test for each that you intend to implement in the
system.

Sales and Purchase Queue Create Options:
Quote
Order
Invoice
Blanket Order
Credit Memo
Return Order
Link to existing sales document (posted or unposted)

Creating a Document using the Sales and Purchase Document Queues

e Open NAV and open the Zetadocs Sales Document Queue.

e Ensure the queue is populated with a selection of sample or test documents.

e Select one of the items from the queue and select Create and then the type of document you wish
to test. In this case we’ll look at a Quote, normally a user would view a queue item using the
Zetadocs Viewer and use this as the basis for filling in the quote, order invoice etc details.

e This will display the Sales Quote window. Fill in the form as usual and when finished click the Print
button.

e This displays the Sales - Quote dialog box. To send your documents using Zetadocs, check that
Send using Zetadocs is selected on the Options tab.

e  Click Print again. This displays the Sales — Quote - Print dialog box. Click OK. This displays the
Zetadocs Delivery window, where you can change any settings if you want to, e.g., if you want to
address your quote to a different contact, or if you want to change the template.

e On the Zetadocs Delivery window, if you select Preview in Zetadocs Client before sending, this
allows you to preview your document in the Zetadocs Client before actually sending it. But if you do
not select this option, your document is sent directly to the recipient.

e After sending the order, the Send Result dialog box is displayed, showing you the result. If you
click the Show log button, you can see information about the Quote you sent, and it will also tell
you the location where the Quote has been archived as per your archiving options in Microsoft
SharePoint.

e You can now close the Sales Quote window. The Zetadocs Status Message is displayed advising
you that a copy of your document that you have just processed from the Zetadocs Document
Queue, has been saved in the archive and will also give you the archive location in Microsoft
SharePoint. You will be asked whether you want to delete the document from the document queue.
If you no longer require the document to be in the Document Queue, you can delete it. You can
always go back to the Microsoft SharePoint location where the document was saved to view it.

e Repeat this process for the other Sales items and the Purchase queue as required.

e Open your SharePoint Archive and ensure the documents have been archived as expected.

20.6 Continuing the Installation

This completes the installation and testing of Zetadocs Delivery and Capture Essentials. If you are not
installing any Advanced features your setup is now complete, should you be performing the install on a test
setup please proceed to the section migrating to a live environment.
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21.Testing Delivery and Capture Plus @ -

You may wish to test on a mixture of the NAV classic and Role Tailored Clients as required by the systems
specifications to ensure all functionality operates as expected.

21.1 Creating Documents using the Custom Document Queues

The Custom Document Queues have the capacity to generate a number of different documents within NAV
based solely upon the requirements of the system. As these can take a number of forms you should do a
test for each that you intend to implement in the system in the manner it is likely to be used. The example
below will look at testing a Shipment Document Queue.

Creating a Document using Custom Document Queues
e Open NAV and open the Zetadocs Shipping Document Queue.
Ensure the queue is populated with a selection of sample or test documents.
Select one of the items from the queue and select Archive.
The available Actions should be listed. Ensure your Actions are all displayed.
Select each in turn and create and send a document.
Repeat this process for the other queues as required.
Open the SharePoint Archive and ensure the documents have been archived and sent as expected.

Bespoke Solutions

The main benefit of Zetadocs Delivery and Capture Plus is its ability to make a solution specific to your
needs, as such it is difficult to provide a comprehensive set of testing instructions. We would recommend
that you attempt to use your modifications in a manner consistent with their intended deployment, with
special attention on any bespoke business logic used.
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22.  Manual Modification of the NAV pages, forms
and reports

This section contains the steps to manually configure various elements of Zetadocs for scenarios where it is
not possible to use the tools provided to modify NAV.

22.1 Role Tailored Client Sample Pages Import

Note: This section should only be performed on systems utilising the Role Tailored client.

To enable the operation of Zetadocs for NAV with the Role Tailored Client, Page Interfaces are provided for
NAV 7.00 (2013) and NAV 6.10 (2009 R2). These pages will add the Documents Factbox to your RTC, the
drag and drop functionality is installed as part of this process.

e Loginto Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.

e Open the object designer (Shift + F12) and import the interfaces file relevant to your NAV version
from the \Zetadocs NAV Server Components\Page Interfaces\ folder. E.g. Zetadocs for NAV Page
Interfaces — NAV7.00Wai.fob where the last two letter denote the NAV database version.

e |t can be found in your product download in the folder If there are no collisions continue with the
import. If there is a collision it is recommended that you export your existing objects and compare
version of the objects with the text file versions of the interfaces detailed above to determine the
safety of the available merge/replace options in the import worksheet.

22.2 Modifying NAV Pages Manually

Should you decide not to install the Zetadocs for NAV Interfaces .fob file relevant to your NAV version, the
instructions below can be performed to add the related document Factbox, including the Capture Essentials
features if licensed, to your Role Tailored Client pages as required.

e Loginto Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.

e Open the object designer (Shift + F12) and select the page that needs to be modified and click the
Design button.

e locate the FactBoxArea on the page, it is usually at the bottom.

e Insert a new row at the top in the FactBoxArea container and enter the following information

o Name: Zetadocs

Caption: Documents (Or translated equivalent)

Type: Part

SubType: Page

O O O

== Page 42 Sales Order - Page Designer EI@
Mame Zaption Type SubType SourceExpr
<Prepayment Due Date> <Prepayment Due Date = Field "Prepayment Due Date” -
<Prepmt, Payment Discount, .. <Prepmt, Payment Discou,.,  Field "Prepmt., Payment Discount %"
<Prepmt, Pk, Discount Date = <Prepmt, Pmt, Discount ., Field "Prepmt, Prot, Discount Date"
<Control1900000007 > < Control 1900000007 Container FactBorArea
DocLments e " I
<Sales Hist, Sell-ta FactBox > «<Sales Hist, Sell-to FactBox>  Part Page
<iCuskamer Statistics FactBox > =<Customer Statistics FactBox> Part Page
<Customer Details FactBox > «<Customet Details FackBox = Part Page
<Sales Line FactBox> «5ales Line FactBox > Part Page
<Ikem Invoicing FactBox> <Ikem Inwoicing FackBox > Part Page

i =hpproval FactBox> Part Page -

Figure 47 — Page Designer

e Select the new line and press Shift+F4 to show the properties window.
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e Change the PagepartID to Zetadocs Rel. Docs. Page Part Object ID 9041211. It should look
something like the screenshots displayed below:

Zetadocs - Properties = @
Property Value
ID an41211 -
ame Zetadocs
Visible =TRLUE =
Enabled <TRUE =
Editable =TRLE =
Caption Docurnents
CaptionML Dan=Dokumenter; DEU=Dokume. .,
ToolTip <>
ToolTiphL <l Indefined>
Description <=
SubFormbiew <l ndefined:=
SubFormLink. <Undefined=
ShowFilker <Yess
ProviderID <0=
PartType Page
PagePartID Fekadorcs Rel. Daocs, Page Park
SyskemPartID <Mone >
ChartPartlD <l ndefined:= -

Figure 48 - Zetadocs Properties

e Press Fg to display the code window.
¢ Inthe OnAfterGetRecord() trigger add a local variable:
o Name: ZdRecRef
o DataType: RecordRef
e Inthe trigger add the following code:
ZdRecRef.GETTABLE(Rec);
IF ZdRecRef.GET(ZdRecRef.RECORDID) THEN
CurrPage.Zetadocs.FORM.SetRecordID(ZdRecRef.RECORDID);
e C(lose the page designer windows.
e C(lick Yes when prompted to compile and save the changes.

22.3 Classic Client Sample Forms Import

Note: This section should only be performed on systems utilising the Classic client.

These form interface changes enable users of the NAV system to access the Zetadocs Rules and Archive
from throughout various cards and appears in NAV, as shown in the figure below.

Zetadocs Rules: Opens the Zetadocs Customer Rule Card for the customer selected.

Zetadocs Archive: Opens the Documents Factbox form containing documents that have been dragged and
dropped into the archive using Zetadocs Capture Essentials. You can drag and drop documents into the
archive by dragging them into the “Drag files here” area.

To make the required changes we have provided a Form Interfaces fob file for NAV 2009 R2 for each of the
supported languages.
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f£5) 10000 The Cannon Group PLC - Customer Card . = @
Statistics F9
General | Communication I Invoicing | FPayments | Shipping | Fo Statistics hy Currencies
MO e o v e e e e e 10000 [ ﬂ Entry Statistics
Mame. . . ... .. .. The Cannon Group PLC Sales
Address . . .. .. .. 192 Market Square Cross References
Address 2. . . . . . ..
) — Service Contracts
Post Code/City . . . . . B27 4T [#]| |Birmingham (i
Country/Region Code . . |GE (4] setieies
PhomeMo. . . . .. .. £ lohs
Primary Contact Na.. . . [®] Online Map
Contact. . . . ... .. Mr, Andy Teal
Zetadocs Rules
Zetadocs Archive
[ Customer v] [ Sales v] [ Functions w Help

Figure 49 — Customer Card with Zetadocs Rules menu item added

Importing the Forms fob file
e lLoginto Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.
e Open the object designer (Shift + F12) and import the interfaces file included on your Zetadocs for
NAV product download relevant to the version and language of your install. E.g. Zetadocs for NAV
Form Interfaces — NAV6.10W1.fob where the last two letter denote the NAV database version.
e It can be found in your product download in the folder \Zetadocs NAV Server Components\Form

Interfaces\.

e |Ifthere are no collisions continue with the import. If there is a collision it is recommended that you
skip those objects that conflict and then follow the steps below to modify existing forms objects

manually.

22.4 Modifying NAV Forms Manually
If when attempting to import the Zetadocs for NAV forms into NAV you have collisions which make it
impractical to import the forms the following manual steps can be performed to provide the same

functionality.

Zetadocs Rules

To allow users to adjust the rules for a customer or vendor from an option on the relevant card we require a
modification of the customer and vendor rule cards. The steps outlined below will add the Zetadocs Rules
menu item to the Customer button on the Customer card, see the above figure, and the Vendor button on

the Vendor card.

Adding the Zetadocs Rules menu item to the Customer Card
e Open the object designer (Shift + F12)

Open the Form in Design View.
Select the Customer button.

Right Click and select menu items.
Scroll down and create the new menu item Zetadocs Rules.
Set the Action to RunObject.
In the RunObject field enter Form Zetadocs Customer Rule List.
Select View > Properties menu item or press Shift+F4.

Set the run form link to Customer No. = FIELD(No.).
Repeat this process for the Vendor Card using Vendor No. = FIELD(No.).
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SharePoint Archiving
The following changes enable display of the related document grid form which shows existing archived
documents from the record in question.

Adding the Zetadocs Archive menu item to the Sales Quote Card

Log into Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.

Open the object designer (Shift + F12) and select the form that needs to be modified and click the
Design button.

In this example we will look at modifying a Sales Quote form, for other form modifications please
follow these steps and select the option relevant to your form when prompted.

Right-click on the Quote button, or the corresponding button on your form, and select Menu Items.
Scroll down and at the bottom add a separator by using the Separator button.

Add a menu item with caption Zetadocs Archive or a suitable localised equivalent.

Add a shift+ctrl+A in the ShortCutKey field.

EE MenuButton - Menu Designer o ] 4|
v, | Caption | ShortCutkey | Action | RunObject l
¥ <RJobs> RunObject Form Job Card =

[
¥ <Caredit Cards> RunChbject Farm DO Payment Credit Card
¥  <Credit Cards Transaction Lo... RunChbject Farm DO Payment Trans. Log E...
v [
| ¥ Zetadocs Archive Shift-+Ctrl+4 L1

"I 'Pl ‘l‘l Jvl Separator Help I

Figure 50 — Menu Designer — MenuButton

While still on the Zetadocs Archive menu item, open up the C/AL Code editor by pressing F9.
In the OnPush () trigger of the menu item add a local variable (View=>Cal Locals):

o Name: RecRef

o DataType: RecordRef
Add a second local variable

o Name: ZetadocsUtilities

o DataType: Codeunit

o Subtype: Zetadocs-Utilities

Note: You may find it easier to locate the Zetadocs-Utilities using its ID code 9009959.
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| & <Control1190000030> - OnPush - C/AL Locals 1O x|
Parameters I Return Value Variables | Text Constants I
MName |DamT‘_.-pe |Subtvpe |Length |
| |RecRef RecordRef =
|__¥ | Zetadocsl tilities Codeunit  Zetadocs-Utilities ll

Figure 51 — OnPush - C/AL Locals

e Next, add the following code into the OnPush() trigger of the menu item:
RecRef.GETTABLE(Rec);

ZetadocsUetilities.ShowCaptureAddinForm (RecRef.RECORDID, STRSUBSTNO('%1-%2",
CurrForm.CAPTION, "No."));

e Close the form designer windows.

e Click Yes when prompted to compile and save the changes.

e Repeat this process for any other required forms.

22.5 Adding the Drag Drop Control to a Classic Client form
These instructions will enable you to embed the Documents Factbox into a Classic Client form rather than
have it appear as a separate form within NAV.
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1002 The Cannon Group PLC - Sales Quote

General | Invoicing | Shipping | Foreign Trade | E-Commerce

MO o e e 1002()| £ OrderDate . . . . . .. 26/01/12
Sell-to Customer No. . . 10000 (4] DocumentDate . . . . . 26/01/12
Sell-to Contact Mo. . . . |CT000001 3] Requested Delivery Date
Sell-to Customer Temp... Salesperson Code. . . . PS 3]
Sell-to Customer Mame . | The Cannon Group PLC CampaignMo.. . . . .. 3]
Sell-to Address . . . . . 192 Market Square Opportunity Mo.. . . . . 3]
Sell-to Address 2 . . . . Responsibility Center . . |BIRMINGHAM  [#]
Sell-to Post Code/City . . |B27 4KT (#]| |Birmingham [#)| AssignedUserID . . . . 3]
Sell-to Contact . . . . . Mr. Andy Teal Status ..o Open
Mo. of Archived Versions. 0

T... No. Description Location ... Quantity Unit of M... Unit Price... Line Amount E
kL. 1000 Bicyde BLUE 1 PCS 4,000.00 4,000.:

E
4 [l | +
[ Quote v] [ Line v] [ancﬁons v] [ Make Order ] [ Print... ] [ Help

[F=3ECl x5
1 .
53| Drag Files Here
2. 9

+4 |Name | Approval Status | F
[;j Play return... Start Workflow
[;j Play return... Start Workflow

4 | 11} b
Customer Information

Sell-to Customer ﬂ

= Ship-to Addresses @

= Contacts (s)

= Sales History

Bill-to Customer

= Awail. Credit 0
Item Information

= Item Card ﬂ

= Availability ©

= Substitutions (0)

= Sales Prices (0)

= Sales Line Di... [ ]

Figure 52 - Documents FactBox

Form Changes
First of all you need to rearrange the controls on the form to allow space for the control.
Add a subform into the cleared space and set the properties of the subform as follows:

o Name: Zetadocs
o Border: No
o SubFormID: Zetadocs Capture Addin Subform

Next open the form properties and set the timer interval property to 200.

Add a new global variable.
o Name: ZdRecordSet
o DataType: Boolean
Ensure the base form is selected and open the code editor.
In the OnAfterGetRecordTrigger create a new local variable.
o Name: ZdRecRef
o DataType: RecordRef
Then add the following code:
ZdRecRef.GETTABLE(Rec);

CurrForm.Zetadocs.FORM.SetRecordID(ZdRecRef.RECORDID);

In the OnTimer trigger create a new local variable.
o Name: ZdRecRef
o DataType: RecordRef
Then add the following code:
ZdRecRef.GETTABLE(Rec);

CurrForm.Zetadocs.FORM.SetRecordID(ZdRecRef.RECORDID);

IF NOT ZdRecordSet THEN
BEGIN
CurrForm. "No. ".ACTIVATE;
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ZdRecordSet := TRUE;
END;

Notes
e The Zetadocs drag drop control has a minimum size of 6000 X 6400. If your subform is smaller than
this some clipping may occur.
e The Zetadocs drag drop control needs to take focus on form opening. The final part of code in the
instructions will set the focus back to the No. field. If another field should be focused this code will
need to be adjusted.

22.6 Using the Zetadocs Sample Reports
Sample Reports are provided for NAV 7.00 (2013) W1 and NAV 6.10 (2009 R2) W1 systems only.

e Loginto Microsoft NAV as a user with SUPER user permission rights to allow you to import new
objects into the NAV database.

e Open the object designer (Shift + F12) and import the sample reports file relevant to your NAV
version from the \Zetadocs NAV Server Components\Sample Reports\ folder of your product
download. E.g. for NAV 2013 choose the Zetadocs for NAV Sample Reports — NAV7.00W1.fob.

e Next assign these reports in NAV so they run in place of the existing reports. Otherwise use the
steps below to configure any remaining reports which you require.

Sample Reports provided:

ReportID | Report Name

9009960 ZD-Blanket Purchase Order
9009961 ZD-Blanket Sales Order
9009962 ZD-Order Confirmation
9009963 ZD-Order

9009964 ZD-Purchase - Credit
9009965 ZD-Purchase — Quote
9009966 ZD-Purchase — Invoice
9009967 ZD-Sales — Credit Memo
9009968 ZD-Sales - Invoice
9009969 ZD-Sales — Quote

9009970 ZD-Statement

9009973 ZD-Return Order Confirmation
9009974 ZD-Return Order

22.7 Manually Modifying your Existing Reports

There are two goals of the Zetadocs for NAV report modifications.

1. To determine the page numbers where one report ends and the next begins.
2. To determine the record to which we want to link the document once archived.

Determining the page breaks

Zetadocs for NAV writes a short code at the top of the report page print output to identify which pages
belong to which record. This can be once per page or only on the first page depending on how the report is
written. This is why we modify the report section / layout. The Zetadocs Ref number also is capable of
dealing with copy loops so that only one copy of the document is sent to a recipient.

Determining the record to link to

If I send a Sales Order Confirmation | will want to link that document to the Sales Header record for the
report. To achieve this Zetadocs requires that you call AddRecord passing the RECORDID of that record. You
can see in the image below how the Sales Header constitutes the main loop of that report.
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Report 9009962 Order Confirmation - Report Desi... EI@
Dataltem MName
) |SalesHeader | <Salesteader> B
Integer CopylLoop
Integer Pageloop
Integer DimensionLoop1
Sales Line <Sales Line >
Integer RoundLoop
Integer DimensionLoop2
Integer VATCounter
Integer VATCounterLCY
Integer Total
Integer Total2
Integer PrepmtLoop
Integer PrepmitDimLoop
Integer PrepmtVATCounter
Integer PrepmtTotal
Integer Zetadocs

Figure 53 - Order Confirmation Report with Zetadocs Modifications

This is not always the case for all reports and so you must determine the record you want to link to and the
dataitem that is constitutes the main print output loop of your report before adding the Zetadocs Integer
dataitem and associated code. Often a report which is based on line records filtered by another record type
will have different records to link to and as the main output loop. A good example of this is the ZD-
Remittance Advice — Journal report shipped in the sample reports .fob with Zetadocs for NAV.

Report modification best practices
e Only call AddRecord with records that will print output.

o Thisis why the Zetadocs dataitem comes at the end of the report loop. That way if there is
any reason to skip a record or there is no report output for that record, AddRecord will not
get called.

e  Only call AddRecord with actual Record RECORDIDs.

o Do not get the RECORDID of a temporary table and call AddRecord passing that value as

this can lead to errors.

Report modification steps NAV 6
The following instructions need to be followed to modify an existing report to work with Zetadocs, simply
repeat these steps for each report you wish to configure.

Open the report designer for the report that you want to modify.

Scroll to the empty row at the bottom and create a new Integer data item called Zetadocs.
Indent this data item once.

Change the DataltemTableView property to SORTING(Number).

Change the MaxIteration property to 1.

Now add the following global variables:

Data Type
ZdSend CodeUnit Zetadocs-Send
ZdRecRef RecordRef

e Add the following code to the OnPostDataltem trigger for the Zetadocs data item:
ZdRecRef.GETTABLE(4+-~Main Data Item--%);
ZdSend.AddRecord(ZdRecRef.RECORDID);
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e Select an empty row on the report and press Fg to view the report code.

e Enter the following code after any existing code in the OnPreReport trigger:
ZdSend.Initialize(CurrReport. OBJECTID(FALSE), CurrReport.PREVIEW);

e Enter the following code after any existing code in the OnPostReport trigger:
ZdSend.ProcessRecords;

Report modification steps NAV 7
The following instructions need to be followed to modify an existing report to work with Zetadocs, simply
repeat these steps for each report you wish to configure.

e Open the report designer for the report that you want to modify.
e Now add the following global variables:

Name Data Type Sub Type
ZdSend CodeUnit Zetadocs-Send
ZdRecRef RecordRef

e Under the Dataltem CopyLoop add a new entry (Right click on the row right underneath it and click

New).
e Give it the following values:
o Data Type: Column
o DataSource:  ZdSend.GetZdReference(CopyLoop.Number)
o Name: Zetadocs_Reference

Scroll to the empty row at the bottom and create a new Integer data item called Zetadocs.

Indent this data item once.

Change the DataltemTableView property to SORTING(Number).

Change the Maxlteration property to 1.

Add the following code to the OnPostDataltem trigger for the Zetadocs data item:
ZdRecRef.GETTABLE(+--Main Data ltem--);
ZdSend.AddRecord(ZdRecRef.RECORDID);

Note: The Main Data Item is the table upon which the report is based e.g. Sales Reports would usually

use the Sales Header table. This information can be found in the report properties.

e Select an empty row on the report and press Fg to view the report code.

e Enter the following code after any existing code in the OnPreReport trigger:

ZdSend.Initialize(CurrReport.OBJECTID(FALSE), CurrReport.PREVIEW);
e Enter the following code after any existing code in the OnPostReport trigger:
ZdSend.ProcessRecords;

22.8 Classic Client specific layout modifications
Below are the instructions for modifying the classic report layout to include the Zetadocs reference, which is
required to add addressing information to the report once it has been printed.

e Click View > Sections to show the classic client report designer.

e Open the toolbox and add a text box that it will appear at the top of the report.

e Change the SourceExpr property to ZdSend.GetZdReference(<COPYNUMBER>).

e (<COPYNUMBER> is CopyLoop.Number if you have a copy loop or 1 if not.)

e Change the FontSize property to 4.

e Change the DataSetFieldName property to Zetadocs_Reference, Note: This field is only available
in NAV 6.0 and later and should be ignored on earlier versions of NAV.

e C(lose the sections window.

22.9 Creating Document Libraries for Zetadocs for NAV

The Zetadocs for NAV SharePoint Extensions create a document library called Zetadocs by default and
enables it for operation with Zetadocs for NAV. Should you wish to create a different document library then
you will need to follow the steps below to ensure you get the full range of Zetadocs functionality.

NOTE: You must activate the Zetadocs site features prior to performing these settings on the site where you
want the new document library.
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Create a new document library on the site.

Open the Document Library settings =>Advanced Settings.

Set Allow management of content types option to Yes.

Return to the Document Library settings and select Add existing content type and then Zetadocs in
the Content Types section.

Should you wish to enable the basic approval workflow feature then you will need to perform these
additional steps:
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From your new Document Library ribbon browse to the library Workflow Settings.

Click on Add a workflow ensuring the These workflows are configured to run on items of this type
option is set to All.

From the workflow list select the Approval - SharePoint 2010 option.

You must name the workflow Zetadocs.

Complete the workflow creation and to complete the setup you must upload a document to the
document library and run the Zetadocs workflow on it.

Once this is complete you can continue with the installation from section s5.5.

Home 9
Content Type
Ebines W Run on items of this type:
e Select the type of items that you want this morifiow to run al
on. Content type workflows can only be assodated to a list
cauisys Pl Content type, not drectly 1o e It (Selecting a different type will navigate you to the Add a Warkflow page for that content type.)
Lists Workflow )
Description:
Calendar Select a workflow to add to this document lbrary. If the Select 3 workflow template: Routes a document for approval.
workfiow template you want does not appear, contact your Three-state Approvers can approve or reject the
administrater to get it added to your site collection or Colloct Signatures - SharePoint document, reassign the approval
Discussions workspace, task, or request changes to the

Team Discussion

fa Recydle Bin

[ Al site content

Hame

Type & name for this workflow. The name will be used to
identfy this workflow to users of this document library.

Task List

Select a task list to use with this workflow. You can select
an existing task list or request that a new task list be
created.

Approval - SharePoint 2010

Type a unique name for this workflow:
Zetadocs

Select 3 task list:

Tasks [+]

document.

Description:
Use the Tasks list to keep track of
work that you or your team needs to
complete.

History List
Select a history list:

Approval History [=]

Description:
Use the Approval History list to keep
track of any reviews or approvals
that have been performed on
documents by you or your team.

Select a history list to use with this workflow. You can
select an existing history list or request that a new history
list be created.

Start Options . . . o
Allow this workflow to be manually started by an authenticated user with Edit Item permissions.

Specify how this workfiow can be started. [F] Require Manage Lists Permissions to start the workflow.

[[] Start this workflow when a new item is created.

[[] Start this workflow when an item is changed.

Next J( Cancel

Figure 54 - Zetadocs Workflow Setup
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23. Adding Capture Essentials features in other
areas of NAV

23.1 Adding Capture Essentials Features to Forms
To add Capture Essentials to a specific form you need to do the following.
e Open the object designer (Shift + F12) and select the form that needs to be modified and click the
Design button.
e When the Design view opens select View>CA/L Globals.
e C(Create a global variable with the characteristics:
o Name: RecRef
o Type: RecordRef
e Select the Functions tab and then create a global function
o Name: SetRecordID
e Click View>C/AL Code or press Fg to open the C/AL Editor, scroll down the list until you reach the
SetRecordID section.
e Add the following code:
RecRef.GETTABLE(Rec);
CurrForm.DragAndDropSubForm.FORM.SetRecordID(RecRef.RECORDID);
e Create a subform from the toolbox and place above the buttons making it the width of the items
grid.
e Select the Properties for the new subform and give it the following properties:
o Name: DragAndDropSubForm
HorzGlue: Both
VertGlue: Bottom
Border: No
SubFormID: Zetadocs Drag and Drop Subform (ID:9010010)

O O O O

-3 Commerce Gateway ~

{1 Employee Portal

-3 Document Approval

--1_] Company Setup

--1_j Microsoft Office Outlook Integration
=155 Zetadocs Setup

----- Zetadocs General Settings

.../=8 Zetadocs Delivery Settings

Zetadocs Document Queue Setup
=155 Advanced Settings

=5 Zetadocs Mo. Series

=3 Zetadocs Templates

=3 Zetadocs Document Sets
{73 Zetadocs System Rules

{73 Zetadocs Customer Rules
{73 Zetadocs Vendor Rules

{73 Zetadocs Report Settings
{75 Zetadocs Company Types
-1 Mabile

- RoleTailored Client

{3 Online Services for Microsoft Dynamics ERF =

Figure 55 - Zetadocs Drag and Drop in the classic client

e Select the main form again and click View->C/AL Code or press Fg to open the C/AL Editor.
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e Next copy the following code into the bottom of both the OnAfterGetRecord and OnNewRecord

triggers of the form:
SetRecordID;

o Note that to enable the drag and drop control, focus is taken from the default field on opening of
the form. If you wish to have the focus restored to the standard starting point for the user, add the
following code to the bottom of the OnOpenForm trigger.

CurrForm.<controlname>.ACTIVATE;
(E.G. CurrForm.”No.” ACTIVATE;)

e You can now drag and drop documents onto this form, repeat this process for any remaining forms

you wish to add the Zetadocs Capture Essentials Drag and Drop control to.

23.2 Adding Capture Essentials Features to pages in the Role Tailored Client
e Open the object designer (Shift + F12) and select the page that needs to be modified and click the
Design button, in this example we will be looking at the Employee card.
e Add the following entry inside the <Controligooooo001> section:

o Name: Zetadocs
o Caption: <Zetadocs>
o Type: Part

e The Zetadocs Related Documents Grid will appear in this location, as such you can choose where
you wish to display it. You can enter the line between, on top of, or at the bottom of the other
controls.

e Forexample, putting the line on top of Control1 will place the related documents list at the top of
the Employee Card page in the RTC.

e Place the Zetadocs line in a suitable location, if unsure view the page and find the entry below
which you wish it to appear and place it there.

e Once you’ve added the line select it and open the properties (shift+Fz) for it.

e Scroll down to the PagePartID field and select Zetadocs Related Docs List, ID:9010003.
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4

o8

Figure 56 - Zetadocs line addition

o =T
| |Mame |Cmn |Type |SubTwe |Sourerg | Property |VE\ue | |
| <Contral 19000000013 <Control 1900000001 Container ContentArea | D 1000000000 :I
|| <control1> General Group Group Name Zetadocs
|| <No.» <No.> Field No.” Visible <TRUE>
|| <JobTitle> <Job Title> Field “Job Title” Enabled <TRUE>
| <First Name > <First Name > Field “First Name™ Editable <TRUE>
- <Last Name> <Last Name> Field "Last Name" Caption <Zetadocs>
- <Middle Name > Middle Name/Initials Field “Middle Name™ CaptionML <Undefined >
- <Initials > <Initials > Field Initials ToolTip <>
|| <Address> <Address> Field Address ToolTipML <Undefined>
- <Address 2> <Address 2> Field "Address 2 Description <>
|| <PostCode> «Post Code > Field "Post Code” SubFormView <Undefined >
- <City> <City> Field City SubFormLink <Undefined >
|| <Country/Region Code> <Country/Region Code> Field "Country/Region Code™ ProviderID <0
- <Phone No. > <Phone No. > Field "Phone No.” PartType <Page>
- <Search Name> <Search Name > Field “Search Name™ PagePartlD ll
- <Gender> <Gender> Field Gender SystemPartlD <None>
| <Last Date Modified > <Last Date Modified > Field "Last Date Modified” ChartPartiD <Undefined>
|__| <Control1902758501> Communication Group Group
|| <Extension> «Extension> Field Extension
||  <Mobie Phone No.> <Mobile Phone Mo, > Field "Mobile Phone No.™
|| <Pager> <Pager> Field Pager
|__| <PhoneNo.> «Phone No. > Field "Phone No.™
|| <EMail> <E-Mail> Field "E-Mail”

- <Company E-Mail> <Company E-Mail> Field “Company E-Mail”
|| <At Address Code> <Alt. Address Code> Field "Alt, Address Code”
[ <Alt, Address Start Date > <Alt, Address Start Date = Field "Alt. Address Start Date”™
||  <Alt AddressEndDatex «Alt, Address End Date> Field "Alt. Address End Date”™
|| <Control1900121501> Administration Group Group
| | <EmploymentDate> <Employment Date > Field “Employment Date”
|| <Status> <Status> Field Status
|__| <Inactive Date> <Inactive Date> Field "Tnactive Date”
- <Cause of Inactivity Code> <Cause of Inactivity Code> | Field "Cause of Inactivity Code”
| <Termination Date > <Termination Date > Field "Termination Date™
|__| <Grounds for Term. Code> <Grounds for Term. Code> | Field "Grounds for Term. Code™
- <Emplymt. Contract Code> <Emplymt. Contract Code>  Field “Emplymt. Contract Code™
|| <Statistics Group Code > <Statistics Group Code > Field "Statistics Group Code”
| | <ResourceMo.> <Resource No. > Field "Resource No.™
|__| <Salespers./Purch. Code> «Salespers, Purch, Code>  Field "Salespers. Purch. Code™
|| <Control1901160401> Personal Group Group
| | <@irthDatex <Birth Date> Field “Birth Date”
|| <socal Security No.> <Social Security No. > Field “Social Security No.”
|| <union Code> <Union Code» Field "Union Code™

<Union Membership Na. > <Union Membership No. > Field “Union Membership No."™

T
| <Control 1900000007 <Control 1900000007 Container FactBoxArea
«<Control 1900383207 > <Control1900383207> Part

e Select View>CA/L Globals and select the Variable tab, create a new global variable with the

values:

o Name:
o Type:

RecRef

RecordRef

e Click View>C/AL Code or press Fg to open the C/AL Editor, scroll down to the OnAfterGetRecord
section and enter the following:
RecRef.GETTABLE(Rec);
CurrPage.Zetadocs.FORM.SetRecordID(RecRef.RECORDID);

e The Documents FactBox can now be used in the Role Tailored Client.
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24. Troubleshooting

24.1 Troubleshooting

This section provides help with resolving common problems with the system. To assist in trouble shooting
problem with the Zetadocs system there are a number of log files which can help diagnose a problem or
assist in getting the configuration of the system correct.

NAV Logging
Ensure that Logging Enabled is ticked ON in the Zetadocs System Settings Form. The Logging Level
determines the amount of information written to the log file. For general configuration and trouble shooting,
WARNING or ERROR should suffice. The NAV log is saved to the users temp folder location. This can be
found by either pressing Start->Run, then type %Temp% and press OK; or manually browse to
C:\Users\<username>\AppData\Local\Temp (Vista) or C:\Documents and
Settings\<username>\Local\Temp(XP) directory.
There are two logs produced by the Zetadocs for NAV Addin.

e ZdExternalUtilitiesDll.log — logging of document queue actions and external calls to Zetadocs API.

Only valid for troubleshooting issues with Equisys.
e ZetadocsNAV.log — standard logging of activity that occurs in the Zetadocs for NAV objects.

Zetadocs Client
Please refer to the Zetadocs Client help for information on client logging.

Zetadocs API
The Zetadocs API runtime, which is used as part of the Zetadocs for NAV addin logs information to the users
Zetadocs folder. Its contents are usually of value when troubleshooting issues with Equisys.
It can be found at:
e C:\Users\<username>\AppData\Local\Equisys/Zetadocs PDF/ZdApi.log(Vista)
e (C:\Documents and Settings\<username>\Local\ApplicationData\Equisys\Zetadocs PDF\ZdApi.log
(XP).

Object ID collisions when importing the Zetadocs objects .fob file

Unless you are re-importing the objects or performing an upgrade it is unlikely that you will come across an
ID collision. If you do, please continue and view the recommendations of the import collision wizard in NAV.
It is not recommended to undertake collision resolution unless you are an experienced NAV consultant.

Some objects fail to compile during import of the Zetadocs objects .fob file
Most likely this is due to not having installed the Zetadocs for NAV Client on the machine you are using to
import the Zetadocs objects from. Many of the codeunits in Zetadocs for NAV use automation components
which must be installed prior to importing to ensure that all objects compile successfully.
Things to check for (in order):
¢ You have installed the Zetadocs for NAV Client on the machine you are using to import the
Zetadocs objects
e You are logged in as the user who installed the Zetadocs for NAV Client
e Ifthe above are true but you are still having problems try uninstalling and re-installing the
Zetadocs for NAV Client

When you run the Customer/Vendor Card no information is displayed in the Zetadocs tab
Copy and pasting the Zetadocs subform control on to the Zetadocs tab should copy all required subform
links. If you are experiencing problems check the following property values on the subform control on the
Zetadocs tab:

e  SubFormlID: Zetadocs Customer Rule Subform

e  SubFormLink: Customer No.=FIELD(No.),Zd Rule ID No.=CONST(0)
OR For Vendors

e SubFormiD: Zetadocs Vendor Rule Subform

e  SubFormLink: Vendor No.=FIELD(No.),Zd Rule ID No.=CONST(0)
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SharePoint Logging
The logs for Zetadocs activity on your SharePoint site can be found in the following locations:

SharePoint 2007 Systems
C:\Program Files\Common Files\Microsoft Shared\web server extensions\12\LOGS\Zetadocs

SharePoint 2010 Systems

C:\inetpub\wwwroot\wss\VirtualDirectories\8o\%CommonProgramFiles%\Microsoft Shared\Web Server
Extensions\14\LOGS\Zetadocs
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This section contains details on performing routine tasks and other procedures which may be required to

maintain an operable system.

25.1 Operational Checklist

Use these checklists periodically to record operations.

Checklist: System Operation
Follow the checklist to verify system operation.

Completed Task

Check the operation of each Zetadocs enabled NAV report.

Check and verify that messages print to the Zetadocs Client successfully.

Check and verify that messages deliver successfully.

Check and verify that messages archive successfully.

Check the number of documents printed, delivered and archived match.

Check the operation of each Zetadocs enabled NAV report.

Checklist: Event Logs
Check event logs using the following checklist.

Completed Task

repetitive warning and error logs.

Filter application and system logs on each NAV Client to see all Zetadocs errors Note

search and crawl errors. Note repetitive warning and error logs

Filter application and system logs on the SharePoint server to see all Office SharePoint

this guide.

Respond to discovered failures and problems with the aid of the Troubleshooting section of

Checklist: Check NAV and SharePoint Backups
Complete this checklist to check supporting systems backups.

Completed Task

completed.

Ensure that the recommended minimum backup strategy - a daily online backup - is

Verify that the previous backup operation completed.

Analyze and respond to errors and warnings during the backup operation.

Follow the established procedure for tape rotation, labelling, and storage.

logs).

Verify that the transaction logs were successfully purged (if your backup type is purging

Make sure that backups complete under service level agreements (SLA).

25.2 Security Hardening

Zetadocs for NAV provides the ability to print and send NAV information and in that respect consideration
should be made as to ensuring the safety of both the information and the method of delivery. As Zetadocs
integrates with Microsoft Dynamics NAV and Microsoft Office Outlook as standard for the source and

destination of the information attention should be paid to the access permissions with NAV to
data. Overall best practices should be followed for the deployment of NAV and Office Outlook.

particular

Similarly the setup and configuration forms within Zetadocs for NAV are recommended for access only by an
NAV Administrator and therefore access permission roles should be set up to this effect as with the other
areas of NAV. For general advice on Security Hardening for NAV and other general recommendations please

refer to the “Navision Security Hardening Guide” which is downloadable from
http://www.mibuso.com/dlinfo.asp?FilelD=474 .
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Some features of Zetadocs for NAV involve the use of shared network folders. It is strongly recommended
that only the necessary users are granted access to these folders. Examples of these are: Zetadocs
Template folders, Zetadocs Document Queue folders.

The Zetadocs Configuration, which contains details of enabled users, license and location of shared
network folders, is stored in the domain partition of Active Directory. Optionally this configuration can be
stored on a network share; it is also strongly recommended that only the necessary users are granted
access to this folder.

SharePoint Security

If integrating with Microsoft SharePoint as a document archive, consideration should be made as to the
access permissions of users to view potentially sensitive archived information. For general security
recommendations for Microsoft SharePoint Server please refer to Microsoft documentation. Some
information on security hardening can be found here http://technet.microsoft.com/en-
us/library/cc262849.aspx .

From Zetadocs for NAV, rules can be setup to change the archive location of documents dependant on type
and writing some code in the Zetadocs-Customization codeunit, per record archive locations can be set
dependant on content. For this reason it is recommended to consider access permissions when creating the
Zetadocs System Rules.

25.3 Performing a Zetadocs for NAV Backup

This section describes how to perform backups of a Zetadocs for Microsoft Dynamics NAV system. This
enables you to safeguard your organizations information resources by holding extra copies in secure
locations and enables you to restore your systems following problems with the original data.

How Zetadocs for NAV Backup integrates with NAV Backup

Zetadocs for NAV has additional tables contained within NAV which when NAV is fully backed up will also be
included within the backup meaning that there is no additional overhead in performing the standard
operation. There are however elements to Zetadocs for NAV which exist separately from NAV which will
require additional steps to include in a complete backup.

Document Queues — The Zetadocs Document Queues are centralized folders for processing documents
from, in essence a virtual in tray. The Zetadocs Document Queues operates by accessing a shared network
folders which contains documents received by NAV via email, fax or scanned from hard copy sources. As the
folder is not part of NAV it will not be backed up during an NAV backup as such it is desirable to backup the
network folders separately.

SharePoint Archive — If the archiving options in Zetadocs have been configured to archive documents into a
SharePoint archive then this to would need to be backed up separately as well to ensure that the record of
processed documents is not lost. The backup of this data falls under the standard backup of a SharePoint
system and therefore may be part of your existing backup procedure.

Preparations before Backing up

It is important to have a clear strategy for dealing with system backups as it is both business critical and
also a legal requirement that backups of essential business data be kept. There are obviously a number of
decisions to be made when backing up:

e Identify the data to be backed up

e Frequency and Timing of the Backup

e Storage Format

e Storage Location

Performing an NAV System Backup

To perform a backup follow the standard NAV backup instructions, a full system backup will include both
NAV and the Zetadocs elements integrated into NAV.
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Backing up the Zetadocs Document Queues
To backup the document queues you need to simply locate the network folders used for your queues and
copy those folders to the assigned storage location for your backup.

Backing up your SharePoint System
Backup of all SharePoint site and document libraries for Zetadocs for NAV are covered in a standard
Microsoft SharePoint backup.

Restoring a Zetadocs for NAV system

To restore your Zetadocs for NAV system following problems with the original data you need to restore 3
separate elements. The NAV system backup itself which contains the additional Zetadocs elements, the
document queue backup and the SharePoint archive.

Preparations for Restoring your System

It is important to have a clear strategy for dealing with system restorations as it is critical to the business
that the system can be restored. There are obviously a number of decisions to be made when restoring the
system:

e |dentify the storage location for the backup

¢ Identify which backup data set is to be restored

Restoring your Zetadocs for NAV System

At some point you may need to restore your system using a backup, this will restore the Zetadocs for NAV
system excluding the document queue and the SharePoint archive which will be covered later in this guide.
To restore your system follow the standard restore instructions as laid down in NAV.

Backups that were exported with the Microsoft Dynamics NAV backup facility can be imported by using
Tools, Restore. You should always restore the database backup into a new (empty) database.

Restoring the Document Queues

e Locate the copy of the network folders which contained the contents of your document queues in your
backup location.

e Copy the folders (or the specific elements you desire) to the network folders being used for your
respective document queues. The location of these folders will be specified within the Zetadocs Sales
Document Queue Setup Form and Zetadocs Purchase Document Queue Setup Form.

Restoring your SharePoint System
All SharePoint sites and document libraries for Zetadocs for NAV can be restored using the standard
Microsoft SharePoint Restore instructions.

Reinstalling the Zetadocs for NAV SharePoint Extensions
If you have had to completely rebuild your SharePoint system then you will need to reinstall the Zetadocs
for NAV SharePoint Extensions after you have restored your SharePoint system.
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26. Migrating to the live database

At this stage the system configuration and testing of Zetadocs Delivery Essentials should be complete, if
these are the only elements to be installed in your system and you have been performing these steps on a
test version of your system you can now migrate it to the live database. Otherwise please continue
installing any remaining components, there will be details on migrating these systems provided following
their install and configuration. The process is very similar to the steps taken in sections 7 and 8 save that
the configuration file that you will be importing is now configured to your requirements.

This requires a number of steps:

Exporting the Configuration

Exporting any Modified Forms, Tables or Reports
Importing the Zetadocs for NAV Objects
Importing any Modified Forms, Tables or Reports
Importing the xml file with your configuration

26.1 Exporting the Configuration
The Zetadocs Configuration Export form will export all of the configuration data specific to Zetadocs, if you
have modified data in other tables this will not be exported.

e From the Navigation pane select the Administration option.

e From the options that appear, select Application Setup and then Zetadocs Setup.

e Select the Zetadocs Configuration Export option.

¢ Inthe window that appears select a suitable name and location for your configuration export and
click Export.

26.2 Exporting Modified Forms, Tables or Reports
e Open the Navision client and connect to/open the Navision database.
e Open the Object Designer (Tools—>Object Designer).
Click on All button in the designer menu.
Select All objects (CTRL + A) or alternatively select those objects you wish to export.
Select Export Objects in file menu (File=>Export).
Export objects to a suitable file e.g. Zetadocs for NAVs.o Export.fob file.
Keep the Zetadocs for NAVs5.o0 Export.fob in a safe place.

26.3 Importing Zetadocs to the Live NAV System

The steps to import the Zetadocs for NAV system to your live system are the same as those utilised earlier,
save that different files are imported. Instead of importing the config.xml file and tables/forms.fob files
straight from the Zetadocs for NAV product download you simply select the configuration xml file you
created during the export and any modified versions of your tables and forms.

Import the Zetadocs for NAV Objects fob file created from you test system.
Install the Page interfaces and forms as required

Import the xml file with your configuration from the test system.

Copy across your Zetadocs Templates.

Once you have imported the configuration you should perform a series of tests like those in chapter 18 to
ensure the system have be successfully migrated.
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27.Installing Zetadocs for NAV using Group Policy

Those intending to roll out their system using Group Policy should refer to the information available here for
further details.
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28. Upgrading Zetadocs Express to the full product

Upgrading from Zetadocs Express requires you to do the majority of the standard install steps as the
Zetadocs for NAV installers files will detect and remove any Express specific components. The only
exception to this are the Page Interfaces import steps which should be skipped to ensure you keep the
existing Express functionality. A Zetadocs install will update the components as required and ensure that
your existing SharePoint archive links to NAV are maintained.

Differing steps between a full install and an upgrade
e You are required to upgrade the SharePoint Extensions as per the instructions below.
e Do not carry out the Page Interfaces Importation step.

Upgrading the SharePoint Extensions
o Toupgrade the Zetadocs SharePoint Extensions you need to add the Zetadocs content type to your
Site and configure the Document Library to use it.
e Loginto SharePoint as a Site Collection Administrator using Internet Explorer 8 or later with
Javascript enabled.
e On the Site Actions menu, click Site Settings.
e Inthe Galleries section, click Solutions, if this is not available ensure you are looking at the
settings for the correct level. Use the Go to top level site settings option to achieve this.
e Click Solutions on the ribbon and then click on the Zetadocs SharePoint Extensions check box in
the table.
e Click on Deactivate under the Solutions options.
e The Solution Gallery — Deactivate Solution dialog box appears, click Deactivate.
e Click Solutions on the ribbon and then Upload Solution.
e Browse to the Zetadocs SharePoint Extensions folder of your product download and select the
Zetadocs SharePoint Extensions.wsp file. In the Upload Document dialog box, click OK.
e The Solution Gallery — Activate Solution dialog box appears, click on Activate.
e Return to the Site Settings and select Manage Site Features from the Site Actions section.
e Scroll down the list and activate the Zetadocs elements in the following order:
o Zetadocs Content Type
o Zetadocs Document Library
o Zetadocs Workflow (Note: Do not activate this item if using Office 365 Small Business)
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29. Uninstalling Zetadocs for NAV

29.1 Uninstallation Overview
This section gives an overview of the uninstallation process. Each step is covered in more detail in the
following sections of this manual. It is recommended that you follow these steps in order.

e Rollback of NAV Reports
e Uninstalling the Zetadocs for NAV Objects

o Remove the Zetadocs for NAV objects and existing object modifications from within
Microsoft Dynamics NAV.

e Uninstalling the Zetadocs for NAV Client
e Uninstalling the Zetadocs SharePoint Extensions (Optional- may not have been installed)

o Removal of the Zetadocs Archive Document library and uninstallation of the Zetadocs for
NAV search web parts.

e Verify all components have been removed successfully

e Uninstalling the Zetadocs Server

29.2 Rollback of NAV Reports

To restore you original report versions you should have either backed up the original versions of your
reports or you produced new versions of your existing reports with different report ID’s.

Different Report ID’s
e Open the Navision client and connect to/open the Navision database.
Open the Object Designer (Tools—>Object Designer).
Click the Report button on the Object Designer.
Set a filter *EQ* on the Version List column.
Select all Zetadocs reports (CTRL+ A).
Click on Delete in the Toolbar (F4).
Click Yes to delete selected lines.

Restoring Backed Up Reports
e Open the Navision client and connect to/open the Navision database.
Open the Object Designer (Tools—> Object Designer).
Select Import Objects in file menu (File=> Import).
Find and select the Backup of Reports before Zetadocs for NAV5.o.fob file.
Choose Yes to import all objects.
Click No to open Import Worksheet.
Click Replace All.
Click Ok.

29.3 Removing Zetadocs for NAV Objects
This section details the removal of Zetadocs for NAV objects and editing restored NAV objects back to their
original configuration.

To call this function it is suggested that you do the following:

e (reate a new form.

e Add a button to the form.

e In C/AL Globals, add a variable called ZDInt of type codeunit with a subtype of Zetadocs-Send
Integration.

e Inthe on push event for the button add the following code:
ZDInt.RemoveArchivelDFromTables(TRUE);

e Save and compile the form.
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e Runthe form and press the button. You will be prompted if you want to continue. Press Yes if you
want to proceed. The Zetadocs Archive ID fields will now have been cleared.
e Delete the form that you just created.

Importing the Backed up objects
e Open the Navision client and connect to/open the Navision database.
Open the Object Designer (Tool->Object Designer).
Select Import Objects in file menu (File=>Import).
Find and select the Backup of Objects before Zetadocs for NAVs5.o.fob file.
Choose Yes to import all objects.
Click No to open Import Worksheet.
Put an *EQ* filter on column Existing Object Version List.
Click Replace All.
Click Ok.

Uninstalling the Zetadocs for NAV Objects
e Click on the All button in the Object Designer menu.
e Put an *EQ*filter on column Version List.
e Compare the remaining object list with the object list table in the Appendix to ensure you will not
delete tables unnecessarily.
e Select table Zetadocs Settings (9009959)

Perform the next steps for all Zetadocs for NAV tables in the following order:
o 9009963 t0 9009982

o 9009960 t0 9009962

Click Run.

Select all lines (CTRL + A).

Click on Delete in the Toolbar (F4).

Click Yes to delete selected lines.

Close Table Run (Esc).

Once this has been complete for all tables in the specified ranges.
e Select all Zetadocs for NAV objects (CTRL+ A).
e Click on Delete in the Toolbar (F4).
e Click Yes to delete selected lines.

Note: You may not have permissions to delete all the objects, such as some codeunits. In this case it is ok
to leave the codeunits on the system as they will not be used.

29.4 Uninstalling the Zetadocs Client

This section describes how to uninstall the client applications which include the Zetadocs Client, the
runtime API and the NAV Extensions. The Zetadocs for NAV Client installation is performed using a
combination of installers. You will need to uninstall each of these to remove the Zetadocs for NAV Client.
You will need to uninstall the Zetadocs for NAV and the two pre-requisites, the Zetadocs Client and
Zetadocs API runtime.
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Figure 57 - Add Remove Programs

Open Add/Remove programs (Windows XP) or Programs and Features (Windows Vista) or other
uninstallation utility relevant to the environment you are operating in.

e Select Zetadocs NAV Client from the program list and select uninstall.
e Select Zetadocs PDF from the program list and select uninstall.
e Select Zetadocs API Runtime from the program list and select uninstall.

29.5 Uninstalling the Zetadocs SharePoint Extensions

SharePoint Extensions

To uninstall the SharePoint extensions you must be logged onto the machine using an account that has
SharePoint Site Collection Administrator privileges for the front-end web application and the Central
Administration program. Alternatively if you are using SharePoint Online you with need to be an
administrator.

Deactivating the Zetadocs Components
e Go to the SharePoint site and select Site Actions and then Site Settings and click on Manage Site
Features from the Site Actions section.
e Scroll down the list and deactivate the Zetadocs Content Type, Zetadocs Document Library and
Zetadocs Workflow.

Deactivate the Zetadocs SharePoint Extensions Solution
e Onthe Site Actions menu, click Site Settings. In the Galleries sections, click Solutions.
e  Scroll down until you locate the Zetadocs SharePoint Extensions solution and click Deactivate.

e With the Zetadocs SharePoint Extensions solution selected, choose Solutions from the ribbon and
then Delete.

29.6 Uninstall Zetadocs for NAV Client Help Files
The Zetadocs for NAV help files should have been copied to the Microsoft Dynamics NAV help folder and
given names that will not clash with other help files.
These files were originally:

e addin_a.chm

e addin_a.hh
This folder may have contained other help files which may have used the ‘a’ post-fix name. As such you
should select and open the addin_a.chm file and identify whether it is the Zetadocs for NAV help file. If it is
not then try the next unused post-fix letter between a and j until you locate the Zetadocs for NAV help files.
Note that the post-fix on both file names must match. (e.g. addin_f.chm and addin_f.hh) Once identified
these files should be deleted from:

Program Files\Microsoft Dynamics NAV\CSIDE Client\ENG

Or removed from the equivalent installation folder of Microsoft Dynamics NAV on the machine.
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29.7 Uninstalling the Zetadocs Server
The Zetadocs Server converts items placed into the document queues into pdf format, to remove it follow
the steps below.

e Open Programs and Features (Windows Server 2008) or other uninstallation utility relevant to the
environment you are operating in.

e Select Zetadocs Server from the program list and select uninstall.

e Some files are created after installation of the Zetadocs Server, to ensure all related files are
removed, delete the Zetadocs Server folder. This is by default located in the Program Files
directory.
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30. Assigning a specific icon for your pdf files in
SharePoint (Optional)

Should you wish to assign a recognisable icon to the pdf files in your archive it is possible to have any
suitable image represent your content. If you do not wish to add a specific icon simply skip the steps below
and continue with the additional steps relevant to your SharePoint version.

e Firstly you need to locate a suitable icon to represent pdf files in your SharePoint system.

e Copy thisicon file to C:\Program Files\Common Files\Microsoft Shared\Web Server
Extensions\12\Template\Images

e Go to C:\Program Files\Common Files\Microsoft Shared\Web Server Extensions\12\Template\XML
and open the Docicon.xml file in a text editor such as Notepad.exe.

e Adjust the file to include the .pdf extension by adding <Mapping Key="pdf" Value="<your image
file name with extension>"/> and saving the file.

Additional steps required on SharePoint 2010 Systems

These next steps are relevant to SharePoint 2010 systems only, if you are using foundation please proceed
to the next step.

Launch the SharePoint Central Administration program.

Click General Application Settings from the left-hand menu.
Select Farm Search Administration from the Search section.
Select the Search Service Application option.

Select File Types from the Crawling section.

Click New File Type.

Enter pdf in the File Extension text box and click OK.

Perform a Search Service stop: Start > Run - net stop spsearch
Perform a Search Service start: Start > Run - net start spsearch

Additional steps required on foundation systems

On foundation systems you will also have to carry out the following steps.
e Click Start > Run > REGEDIT and then locate the following registry subkey: Foundation Systems
e HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Shared Tools\Web Server

Extensions\14.0\Search\Applications\<GUID>\Gather\Search\Extensions\ExtensionList\

Select Edit > New - String Value

Assign the name 38 to the new string or the next available number.

Give it the value pdf

Perform a Search Service stop: Start > Run - net stop spsearch

Perform a Search Service start: Start > Run - net start spsearch
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